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Clip Studio Paint, once known as Manga Studio, is used by more than four million creators around the world. Illustrators and comic artists love this software for its specialized features for drawing comics and cartoons. You can create black and white or full-color comics and illustrations using just this software, a computer, and a graphics tablet. As of the time of this writing, Clip Studio Paint has been the top seller for three years for graphics software in Japan, and this software is growing in popularity all over the world, too!

Whether you're an illustrator, a comic artist, or even an animator, Clip Studio Paint has features that will improve your workflow and make your journey into the digital art realm easier and faster. 



            

            
        
    
        

                            
                    Who this book is for

                
            
            
                
This book is for beginning digital artists who are just starting to use graphics software, or for users who are switching to Clip Studio Paint from other software. You should have basic computer skills and knowledge of installing drivers for computer peripherals. 



            

            
        
    
        

                            
                    What this book covers

                
            
            
                
Chapter 1, Installing Clip Studio Paint, Recommended Systems, and Interface Basics, covers purchasing and installing the software, system requirements for running the software, and a basic introduction to the interface.  

Chapter 2, Preferences, Shortcuts, and Other Commands, covers setting the software preferences, using command bar and keyboard shortcuts, making workspaces, and creating new files.

Chapter 3, Clip Studio Paint Brushes: An Introduction, covers how to make digital marks, and introduces us to customizing the brush engine, tool properties, and saving and restoring brushes.

Chapter 4, Pencilling: Layer Properties, covers the different properties of digital layers, layer menu options, and the Layer Palette icons.

Chapter 5, Erasers, Selections, and the Subview Palette, will teach you about the various eraser tools, selection tools, and how to use the Subview palette.

Chapter 6, All about Rulers, covers the myriad of ruler tools in Clip Studio Paint. We will cover the basic rulers, as well as symmetry rulers, focus and parallel line rulers, and how to use perspective rulers.

Chapter 7, Using 3D Figures and Objects, teaches you how to use the 3D materials included with Clip Studio Paint. Placing characters, posing them, and customizing poses and characters are all topics covered in this chapter.

Chapter 8, Vector Layers and the Materials Palette, covers how to create vector images, and also covers using the Materials Palette to add textures, patterns, and more to your images.

Chapter 9, Using Text and Balloon Tools, will teach you how to navigate the world of text and its options. Creating word balloons is also covered. 

Chapter 10, Creating Sound Effects, covers creating specialized text, adding strokes and gradient to text, and how to use the Mesh Transformation to morph text into punchy sound effects.

Chapter 11, Making Layer Masks and Screentones, covers the use and creation of Layer Masks, and also how to apply screentones to black and white by using selections and layer masks.

Chapter 12, Making Comic Panels, teaches you how to use the comic panel creation tools to make professional looking comic panels. The benefits of making panels all on one layer or each on their own layer are examined.

Chapter 13, Auto Actions and Your Workflow, covers the benefits of Auto Actions, how to use default actions, and how to record and playback custom actions.

Chapter 14, Inking Tools, goes over the inking pens, brushes, and markers that come included in Clip Studio Paint. Some basics of inking are also covered.

Chapter 15, Inking Special Effects, covers the creation of special effect brushes, textured brushes and brushes with patterns such as foliage.

Chapter 16, Color Palettes, covers the color selection and mixing palettes such as the Color Wheel, Color Sets, Intermediate Color, Approximate Color, and Color History.

Chapter 17, Using CSP to Color Your Comics, discusses the use of reference layers, how to create flats using bucket fill and Paint Unfilled Area tools, layer blending modes, and how to create colored line art.

Chapter 18, Exporting and Printing Your Comic, covers how to use the print preview and print settings to create a physical copy of your comics and illustrations. Exporting your work in various formats for printing and for display on the web are also covered.

Chapter 19, The Clip Studio App and Getting Animated, covers how to download new assets and materials using the Clip Studio App, and how to create animation timelines and cels to animate your drawings.



            

            
        
    
        

                            
                    To get the most out of this book

                
            
            
                
Having a graphics tablet or a tablet computer with a stylus and pressure sensitivity are highly recommended for using this software. Drawing with a stylus is much more natural than drawing with a mouse or trackpad. For more information on graphics tablets, see Chapter 1, Installing Clip Studio Paint, Recommended Systems, and Interface Basics.



            

            
        
    
        

                            
                    Download the color images

                
            
            
                
We also provide a PDF file that has color images of the screenshots/diagrams used in this book. You can download it here: https://www.packtpub.com/sites/default/files/downloads/9781789347036_ColorImages.pdf.



            

            
        
    
        

                            
                    Conventions used

                
            
            
                
There are a number of text conventions used throughout this book.

CodeInText: Indicates code words in text, database table names, folder names, filenames, file extensions, pathnames, dummy URLs, user input, and Twitter handles. Here is an example: "Locate the install file named CSP_1XXw_setup.exe that has been saved to your computer and double-click it to launch the setup program."

Bold: Indicates a new term, an important word, or words that you see onscreen. For example, words in menus or dialog boxes appear in the text like this. Here is an example: "Under the Payment Option section, click on the PayPal Checkout button to pay with PayPal."

Warnings or important notes appear like this.

Tips and tricks appear like this.



            

            
        
    
        

                            
                    Get in touch

                
            
            
                
Feedback from our readers is always welcome.

General feedback: If you have questions about any aspect of this book, mention the book title in the subject of your message and email us at customercare@packtpub.com.

Errata: Although we have taken every care to ensure the accuracy of our content, mistakes do happen. If you have found a mistake in this book, we would be grateful if you would report this to us. Please visit www.packt.com/submit-errata, selecting your book, clicking on the Errata Submission Form link, and entering the details.

Piracy: If you come across any illegal copies of our works in any form on the Internet, we would be grateful if you would provide us with the location address or website name. Please contact us at copyright@packt.com with a link to the material.

If you are interested in becoming an author: If there is a topic that you have expertise in and you are interested in either writing or contributing to a book, please visit authors.packtpub.com.
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Please leave a review. Once you have read and used this book, why not leave a review on the site that you purchased it from? Potential readers can then see and use your unbiased opinion to make purchase decisions, we at Packt can understand what you think about our products, and our authors can see your feedback on their book. Thank you!

For more information about Packt, please visit packt.com.



            

            
        
    
        

                            
                    Installing Clip Studio Paint, Recommended Systems, and Interface Basics

                
            
            
                
In this chapter, we're going to dive right into the thick of it and start getting to know Clip Studio Paint. First, we'll take a look at the recommended system specifications for running Clip Studio Paint and how to install the program. We'll also talk about graphics tablets, their importance, and how to obtain one.

Once we have Clip Studio Paint installed, we'll begin by getting to know the interface. First, we'll go over the parts of the default interface. Then, we'll learn how to customize and change the interface to suit our needs, as well as how to select tools and about the various palettes that comprise the Clip Studio Paint interface and their properties.

By the end of this chapter, you will be able to install Clip Studio Paint and identify the different parts of its interface.

In this chapter, we will learn about the following topics:


	Recommended system specifications for Clip Studio Paint

	Installing Clip Studio Paint

	The default user interface

	Moving, collapsing, and stacking palettes

	Using the tool palette

	Using the Command Bar

	Clip Studio Paint Pro terms









            

            
        
    
        

                            
                    System specs, installation, and your serial number

                
            
            
                
Before installing Clip Studio Paint, we need to ensure that our computer hardware is capable of running the program. Graphics software can be taxing on system resources, so it is important to ensure that your computer is up to the task!

Clip Studio Paint is made for both Windows PCs as well as Mac operating systems. Once we have ensured that we can run the program on our computer, we can then download and install the software and get it running for the first time. 
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To run Clip Studio Paint effectively, our computer must meet certain system requirements. These requirements are slightly different for PC than for Mac, so please check the system requirements carefully against the computer that you will be installing the software on to ensure that Clip Studio Paint will run properly.

Both PC and Mac computers have the following requirements for use of the program:


	
Storage space:


	At least 3 GB of storage space available on the hard drive





	
Tablet:


	Pen tablet or tablet monitor that supports a pressure sensitive stylus – WACOM products are recommended





	
Monitor:


	XGA (1,024 * 768) or higher required, WXGA (1,280 * 768) or higher recommended, high color (16 bit 65536 color) or higher required





	
Scanner:


	Scanners compatible with TWAIN





	
Printer:


	Printer compatible with the aforementioned OS





	
Internet access:


	
An internet connection will be necessary for license authentication













            

            
        
    
        

                            
                    Windows system requirements

                
            
            
                
The following are the requirements for running Clip Studio Paint Version 1.7.4 on Windows:


	
OS:


	Microsoft Windows English OS

	Windows 7 (32 bit/64 bit) Service Pack 1 or later is required

	Windows 8.1 (32 bit/64 bit)

	Windows 10 (32 bit/64 bit)





	
Main Computer/CPU:


	Intel processors compatible with SSE2 or an AMD CPU

	GPUs compatible with OpenGL 2.1

	2 GB memory or more is required, 8 GB or more is recommended







Memory space and CPU capability are required for top software performance regarding image size, number of layers, and so on. Generally, the larger the image size and the number of layers, the more memory, and the faster CPU will be required.


	
Tablet:


	Computers compatible with Windows Ink Platform

	Pen tablet or tablet monitor that supports a pressure-sensitive stylus (compatible with Wintab)

	For tablets compatible with Wintab, WACOM devices are recommended
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If you are using a macOS computer, you will need to meet the following system requirements to run Clip Studio Paint version 1.7.4:


	
OS:


	macOS English OS 10.10, 10.11, and 10.13





	
Main Computer/CPU:


	Intel processor

	GPUs compatible with OpenGL 2.1

	2 GB memory or more is required, 8 GB or more is recommended







We'll go into tablets in more detail in the About graphics tablets section.

If your computer system meets or exceeds the requirements listed, then it's time to install the program!



            

            
        
    
        

                            
                    Installing the program

                
            
            
                
To purchase and download the Clip Studio Paint program, you will need an internet connection. The program is available through the Clip Studio website. To access the English version of the website, you will need to visit the URL http://www.clipstudio.net/en in your internet browser.

Clip Studio does have a free trial of the program, which is very handy if you want to try the program to make sure your computer system can run it or if you want to explore the program and ensure that it will meet your needs before buying it. At the time of writing this book, the Clip Studio Paint free trial lasts for 30 days. You can try both the Clip Studio Paint Pro and Clip Studio Paint EX versions of the program. Also, when using the trial version of the software, you will need to register for a free Clip Studio account. We'll discuss more about the Clip Studio account in Chapter 19, What Is the Clip Studio App and Getting Animated.

Clip Studio Paint Pro or Clip Studio Paint EX? Which version should you choose? Unlike previous versions of this program, there are very few differences between the Pro and EX versions of the software. The Pro version is the standard version and EX is the full-featured version. Clip Studio Paint Pro is less expensive than the EX version. The biggest difference between the two versions of the program is that the EX version allows you to create multi-page files (files with multiple pages in them that can be viewed and edited all at once), and that the EX version has no limit regarding the number of animation frames in a file while the Pro version limits animation frames to a total of 24. If you will be creating long animations, chapters of a comic or graphic novel, or other works where viewing multiple pages are needed, it is highly recommended to get the EX version of Clip Studio Paint.





            

            
        
    
        

                            
                    Downloading the trial version

                
            
            
                
Once we're on the Clip Studio website, we'll need to download the trial version or buy the software. To download the trial version, complete the following steps:


	On the ClipStudio.net/en website, click on the button in the upper-right-hand corner labeled Free Trial.

	Choose the version of the software compatible with your operation system (Windows or macOS) and click on the corresponding Download Trial button.

	On the next window, click on the button labeled Start Download.

	The program installation file will be saved to your computer.





            

            
        
    
        

                            
                    Purchasing Clip Studio Paint

                
            
            
                
If you are ready to purchase Clip Studio Paint, follow these steps:


	 On the ClipStudio.net/en website, click on the button in the upper-right-hand corner labeled Buy Now.

	The price for both the Pro and the EX versions will be shown. Click on the Buy Now button beneath the version of the software that you wish to purchase.

	On the next screen, fill out your personal information, making sure to fill out all of the required fields.

	Under the Payment Option section, click on the PayPal Checkout button to pay with PayPal. Complete the PayPal payment on the next screen by following the directions.

	To use another form of payment, choose the relevant payment option from the first drop-down menu, then select your currency from the second drop-down menu.

	When Credit Card is selected under the payment option, some fields where you can enter your credit card information will be automatically displayed. Complete the necessary fields and click on the button marked Next.

	To pay with a check or another payment method, select Check - prepayment from the drop-down menu. Click the Next button.

	On the next screen, review the displayed information. To correct any errors, click on the Edit button next to that section and make the necessary changes. If all of the information is correct, click on the Buy Now button to complete your purchase.



















Now that we have the program saved to our computer, we can begin the installation process. This process is the same for both the trial and purchase versions of the software. When registering a purchased version, however, we will enter the serial number for the software while launching the application for the first time. 

Your serial number will be sent to the email address that you registered with when purchasing the program. It is very important to keep this serial number in a safe place where you can locate it! Your Clip Studio Paint serial number allows you to register the software on up to two computers, so long as the following conditions are met:




	The two computers must be owned and administered by a single user.

	Use of the product is limited to the primary user and one supplementary user appointed by the primary user.

	The software must NOT be used simultaneously on the two machines.

	The two computers may have a different OS (for example, Windows 8 and Mac OS X 10.8). Please refer to the official conditions of use provided in the End-User License Agreement. If you wish to use the product on three or more computers, please purchase additional licenses.



You must also have your serial number if you purchase a new PC and need to install Clip Studio Paint on it again. Save the email from your registration in a safe folder in your email client. I also keep important serial numbers in a text file in a cloud backup, such as Dropbox or Google Drive, in case something happens to my emails. You may also want to make another backup of your serial number on a removable drive like a USB drive to be extra certain that it is safe and able to be recovered in case of emergency.

Now that we have a backup of our serial number, let's install the Clip Studio Paint software so that we can start using it!



            

            
        
    
        

                            
                    Installing on a Windows computer

                
            
            
                
Complete the following steps to install Clip Studio Paint to your Windows computer:


	Locate the install file named CSP_1XXw_setup.exe that has been saved to your computer and double-click it to launch the setup program.

	The welcome screen will be displayed. Click on Next to continue.

	Read the License Agreement. Click on the circle next to I accept the terms of the license agreement to accept the terms. Click Next to continue.




	The Choose Destination Location window will be displayed. The setup will default to a folder in Program Files for installation. If you wish to change the location of this folder, click on the button labeled Change to the right of the currently selected folder name and choose the location of the desired folder. Once the desired folder is selected, click Next.

	On the next screen, choose the desired language for installation. Note that when using a purchased version, the language that correlates with the serial number must be used. If using the trial version, select the language you wish to install. Then, click Next.

	Click Install to complete the installation. 

	When the installation completion screen appears, click on the Finish button to exit setup.





            

            
        
    
        

                            
                    Installing on a Mac computer

                
            
            
                
Complete the following steps to install Clip Studio Paint to your Mac computer:


	Locate the file named CSP_1XXENm_app.pkg that has been saved to your computer, and double-click it to launch the Installation window.

	Once the setup program launches, click on Continue.

	Read the License Agreement, then click on Continue. 

	To continue, you must click on Agree in the next screen to accept the terms of the license agreement. Clicking Disagree will cause Clip Studio Paint to not be installed. Click on Agree to accept the terms and continue with the installation.

	On the Installation Type screen, click Install to continue.

	Select the desired language for installation. Note that when using a purchased version, the language that correlates with the serial number must be used. If using the trial version, select the language you wish to install. Then, click Ok.

	Once the installation completes, you will see a screen stating that the installation was successful. Click on Close to exit the setup program.





            

            
        
    
        

                            
                    Starting the program for the first time

                
            
            
                
Now that we have the program installed, we're ready to launch it for the first time. On the initial launch, you will have the opportunity to download additional materials, enter and verify your serial number, or register to use the trial version. This is the last step before we can open the Clip Studio Paint program and begin exploring the interface, so let's get started.





            

            
        
    
        

                            
                    Registering for a trial version of Clip Studio Paint

                
            
            
                
Follow these steps to register for a trial version of Clip Studio Paint:


	Double-click the Clip Studio application icon.

	A message will appear stating that the program is preparing for use. Click on OK to continue.




	A message will display stating that you can download additional materials provided by CELSYS. To start the material download, click on Yes. Wait until the download is complete. Depending on the size of the materials, this download may take several minutes. To skip downloading, click No. Additional materials can be downloaded later by using the instructions in the Downloading additional materials section.

	After launching Clip Studio, click on the Paint icon on the left-hand side to launch Clip Studio Paint.

	On the next screen, click on the button labeled Use trial version (without limited features) to register for your free Clip Studio account. 

	Click Register for trial version on the next screen. Then, enter your email address and a password to create your Clip Studio account. Click Next when finished.

	Clicking OK on the next screen completes your trial version registration.

	In the trial version, you will be able to select the EX or PRO version of the software each time Clip Studio Paint is launched. At the version selection window, select the version you are interested in trying to launch.



You can begin the trial version of the software without registering for a Clip Studio account, but the software will have limited features. Registering for an account is free, secure, and fast, and it will give you unlimited features to try in Clip Studio Paint!



            

            
        
    
        

                            
                    Registering for a licensed version of Clip Studio Paint

                
            
            
                
Follow these steps to register for a licensed version of Clip Studio Paint:


	Double click the Clip Studio application icon.

	A message will appear stating the program is preparing for use. Click on OK to continue.






	A message will display stating that you can download additional materials provided by CELSYS. To start the material download, click on Yes. Wait until the download is complete. Depending on the size of the materials, this download may take several minutes. To skip downloading, click No. Additional materials can be downloaded later by using the instructions in the Downloading additional materials section.

	After launching Clip Studio, click on the Paint icon on the left-hand side to launch Clip Studio Paint.

	On the next screen, enter the serial number from your documentation in the appropriate text entry boxes. Click Register License.

	Select Verify license right now, then click Next.

	In the License registration screen, select Perform automatically, and then click Next.

	If the license check completes successfully, you will see a screen stating it was successful. Click Next to launch the software.

	If the license check doesn't complete successfully, you can verify the license in your web browser. From the License verification error screen, select Yes, verify license in another procedure, and then click Next.

	On the next screen, click on the link to connect to the website in your browser. This will issue an authentication key. 

	Enter the authentication key in the provided text boxes, and then click Next to continue.

	If the license check is successful, click on OK to launch the software.





            

            
        
    
        

                            
                    Changing a license

                
            
            
                
There are a few cases where the license may need to be changed:


	When changing from the trial version to the purchased version

	Upgrading the software from PRO version to EX version

	Upgrading to PRO or EX versions from the DEBUT version



To change a license, follow these steps:


	Launch the Clip Studio Paint software.

	From the Help menu, select the Register License option (or the Clip Studio Paint menu in macOS).

	Enter the new license serial number.





            

            
        
    
        

                            
                    Downloading additional materials

                
            
            
                
If the additional materials were not downloaded during the initial registration of the program, they can be downloaded later by using the following steps:


	Launch the Clip Studio application by double-clicking the icon.

	Once Clip Studio is open, click on the Settings menu (the gear icon) in the top-right-hand corner.

	Click Download additional materials now from the menu.

	When the download confirmation message is displayed, click Yes to begin the download. Depending on the size of the materials, this download may take several minutes. 





            

            
        
    
        

                            
                    About graphics tablets

                
            
            
                
When working in an art software like Clip Studio Paint, having a graphics tablet makes life a lot easier. So, what is a graphics tablet and where can you obtain one?



            

            
        
    
        

                            
                    What is a graphics tablet?

                
            
            
                
A graphics tablet is a computer peripheral that comes with a stylus. It allows you to hold the stylus and draw the way that you would with a pencil or pen on paper. The following diagram illustrates a basic tablet and stylus:



There are many different types and brands of graphics tablets, all ranging in price from under $100 to over $2,500, so it is easy to find a tablet that is in your budget. I cannot express enough how much easier working in Clip Studio Paint is when you have a tablet! 



There are many different factors to consider when shopping for a graphics tablet. Let's break some of those options down so that you can make a good choice when purchasing your tablet.



            

            
        
    
        

                            
                    What type of tablet should I buy?

                
            
            
                
There are two primary types of tablets: traditional tablets and monitor tablets. Traditional tablets are slates that plug into or connect wirelessly to your computer. You then use the stylus to draw on the tablet while looking at the separate monitor, just like using a mouse on a computer.

A monitor tablet is a tablet with a monitor screen built into it. You then use the stylus directly on the screen so that you can see your hand and what you're drawing at the same time. This method feels more like using traditional paper and pencil and requires less of an adjustment period for new tablet users because there is less disconnect between what your hand is doing and what your eyes are seeing.

However, this comes at a price. Monitor tablets are becoming more affordable every year, but they are still much more expensive than a traditional tablet. If you are purchasing a tablet for a young artist or are someone just getting into digital art, I always recommend getting a traditional tablet. They are far more affordable and usually easy to find second-hand, but still in good working order. For more established artists who do a lot of art and know for certain that they like working digitally, investing in a larger tablet or a tablet monitor will usually speed up your workflow and make life easier, so it makes sense to make the investment into a higher-end tablet.



            

            
        
    
        

                            
                    How large of a tablet should I buy?

                
            
            
                
Tablets come in all sizes, from ones no bigger than a traditional mouse pad to the size of a table top. The size of the tablet that you buy is very much dependent on how you draw. Sit down and draw on a piece of regular paper and try to pay attention to how large or small you draw. You'll need to figure that out before you can decide on the size of the tablet you want to buy!

I find that people who draw small can be comfortable on a small tablet size. Personally, I draw rather large and tend to take up the whole sheet of paper when I draw, so I like a larger size tablet when I work because it gives me more room to work with. 





Another thing to consider when looking at different sizes of tablets is the space you have to store it in. If you are using the tablet with your laptop and will be traveling with it often, or if you have only a small amount of space on your desk, you will want to purchase a smaller tablet that is more easily transported. However, if you have a larger area or will only be using the tablet at a desk, a larger tablet could be the right fit for you.



            

            
        
    
        

                            
                    What tablet brand should I buy?

                
            
            
                
It used to be that you only had one choice of tablet brand, but in the past several years, more companies have started manufacturing their own graphics tablets. This means that there is a wide selection of tablets available, all with their own pros and cons. Some of the most well-known of these tablet brands are Wacom, Yiynova, and Huion. Each brand has a wide range of different size and price tablets, most of which you can find on their websites or by searching for them on sites like Amazon.

I often get asked what brand of tablet I would recommend, and for me there is one clear winner: Wacom. From my personal experience, Wacom tablets are of the highest quality and last the longest for me. I have tried other brand tablets that broke within two years, but every Wacom brand tablet I have ever owned has stood the test of time. This is, of course, not saying that the other brands out there are bad, and I know many people have had good experiences with those brands! But for me, personally, I find Wacom tablets to be well worth the money. Their cheapest tablets are in the $50-100 USD range, and you can often find them used on eBay and Amazon as well, so with a bit of searching, you should be able to find a tablet for any budget.



            

            
        
    
        

                            
                    Any other considerations?

                
            
            
                
Like computers, tablets come with their own set of specifications. You'll want to look at these specifications and consider them when purchasing, of course. Things like pressure levels, hotkeys, and built-in erasers are just a few options you will encounter when shopping for a graphics tablet.

Pressure levels are the amount of sensitivity that the tablet can sense. When drawing with a tablet, how hard you press with the stylus translates on the screen to a thinner or thicker line. Drawing lightly will produce a thin line, while pressing harder will produce a thicker line. The higher the pressure levels, the more sensitive the tablet is.

Hotkeys, or shortcut keys, are buttons on the stylus or on the tablet itself that allow you to perform operations while using the tablet. For instance, two shortcut keys on the tablet stylus may simulate a left and a right mouse click. Sometimes, these buttons are programmable within the tablet driver. If you use a lot of keyboard commands while working with software, you may want a tablet with more of these hotkeys built in.



Some tablets have a stylus with a built-in eraser. This means that there is a button on the eraser end of the stylus so that while you're drawing you can just flip the stylus over and erase without having to switch tools in your software. When the stylus is flipped back to the other end, it changes back to the drawing tool. I find that having an eraser button on the end of my stylus makes the digital drawing process much easier for me, and it feels more like the experience of drawing with a pencil on paper.



            

            
        
    
        

                            
                    Where can I purchase a graphics tablet?

                
            
            
                
Graphics tablets are sold in a variety of places. Sometimes, they can be found in office supply stores, so check with the ones in your area if you want to get one quickly and without having to wait for shipping. It can be difficult to find a tablet in a local store, however, and ordering online allows for a better selection, and you may be able to find one for a much better price.

Tablets can be ordered from lots of websites. Many manufacturers sell directly from their own sites. You can also find used or new tablets on sites like Amazon or eBay. Some websites even sell refurbished tablets: tablets that are used but have been repaired or had hardware replaced in them. When purchasing a monitor tablet, it may be best to look for a refurbished one to get the best deal if cost is a concern.

Now that we have Clip Studio Paint installed, and we have chosen our graphics tablet, it's time to start getting to know this amazing art software.



            

            
        
    
        

                            
                    Taking a look at the default interface

                
            
            
                
Once you launch Clip Studio Paint, you will be greeted by the default interface. I have been told many times that new users often get to the default interface and panic. It can be a bit overwhelming at first because there's a lot of palettes and options, but I promise that it's not so scary! With a little bit of exploration, we can break down the default interface and understand what each section is. In the next section, we'll even learn how to customize the interface to suit our own needs. But for now, let's take a look at the default user interface.



The following screenshot shows what you may see when starting up your program for the first time:



The numbers in the preceding screenshot correlate to the following:


	Menu Bar 

	Tool box

	Sub Tool palette

	Tool Property palette

	Brush Size palette

	Color Palette

	Command Bar

	Canvas display

	Timeline palette

	Quick Access/Materials Library

	Navigator/Sub view palette

	Layer Property palette

	Layer/History/Auto action palette



Now, let's break down what each of these parts of the program does.

The Menu Bar is where you will find many of your options, such as creating and saving files, program preferences, viewing preferences, and more.

The Tool Box holds all of the various tools that we'll be using to create our comics and illustrations. In the top of the Tool Box are tools such as the magnifying glass, hand tool, and selection tools. Below those are drawing tools, such as the pencil, pen, brush, decoration, eraser, and blending tools. In the bottom third of the toolbox are tools such as the fill tool, gradient tool, line and ruler tools, text tools, and correct line tools. The final part of the toolbox displays our current foreground and background color selections, as well as a transparent color selection. We'll be discussing all of these tools as we continue through this book, so don't worry if you don't know what all of them do just yet.

The Sub Tool palette contains options for each of the tools in the Tool Box, and it changes depending on which tool we currently have selected.

For example, clicking on the Pencil tool in the toolbox will bring up a variety of different tools in the Sub Tool palette, like what is shown in the following screenshot:



At the top of this palette are the different categories of tools under the Pencil category. Our currently displayed category is shown in blue. In the central area of the palette are the different types of pencil tools. The tools displayed in your Sub Tools may be different than what is shown in the preceding screenshot.

The Tool Property palette displays options for the currently selected tool. Each tool can be customized to meet our individual needs, but let's look at the default properties for the Darker pencil, as shown in the following screenshot:



We will explore this palette in detail in Chapter 4, Pencilling: Layer Properties.

The Brush Size palette allows us to quickly change the size of our brush by selecting one of the preset brush sizes from the icons shown.

The Color Palette offers us several options for choosing and mixing colors, all of which we'll explore later on in Chapter 16, Color Palettes.

The Command Bar is a powerhouse in Clip Studio Paint, even though it doesn't look like much. This little piece of the interface gives us quick access to frequently used functions, such as creating a new file, saving, undoing, and even exporting files. The best thing is that it's completely customizable, too! We'll learn how to customize the Command Bar in Chapter 2, Preferences, Shortcuts, and Other Commands.

When there is a drawing or file currently open in Clip Studio Paint, it will be displayed in the Canvas display in the center of the program.

The Timeline palette is used when making animations in Clip Studio Paint. It also contains a tab called All Sides View, which is used when working with 3D model elements.

The Quick Access and Material Library has a lot going on, but it's an extremely useful part of the Clip Studio Paint software. The Quick Access window gives us access to more frequently used actions, much like the Command Bar. Quick Access can also be customized, but unlike the Command Bar, it has two sets inside of it. This allows for more flexibility, as Set 1 could be used for functions such as save and undo, while Set 2 could be set up with the most used tools or other commands to make tasks like coloring easier. We'll explore Quick Access more in Chapter 2, Preferences, Shortcuts, and Other Commands.

This part of the software also contains the Materials Library. Materials can be everything from comic frame templates to word balloons to photographs, to special brush designs, to 3D models. There's a huge variety of items contained in the Materials Library. We'll learn more about 3D models in Chapter 7, Using 3D Figures and Objects, and more about the Materials Library in Chapter 8, Vector Layers and the Material Palette.

The Navigator palette contains several tabs inside of it, each with a different function. The Navigator shows the currently active file, along with a red rectangle that outlines the currently viewed section of the canvas. This is useful when working zoomed in on a page or illustration. Also in this palette is the Sub View palette, which can be used to display reference images and more. We'll discuss more about the Sub View in Chapter 5, Erasers, Selections, and the Subview Palette. The Item Bank tab displays any 3D objects that are currently being used in the open file. Finally, in this palette, we have the Information tab, which shows the percentage of system and application resources currently being used and also the X and Y coordinates of the current position of the cursor.



Beneath the Navigator palette is the Layer Property palette, which also has a few tabs inside of it. The Layer Property tab gives us the options available for the currently active layer. We'll be discussing layers and layer properties in more detail in Chapter 4, Pencilling – Layer Properties and the Brush Properties. Also in this palette is the Search Layer, which allows us to filter out layers and find layers easily depending on certain parameters. This is a very handy tool for files with lots of layers. Finally, in this palette is the Animation Cels tab. When making animations, this tab will display our animation cels.

The final part of our interface is the Layers palette, which also has several tabs in it. The first tab is the Layers tab, which shows all the layers in our currently active file. We also have the History tab, which allows us to see a list of actions performed on the currently active file and step backwards in time to easily undo unwanted changes to the file. Finally, we have the Auto action tab. Auto actions are recorded sets of processes that can then be carried out by the press of one button. We'll discuss Auto actions in detail in Chapter 13, Auto Actions and Your Workflow.

Now that we have a better grasp of the default parts of the interface, we can learn how to move elements of the program around and customize it to suit our needs. Read on to learn more!



            

            
        
    
        

                            
                    Moving, collapsing, and closing palettes

                
            
            
                
One of my favorite things about Clip Studio Paint is how customizable it is. Not only can we customize our tools, but we can also customize the interface of the program to make it look however we want it to look. This means that we can set up the program palettes and toolbars to give us the most efficient workflow and make our process as streamlined as possible. The process of moving, closing, and rearranging palettes is very easy, so let's get right to it.



            

            
        
    
        

                            
                    Moving a palette

                
            
            
                
Let's start off by moving a palette to a new location in the Clip Studio Paint interface. I'll be working with the Information palette in this example, but this can be done with any palette you choose. Follow these steps to move a palette:


	Locate the palette to be moved.

	 Put the mouse cursor over the name tab of the palette. The tab will be highlighted in blue when the mouse cursor is in the correct position.




	Hold down the left mouse button to grab the palette, then move the mouse to drag the palette out of its position. The palette's new location will be shown in red, as shown in the following screenshot:






	Drag the palette to the new desired location. A red line will appear when the palette is in line to be dropped in a new place in the interface, as shown by the red line below the Navigator palette in the following screenshot:






	When the palette is in the desired new location, release the left mouse button to finish moving the palette. In the following screenshot, the Information palette is now below the Navigator palette:






	A palette can also be popped out of the interface by dragging the palette out to the Canvas display window and releasing it when the palette is surrounded by a red rectangle. This will put the palette out on its own and not as part of the sidebars of the interface, as shown in the following screenshot:







            

            
        
    
        

                            
                    Closing a palette

                
            
            
                
There are two ways to close a palette that isn't needed. In this example, I will continue using the Information palette, because it's actually not a palette that I need to use and so I usually keep it closed anyway! Follow these simple steps to close a palette:


	Follow the preceding instructions for moving a palette, and making sure to pop out the palette, as shown in step 6.

	Click on the X button in the upper-right-hand corner of the palette to close it.

	To bring a palette back once it's been closed, simply go to Window in the File menu. Click on the name of the palette to show it again. Alternately, the Window menu can also be used to close palettes by clicking on the names with check marks next to them.







            

            
        
    
        

                            
                    Collapsing and expanding palettes

                
            
            
                
Clip Studio Paint also has the ability to temporarily hide entire banks of palettes and then bring them back when needed. In the following screenshot, the Quick Access and Materials Library are collapsed so that we can only see the category icons:



Let's learn how to expand and collapse this palette by following these steps:


	To fully expand the palette, click on the single left-facing arrow at the top of the palette window. The palette will expand, as shown in the following screenshot:






	To collapse the palette back down to icons-only, click on the single right-facing arrow at the top of the palette.

	To fully collapse the palette, click on the double right-facing arrows at the top of the palette.



Remember that palettes on the left-hand side of the screen will have arrows facing the opposite direction, but they still perform the same function! They just collapse the palettes to the left instead of to the right. Collapsing palettes is a great way to give yourself more drawing space when on a small monitor, so be sure to use this if the interface is feeling cramped and you want to temporarily move things out of the way while you're creating your art!



            

            
        
    
        

                            
                    The tool palette and Command Bar

                
            
            
                
Now that we've explored how to move palettes around, let's discuss the tool palette and Command Bar in more detail. Both of these parts of the Clip Studio Paint interface are very important and you'll be using them often, so let's get to know them before we start drawing.





            

            
        
    
        

                            
                    The tool palette

                
            
            
                
The tool palette is found in the default interface down the left-hand side of the program. This is shown in the following screenshot:



The tool palette gives us access to the various drawing and editing tools in Clip Studio Paint. The tools are separated into categories, designated by the horizontal lines going across the tool palette, and are divided into thirds.

In the top third of the tool palette are the selection and editing tools. From top to bottom, they are listed in the following order:


	Zoom

	Move

	Operation

	Move layer

	Marquee

	Auto select

	Eyedropper



The middle third of the tool palette consists mainly of our drawing and other mark-making tools. From top to bottom, they are listed in the following order:


	Pen

	Pencil

	Brush

	Airbrush

	Decoration

	Eraser

	Blend



The bottom third of the toolbar holds tools that do not necessarily fit into the other two categories. They are as follows:


	Fill

	Gradient

	Contour line paint

	Figure

	Text

	Correct line



The very bottom of the tool palette shows the current foreground and background colors, as well as a transparent color that can be selected to allow mark-making tools to act like erasers. More information on this is in Chapter 5, Erasers, Selections, and the Subview Palette.

It is best to think of the tool palette as a collection of categories of tools. Clicking on one of the icons in the tool palette will change the options available in the Sub Tool palette. The desired tool is then selected from the Sub Tool palette. You can think of the tool palette as drawers holding supplies in each one. For instance, if we clicked on the pencil in the tool palette, it is like opening a drawer where all of our pencils are stored. Then, we can select the specific pencil we want out of that category of pencils. It is always good to have the Tool palette and Sub Tool palette open near each other to make tool selecting quick and easy.



            

            
        
    
        

                            
                    Customizing the tool palette

                
            
            
                
Just like all the other parts of the Clip Studio Paint interface, the tool palette can be customized to suit our needs. Let's take a look at the different options we have to customize the toolbar.



            

            
        
    
        

                            
                    Reordering tools

                
            
            
                
Just like the palettes of the interface, the tools in the toolbar can be moved around to suit our individual needs. For the following instructions, let's move the Pencil tool up above the Zoom tool, so that it is the first tool in the tool palette. Accomplish this by following these steps:


	Click on icon of the tool in the tool palette to be moved and hold down the left mouse button.

	While holding down the button, drag the tool icon to the new location. A red line will show the current position.

	Once the red line is in the new desired place, release the mouse button.

	To put the tool icon back in its previous place, repeat the preceding steps to move it again.







            

            
        
    
        

                            
                    Renaming tools

                
            
            
                
Any of the tools in the tool palette can be renamed. To do this, complete the following steps:


	Locate the icon of the tool to be renamed in the palette.

	Right-click with the mouse on the icon to bring up the menu shown in the following screenshot:






	Select Tool Settings from the menu. The following dialog box will appear:






	In the text entry field, type in a new name for the tool.

	To accept the name change, click OK. If you change your mind and don't wish to rename the tool, click Cancel.





            

            
        
    
        

                            
                    Deleting tools

                
            
            
                
Sometimes, you just don't use a certain category of tools, and you don't want them cluttering up your space. With Clip Studio Paint, we can get rid of some of the visual clutter and delete tools that we don't use from the tool palette. Use the following steps to delete a tool and all of its sub tools:


	Locate the icon of the tool to be deleted in the tool palette.

	Right-click on the icon to bring up the menu shown in step 2 of the Renaming tools section.




	Select Delete Tool from the menu. The following message will appear:






	To proceed with deleting the tool and all of its sub tools, click OK. If we've changed our mind and want to leave the tool icon in the tool palette, we can simply click Cancel.



If you accidentally delete an important tool from the tool palette and need to get it back, all of the default sub tools are available for download on the Clip Studio website. Go to http://www.clipstudio.net/en/dl in your browser and scroll down to the Additional content and materials section, and then download the Sub Tool Package. There are instructions in this package for restoring the deleted tool to the tool palette.

Now that we know all about customizing the tool palette, let's take a minute to talk about Command Bars.



            

            
        
    
        

                            
                    The Command Bars

                
            
            
                
There are two different Command Bars in Clip Studio Paint. One is the permanent one at the top of the program, between the File menu and the area where the currently active canvas is displayed. The other Command Bar only shows up when a selection is active and is sometimes called the Selection Launcher. We'll take a closer look at the primary Command Bar first.



            

            
        
    
        

                            
                    The primary Command Bar

                
            
            
                
The primary or permanent Command Bar is located between the File menu and the Canvas display area. It is shown in the following screenshot:


The default options on the Command Bar in the preceding screenshot are as follows, from left to right:




	New File: Creates a new file

	Open File: Opens an existing file

	Save File: Saves the current file

	Undo: Reverses the last action

	Redo: Redos an undone action

	Clear: Deletes the current content (of a layer or of a selection)

	Clear Outside Selection: Deletes any content outside of the currently active selection

	Fill: Fills in the current area with a foreground color

	Scale up/Scale down/Rotate: Resizes or rotates the current layer or selection content

	Deselect: Clears active selection

	Invert selected area: Reverses the selected area

	Show border of selected area: Turns visibility of the selected area off and on

	Snap to ruler: Toggles snapping when there is an active ruler

	Snap to special ruler: Toggles snapping on a special ruler

	Snap to grid: Toggles snapping on an active grid

	Show/hide title bar and menu bar: Hides or displays the title bar and menu bar

	ClipStudio.net: This is a direct link to the ClipStudio.net website for help or downloads



We will discuss customizing the Command Bar in Chapter 2, Preferences, Shortcuts, and Other Commands.





            

            
        
    
        

                            
                    The selection Command Bar

                
            
            
                
The other Command Bar is only shown when there is a currently active selection. The following screenshot shows an area of a drawing that has been selected with the rectangle marquee tool, and below this area is the selection Command Bar:



From left to right, the options on the selection Command Bar and their functions are as follows:


	Deselect: Clears active selection

	Crop: Resizes image to the current selection

	Invert selected area: Reverses the selected area

	Expand selected area: Makes selection larger

	Shrink selected area: Makes selection smaller

	Clear: Deletes the contents of the selection

	Clear outside selection: Deletes the contents that's outside of the selection

	Cut and Paste: Cuts the selected content out and pastes it to a new layer

	Copy and paste: Makes a copy of the current content of the selection and pastes it to a new layer

	Scale up/Scale down/Rotate: Scales or rotates the contents of the selection

	Fill: Fills the selection with the currently active color

	New tone: Fills the area with a screen tone based on set parameters

	Selection Launcher Settings: Personalizes the selection Command Bar settings









            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, you have learned how to obtain Clip Studio Paint and install it. You are familiar with the default interface and can move, close, and temporarily collapse menus and palettes, and know how to reorder tools in the tool palette. We have also taken a closer look at the Command Bar in the main menu and also the Selection Launcher.

In the next chapter, we are going to take a look at the program's preferences and keyboard shortcuts before we get into our actual drawings. Read on to learn more!



            

            
        
    
        

                            
                    Preferences, Shortcuts, and Other Commands

                
            
            
                
Now that we've gotten Clip Studio Paint installed and gone over the basics of the interface, we can take a closer look at setting the program preferences before we start making new files.

In this chapter, we will cover the following topics:


	Changing the program preferences

	Using keyboard shortcuts

	Customizing the Command Bar

	Making and saving workspaces

	Creating new files and templates



Let's dive right in!







            

            
        
    
        

                            
                    Program preferences

                
            
            
                
Program preferences allow us to set up Clip Studio Paint in a way that facilitates how we work. This also allows us to change the program operations so that they don't tax computer resources. There are technically four sets of preferences in the Clip Studio Paint program: Preferences, Shortcut Settings, Modifier Key Settings, and Command Bar Settings. You can find all of these options under File in the menu at the top of the program screen:



In this section, we will be discussing the options found under the File | Preferences option. In the next section of this chapter, we will discuss the Shortcut Settings and Modifier Key Settings. In the section after that, we will discuss the Command Bar Settings. So, let's get started on the Preferences menu.





            

            
        
    
        

                            
                    Tool category

                
            
            
                
After you click on File | Preferences, the following window will appear:



The Tool category of preferences deals with how the tools in the Tool Box operate. The following is a short description of what each option does:


	Switch tool temporarily by pressing and holding shortcut key allows us to switch to a tool, but while holding down the designated shortcut key, and then switch back to the previous tool as soon as the keyboard key is released.

	Delay before switching tool temporarily is the amount of time the key must be held down before the tool is switched temporarily.

	Auto scroll at edge of canvas while dragging allows the canvas scroll to follow the cursor when a tool is dragged outside of the canvas while in use. 

	Start from current size when changing brush size by dragging on canvas starts the brush size adjustment from the current size when holding down the Ctrl and Alt keys while dragging the mouse.

	When changing brush size, display circle in the center of canvas will show a circle in the center of the canvas, indicating the new brush size when turned on.

	Show preview when creating straight lines by holding a modifier key will display a preview of the line being drawn by holding the Shift key and clicking with a drawing tool.

	Use simple display for lines being created with the figure tools will use a simple display when creating lines with the Direct Draw - Figure set of sub tools. When it is turned off, the lines being created will be previewed with their actual line width and color.

	Switch to high-speed view mode of canvas while dragging viewing tool will put the canvas in fast view mode when dragging with a tool such as the Zoom or Move tool. This can reduce the required processing capacity.

	Replace transparent color with white for drawing on layers with locked transparent pixels will use white for drawing tools when a transparent color is selected on a layer with locked transparent pixels.





            

            
        
    
        

                            
                    Tablet category

                
            
            
                
The Tablet menu under the preferences may have different options depending on whether you are using a Windows, Mac, or tablet computer. The following are the settings under the Tablet preferences in Windows:


	Under the Using Tablet Service, there is an option for Wintab or for TabletPC. Select Wintab when using a regular graphics tablet, such as a Wacom brand tablet that plugs into your computer. Select TabletPC when using a Tablet computer such as a Windows Surface tablet. 

	The Use mouse mode in setting for the tablet driver should be turned on when mouse mode is enabled by the tablet driver settings.

	The Set tablet operation area with application setting configures the display area and tablet operation area to Clip Studio Paint when turned on. These settings should be used when the tablet driver software doesn't have these options.







            

            
        
    
        

                            
                    Touch gesture category

                
            
            
                
If you are working on a system that has a touchscreen, the options to configure touch operations can be found under the Touch Gesture menu. Using the drop-down menus next to each gesture allows the operations to be customized.
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The next set of preferences in the preference window deal with the interface. They are explained as follows:


	Automatically activate IME when editing text layer can be used when entering Japanese characters into a text layer.

	Automatically switch IME when typing text into panel changes the IME mode when inputting characters. Both IME settings are used for Japanese character input.

	Under the Color setting, the drop-down menu can be used to change the interface from the Light color scheme to the Dark color scheme. The Density slider to the right of the drop-down can be adjusted left or right to change the brightness or darkness of the color scheme.



Use the dark color combination to minimize eye strain when working for long periods of time!


	Under Touch Operation Settings, the checkbox can be used to activate adjusting the interface to be suitable for touch operations. Setting the buttons below to Small, Default, or Large options will adjust the elements of the interface accordingly. When using Clip Studio Paint on a computer with a touchscreen, it is helpful to activate this preference.

	Configure basic layout of the palettes to one for tablets will switch the user interface to one that is suitable for tablet devices.









            

            
        
    
        

                            
                    Performance category

                
            
            
                
Now, we will learn about the options under the Performance category of preferences. They are as follows:


	Destination to create virtual memory is the option that you can use to specify the disk drive where Clip Studio Paint can create virtual memory. If you have a secondary hard drive dedicated to creating virtual memory for programs, this is where to specify it. Be sure that the folder specified is in a destination with enough capacity, otherwise, the program may become unstable.

	Allocate to application allows you to specify the percentage of system memory to allocate to the application. Changes take effect after the program is restarted.

	Undo count allows you to specify the number of undo steps you want the program to remember. On systems with less RAM capacity, setting this number too high can cause the program to run slowly.

	Time to recognize as other object to undo after finishing drawing is used to specify the number of seconds needed to recognize an operation as another when using the same tool consecutively. For example, if drawing quickly with a pencil tool, the program may recognize several consecutive strokes as one action if they are made before the allotted time has passed.
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Under the Cursor category of preferences, we will find the following options:


	Shape of Cursor allows us to set the cursor shape when using various tools in Clip Studio Paint. Using the drop-down menus will change the cursor of the tools based on the preferences set.

	Additional display when brush-size cursor is small is used to set an additional display to the cursor when the brush size is too small to be seen easily. Using the Line or Dot options can make it easier to see the cursor when working with a very small brush size.

	Display position of reversed cursor is used to specify how the cursor is displayed when using tools with the stabilization setting. Setting No Delay will make the cursor show in the current actual position of the mouse. Setting Delay for stabilization will show the cursor in the position of the stabilized line, causing a slight lag in the movement of the cursor.





            

            
        
    
        

                            
                    Layer/Frame category

                
            
            
                
The next category of preferences is the Layer | Frame preferences. These options are shown in the following screenshot:



The following list explains these options in detail:


	Layer name for duplication controls the settings for the name of a layer created by duplicating another layer. This can be set using the drop-down menu options.

	Set blending mode [Through] when creating layer folder sets the default combine mode to Through when a folder for layers is created.

	Opacity when creating selected area stock set the percentage of opacity when creating new selected area stock.

	Tone effect in case of scaling down sets the display method when the canvas scale is reduced. This is used for artwork with screen tones.

	Area Color beneath the Mask settings allows for the display color when creating a layer mask to be set. The default is a blue color. By clicking on the colored box, the color can be changed to another of the user's choosing. 

	Opacity of area display sets the opacity of the color that's displayed when creating the mask area.

	The Display mask area when creating mask checkbox allows the mask area to be displayed when creating a layer mask.

	Under the Frame Border settings, the horizontal and vertical space between frame (panel) borders can be set. More about creating panels is in the New Files and Templates section of this chapter.

	Display mask area when creating frame allows the mask area to be displayed when creating a panel frame.





            

            
        
    
        

                            
                    Light Table category

                
            
            
                
The Light Table category of preferences is used to adjust settings for the light table, which is used on cels and layers that have been registered in the Animation cel palette. More on animating with Clip Studio Paint is in Chapter 19, The Clip Studio App and Getting Animated.

The following are the settings available for the Light Table:


	Opacity sets the opacity of layers in the light table.

	How to show sets how the color of light table layers is displayed. When Color is selected, the colors of cels and layers are displayed as is. When Half color is chosen, the color set in the Layer Color option is combined with the actual cel and layer colors. When Monochrome is selected, the cel and layer colors are grayed while black areas are changed to the color set in Layer color and white is changed to the color set for Sub color.

	Layer color sets the color of the layer when using the Half Color or Monochrome display colors, as described previously.

	Sub color is used to set the display color used in place of white when Monochrome is selected, as described previously.









            

            
        
    
        

                            
                    Ruler/Unit category

                
            
            
                
Next, we will move on to the Ruler | Unit category of preferences. These preference settings are described as follows:


	The Line Color options allow the colors of different types of ruler, grid, and crop mark lines to be set. We will be covering rulers in more detail in Chapter 6, All About Rulers. The options for Ruler to snap (currently active ruler), Ruler not to snap (ruler not currently active), Grid line, Grid dividing line, and Crop mark | default border can all be set by clicking on the current color box and selecting a new color for the ruler line from the Color Settings dialog box.

	Opacity of Ruler 

	Grid | Crop mark is used to set the opacity of the ruler, grid, and crop marks.

	Decide direction again if coming back to start point while snapping perspective ruler, when turned, on allows the direction of a drawn line to be changed if the tool is dragged back to the starting point on the perspective ruler.

	Unit of Length allows the units used by Clip Studio Paint to be set from pixels (px) to millimeters (mm). 

	Text unit sets the text size unit from Q value (Q) to points (pt).





            

            
        
    
        

                            
                    Canvas category

                
            
            
                
Our next category of preferences deals with the Canvas and how it is displayed. The following is a list of these preferences:


	Display quality sets the quality of the display of the canvas. When on the Default setting, the image may become pixelated or otherwise rough looking when rotated or scaled. However, this setting minimizes processing capacity. Setting to High Quality displays the canvas in high quality always, but the program may become slow when the canvas is rotated or zoomed.

	The color boxes under the Transparent options configure the color of the checkerboard grid displayed in transparent areas of an image. These colors can be configured by clicking on the color boxes and setting the new color using the color settings dialog box. The following is an example of the transparency checkerboard pattern in the default white and gray colors:






	The Scale settings are used to set the steps of scaling the canvas when clicking with the Zoom tool, Navigator palette, View menu, and so on. The Scale list displays the current list of scale steps. The Input box allows you to change the display scale that's currently selected in the Scale list or input a new scale step. The Add button adds the number in the Input box to the Scale list. The Delete button deletes the currently selected scale from the Scale list. The Change button changes the selected scale in the Scale list to the scale in the Input box. The Revert button resets the display scales back to their initial settings.

	The Angle setting specifies the angle that the canvas will be rotated at when the canvas is rotated using Rotate left or Rotate right in the Navigator palette, View menu, and so on.

	Settings of display resolution configures the measurement of the display resolution for an accurate Print Size preview. Clicking on the settings button shows the dialog box. Adjusting the slider in the dialog box until the ruler is displayed is the same scale as an actual ruler that adjusts the display resolution to be more accurate for printing.
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The next category under the preferences is the File category. It contains the following preferences:


	Enable canvas recovery saves canvas information at regular intervals. If Clip Studio Paint terminates abnormally, the canvas will be restored when the program is activated again.

	Saving interval for restoration info controls how often recovery information is saved. The interval time can be set between 5 to 60 minutes.

	Beneath the Import IllustStudio Document (xpg) category and the Import ComicStudio Page Files (cpg) category, there are several checkboxes that control how .xpg and .cpg files are imported. These checkboxes are Combine all layers, Anti-aliasing vector, and Rasterize vector. The Combine all layers option flattens the file upon import, the Anti-aliasing vector enables anti-aliasing for any vector layers, and the Rasterize vector option will convert Vector layers to Raster layers upon import.

	Auto save when switching page will automatically close and save the page file you were previously editing when a new page is opened from the story file. This preference is only available in Clip Studio Paint EX.

	Always open with new tab when opening page with double-click allows you to configure how to open a page file when opening it by double-clicking from the Page Manager window of a story file. When turned on, the page file will open in a new tab. When turned off, the page file opens after the tab of the previous page file closes. This preference is only available in Clip Studio Paint EX.
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The next category of preferences, the Color Conversion preferences, allows us to configure default values for color profiles. They are as follows:


	RGB profile allows you to use the drop-down menu to set the desired color profile for RGB color.

	CMYK profile allows you to use the drop-down menu to set the desired color profile for CMYX color.

	The Rendering Intent drop-down menu configures how to process the color conversion between color spaces. The Perceptual option preserves the visual relationship between colors so that the colors are perceived as natural, even when the color values are changed. Saturation compares the maximum highlight in the source color space with the maximum in the destination color space and shifts the difference. RelativeColorimetric attempts to reproduce vivid colors, even if the color accuracy is compromised. AbsoluteColorimetric doesn't change colors that fall outside the destination color gamut.

	Library to use allows you to choose between the Icclibrary and MicrosoftICM libraries via the drop-down menu.
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The next category of preferences we will explore is the Edit Text category. The options for this category are listed as follows:


	How to insert new text controls how new text is added. The options are Add to current layer, which will add the new entered text to an existing text layer, and Always create new layer, which will create a new layer each time text is entered.

	The New text property menu allows you to configure the default settings for entering new text. The options are Selected text tool property, which uses the settings in the Tool Property palette of the Text tool, and Copy from current text, which uses the settings of text already entered on the page.

	How to show line break configures how to show line breaks in the Story Editor. The Normal option shows a line break in the specified position. Display by sign without line break inserts a symbol in place of the line break without showing the actual line break.

	In Divide text by line break, the method of adding line breaks can be configured. When set to Do not divide, line breaks will not be inserted when the Enter key is pressed. The remaining options configure how many times the Enter key must be pressed to insert a line break – from one to three times.

	All settings under the View section configure how text is displayed in the story editor. 

	Direction sets the text to either display horizontally or vertically in the Story Editor.

	Main text font allows you to configure the text font and size of text entered in the Story Editor.

	Reading font configures the text and size of reading text.







            

            
        
    
        

                            
                    3D settings category

                
            
            
                
Finally, we come to the 3D settings in the preferences. These settings are detailed as follows:


	Drawing figure to be used with pose materials allows you to set which version and gender of the drawing figure model to use when loading pose materials onto the canvas

	Use multi-sampling can be turned on to apply multi-sampling to 3D materials and improve the display quality



Wow, that's a lot of program preferences! It is easy to get overwhelmed by having so many options, but don't fret. Most users will find that the default preferences work fine for them. But with the information presented in this chapter, you will now have an idea of the aspects of Clip Studio Paint that can be personalized should you need to tweak anything to suit your working style and computer system resources.

In the next section, we will cover the keyboard shortcuts, including how to set custom shortcuts. Read on to learn more about optimizing your workflow.



            

            
        
    
        

                            
                    Using keyboard shortcuts

                
            
            
                
Learning keyboard shortcuts is a great way to streamline your workflow. Using keyboard shortcuts with the hand that isn't holding the drawing stylus helps reduce the amount of time spent moving your arm back and forth to switch tools or even to use menu options like creating a new file or saving. Let's take a look at customizing our keyboard shortcuts to start familiarizing ourselves with them.

To access the keyboard shortcut settings, go to File | Shortcut Settings in the File menu. This will open the Shortcut Settings dialog box. The Shortcut Settings window is shown in the following screenshot:



We'll be working in the Shortcut Settings menu for the next few sections.



            

            
        
    
        

                            
                    Different categories of shortcut settings

                
            
            
                
When you open the Shortcut Settings menu, you will notice at the top there is a drop-down menu called Setting area. This has several options regarding different categories of shortcuts that can be chosen from and helps to keep things organized instead of one big long list of the many options that can have a keyboard shortcut assigned to them. Here's what each of the category names means:


	Main Menu: These are the options in the File menu, such as New, Save, Window, Help, and so on.

	Pop-up Palette: These shortcuts control a pop-up palette that will come up next to the cursor position when the keyboard shortcut is pressed. 

	Option: These shortcuts control options, such as Subtool settings (brush size, paint density, and so on) and other options.

	Tool: These shortcuts control switching between tools and sub tools.

	Auto action: This list allows auto actions to be set to keyboard shortcuts. We will be covering auto actions in more detail in Chapter 13, Auto Actions and Your Workflow.



Now that we're familiar with the categories of shortcuts, let's look at how we can view and customize them.



            

            
        
    
        

                            
                    Viewing an existing keyboard shortcut

                
            
            
                
Many tools and functions of Clip Studio Paint already have keyboard shortcuts set as defaults in the program. Here's how we can view the shortcuts that are already set up:


	Open the Shortcut Settings.

	Locate the appropriate category of settings in the Setting area drop-down menu. Refer to the previous section for explanations of the different categories.




	If the program function already has a shortcut assigned to it, it will be listed to the right of the function or tool name, as shown in the following screenshot:








            

            
        
    
        

                            
                    Editing, adding, and deleting shortcuts

                
            
            
                
Now that we know how to navigate the Shortcut Settings and see what functions already have shortcuts, we can customize them to suit our needs. First, we will add a shortcut to a function that already has one, then we will create a new shortcut for a function that doesn't have one already, and we will delete a shortcut.

Let's get started!
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Despite its name, the process of adding a shortcut does not assign a shortcut to a function without one already, but rather adds a second keyboard shortcut. This can be useful in some instances. For instance, you could have two keyboard shortcuts for making a new document, one for use when using your right hand and one for the left hand. This is just one idea – use your imagination and your own personal workflow to come up with ways to use this Clip Studio Paint option to streamline your process.

Now, let's add a shortcut. In this example, we are going to add a secondary shortcut to the File | New command. The default command in Windows is Ctrl + N, which can be used with the right hand on a standard keyboard. We are going to add a command that can be used with the left hand. Follow these steps to complete this process:


	Locate the File | New function under the Shortcut Settings. Click on the name of the function to highlight it.

	On the right-hand side of the Shortcut Settings box, click on the button marked Add Shortcut.

	On the keyboard, press down the keys that are desired for the new keyboard shortcut. For instance, when putting in the new shortcut Ctrl + Shift + Alt + Z, all four of the listed keys were pressed down on the keyboard, as though executing the shortcut. Clip Studio Paint will create the shortcut based on these key presses.

	Once the keyboard shortcut is registered by the program, the new shortcut will be listed in the white box next to the function. Selecting another function or clicking on the OK button will accept the shortcut. In the following screenshot, the new Ctrl + Shift + Alt + Z keyboard shortcut is listed beneath the previous Ctrl + N shortcut.

	Click OK to set the changes:





If the shortcut you are trying to assign to a function is already in use, you will see a warning message at the bottom of the shortcut settings window. It will state what function is already using this combination of keys, and state that assigning this shortcut will delete the other occurrence. Be certain that this is what you want to do before clicking OK!



            

            
        
    
        

                            
                    Editing a shortcut and assigning a shortcut to a function without an existing one

                
            
            
                
Functions and tools without existing shortcuts can have shortcuts added to them. This process is similar to the one listed previously for adding a shortcut to a function.

For the following example, we're going to create a keyboard shortcut for the Export (Single Layer) - .psd (Photoshop document) function of Clip Studio Paint. Follow these steps to complete this process:


	Locate the function or tool to add the keyboard shortcut to. In this example, we are using the Export (Single Layer) - .psd (Photoshop document) function. Click on the function name to highlight it.

	Click on the Edit Shortcut button.

	Press down on the buttons on the keyboard that are desired for the new shortcut. In the following screenshot, the keys Ctrl, Shift, Alt, and the letter P were pressed to register the shortcut:








	Click on another area of the shortcut settings window or press the Enter button to confirm the new shortcut.

	Click on OK when finished to initialize the new shortcut.



Editing an existing shortcut is also a simple process. Follow these steps to edit a shortcut:


	Locate the existing shortcut in the list of shortcuts.

	Click on the shortcut to highlight it.

	Click on the Edit Shortcut button.

	Press the buttons on the keyboard that are to be used for the new shortcut.

	Click on OK to initialize the new shortcut.



Double-clicking on a shortcut name will allow you to add a shortcut to a function or tool without an existing shortcut, or to edit an existing shortcut. 



            

            
        
    
        

                            
                    Deleting a shortcut

                
            
            
                
Getting rid of a keyboard shortcut is also a simple process. Follow these steps to delete the secondary shortcut we added to File | New at the beginning of this section:


	Locate the shortcut to be deleted in the Shortcut Settings window. Click on the shortcut to highlight it.

	Click on the Delete Shortcut button.

	The highlighted shortcut will be deleted.



There is no confirmation when deleting shortcut settings, so be certain you have selected the correct shortcut before clicking the Delete button!

Now that we know how to set up our keyboard shortcuts, let's learn how to customize the Command Bar. Read on to learn more.







            

            
        
    
        

                            
                    Customizing the Command Bar

                
            
            
                
The Command Bar is the set of icons in the Clip Studio Paint user interface that appear between the File menu and the area where the canvas is displayed. It is shown in the following screenshot:



This section of the user interface can be used to greatly improve your workflow by customizing it to include the functions of Clip Studio Paint that you use most often. You can even include your most used drawing colors! In this section, we'll cover how to customize the Command Bar to make it your own.



            

            
        
    
        

                            
                    Adding items to the Command Bar

                
            
            
                
In this section, we will add the Create New From Clipboard item to the Command Bar and then we will learn how to rearrange icons. Follow these steps to complete this task:


	
Open the Command Bar Settings by clicking on File - Command Bar Settings. The following dialog box will appear:








	Like the Shortcut Settings from the previous section, there are different categories of items we can add to the Command Bar. These are accessed via the drop-down menu in the top left of the screen. For this example, we are going to add Create New From Clipboard to the Command Bar, which is in the Main Menu category and under the File section.

	Select the function to add to the Command Bar and click on the Add button. Alternatively, you can also click on the item and drag it to the Command Bar while holding down the mouse button. While using this method, a red indicator will appear where the new icon is being placed. so simply release the mouse button once the new icon is in the desired place!

	To rearrange icons in the Command Bar, simply click and drag them while the Command Bar Settings window is still open.




	The icons in the Command Bar are separated into groups by small vertical lines. These can be used to group icons into categories. To add a separator, select an icon in the Command Bar and click on the Add Separator button. A separator line will be added to the right of the selected icon. Note that this only works if the icon doesn't already have a separator to the right of it. This means that current groups can be separated, but an empty group cannot be created.

	To insert a command nestled under another icon, first, select an icon in that group on the Command Bar. Then, select the new icon to be inserted in the Command Bar Settings window. Click on the Insert into group button to add the new function underneath of the current function. In the following screenshot, two commonly used Pencil tools have been added, nestled together under the same icon, and can be accessed by clicking on the downward pointing arrow to the right of the icon:






	Once you have finished adding icons to the Command Bar, click on Close to close the settings. To revert the Command Bar back to its initial settings, click on the button marked Restore initial layout.





            

            
        
    
        

                            
                    Editing icon settings

                
            
            
                
In addition to adding functions and tools to the Command Bar, the settings of the icons can also be customized. In the preceding section, we added the Create New from Clipboard command to our interface. As you can see in the following screenshot, the icon for the existing New command and the command that we added are both the same, making it difficult to discern them from each other:

 

Let's edit the icon for the Create New from Clipboard command to make them easier to distinguish:


	Access the Command Bar Settings.

	Click on the icon to be edited to select it. In this example, we'll be using the Create New from Clipboard icon we added in the previous section.

	Click on Settings in the Command Bar Settings window to bring up the Icon Settings window. This is shown in the following screenshot:






	To load a custom icon image, click on the Specify image file... button. Navigate to the location of the image file to be used and click on Open to load the new icon image.

	In this example, instead of loading a custom icon, we will instead be adding a background color to the existing icon to distinguish it from the other New icon. To do this, click on the checkbox to the left of Background color of icon. To set the background color, click on the color selector box that will be active once the checkbox is selected. Choose a color from the Color Settings window and click on OK to confirm.

	To reset the icon to its default settings, click on the button labeled Revert icon to initial settings. Click on Cancel to undo any changes to the icon and exit the Icon Settings window.

	Once we're finished making desired changes to the icon, click on OK to confirm the changes.



As you can see in the following screenshot, the icon on the right now has a white background color that we added in the Icon Settings window, making it different from the icon on the left and marking it as our Create New from Clipboard command:





            

            
        
    
        

                            
                    Deleting icons from the Command Bar

                
            
            
                
In addition to adding items to the Command Bar, we can also remove icons that are no longer desired. Follow these easy steps to delete an unwanted icon from the Command Bar:


	Access the Command Bar Settings.

	Click on the icon to be deleted in the Command Bar to select it. 

	Click on the Delete button to delete the selected icon.



And that's it! Now that we've gotten familiar with customizing the program options, let's customize the look of the workspace before we start drawing. Keep reading to learn more about custom workspaces!



            

            
        
    
        

                            
                    Making and saving workspaces

                
            
            
                
One of the best features of Clip Studio Paint is the ability to create and save different workspaces for different tasks. A workspace is a collection of palettes and their position in the interface. Clip Studio Paint comes with a few workspace options already in the program, but we can also create our own workspaces.
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Follow these steps to create and save a workspace:


	Use the directions in Chapter 1, Installing Clip Studio Paint, Recommended Systems, and Interface Basics to move, collapse, and close the palettes to set up a workspace. In the following screenshot, the palettes have all been moved to the left-hand side of the interface to make it easier to select items for a left-handed user:






	To save the current workspace, click on Window in the File menu, then go down to Workspace and click on Register Workspace. The following box will appear:



 


	Enter a name for the workspace in the text entry box. Then, click OK to save the workspace settings.

	Your workspace is now saved!





            

            
        
    
        

                            
                    Switching between workspaces

                
            
            
                
Now that we've saved one of our own workspaces, we can switch to that workspace again whenever we'd like. Follow these steps to load a previously saved workspace:


	Click on Window in the File menu, then go to Workspace to see the following options:



 




	To switch back to the default workspace, click on the Reset to Default option.

	To change to one of the workspaces included in Clip Studio, click on the Illustration or Comic options.

	To load the custom workspace, locate it in the area above the Illustration and Comic workspace names and click on the name of the workspace to reload. In the preceding screenshot, it's the option named Left Handed. 

	The new workspace will be loaded.





            

            
        
    
        

                            
                    Managing and deleting workspaces

                
            
            
                
Sometimes, you may want to rename or delete workspaces that you've saved. We can do this easily just by following these steps:


	In the File Menu, click on Window | Workspace | Manage Workspace... The following menu will appear:










	To delete a workspace, click on the name of the workspace in the left-hand side of the menu to highlight it in blue. Then, click on the button marked Delete on the right-hand side.

	To rename a workspace, click on the workspace name to highlight it in blue. Then, click on the button in the right-hand side marked Change name of settings. Enter the new name for the workspace and click on OK to save the new name.



As you can see, it is easy to make new workspaces and change between them! This means that we can make workspaces for any task. Perhaps you want to make a workspace for drawing and inking, and another for coloring. The sky is the limit, so get creative with your workspaces and use them to maximize your workflow for efficiency.

In the next section, we'll start making new files and also learn about file templates.



            

            
        
    
        

                            
                    New files and templates

                
            
            
                
Making a new file in most computer programs is pretty easy. You just make a new file and off you go! But in Clip Studio Paint, there are some terms and options that need an explanation so that you are able to create new files that will be the right size and have the right specifications for whatever project you're working on. For some users of Clip Studio Paint, some of these options and terms won't be necessary to know. But for anyone doing projects for print, they are very important. In this section, we will discuss the terms of creating a new file, and also learn how to create template files and load templates into new pages. Let's get started!



            

            
        
    
        

                            
                    The New file window – explained

                
            
            
                
When first creating a new file in Clip Studio Paint, the number of options can look daunting. Not to worry though – in this section, we will explore each option in the new window and explain what each one means.

The following screenshot shows the New file dialog box. Note that if you are using Clip Studio Paint Pro, you will not have the Multiple Pages or Cover Page settings that are available in Clip Studio Paint EX:



Wow, that's a lot of options! It can look scary at first, but let's break it down piece by piece and talk about each option individually so that we know what they all do.





Use of work is the area where we can select from a category of preset document options. The categories are Illustration, Comic, Printing of fanzine, Show all comic settings, and Animation. Clicking on one of these categories changes the available settings as well as the Presets, depending on which Use of work category is selected. For instance, selecting the Illustration category hides any settings related to making a comic.

File name is a text box where the name of the file can be added. This field must be filled in when making multiple page files.

Save to is the folder where a multiple page file is saved to. To change the destination folder, click on the Refer... button to the right of the current file path.

Preset is a drop-down menu of preset page sizes and settings that correspond to the current selection made in the Use of work section. This is also where any user made page presets will appear. We'll learn more about saving our page settings in an upcoming section.

Unit is where we can set the unit of measurement for the page. In the preceding screenshot, it is set to mm. It can be set to cm, in, px, or pt via the drop-down menu.

Under the Canvas section, we have several options. The Width and Height are the measurements of the new canvas that will be produced, in whatever unit of measurement is set in the Unit drop-down menu. These can be adjusted either via the arrows to the right of the text box, or we can click inside the box and simply type in a new measurement. To switch the measurements for the height and width, click on the curved double-headed arrow button to the left of the Width and Height boxes.

Resolution is where you can set the resolution in dpi for the new document. For print projects, this should be at least 300 dpi.

Create all of your projects in at least 300 dpi (or larger, if your computer can handle it!) so that you never have to redo something if you decide after making it that you want to print it. Images with low resolution will look pixelated and blurry when printed.

Basic expression color is where you can set the default expression color of the image. Basic expression color can be changed via individual layers in the image later, no matter what the expression color is set to during this step. However, if you are creating a pure black and white or grayscale image, it can save time (and file space!) to set the basic expression color now.

Paper Color is where you can set a default paper color layer. Activating the checkbox here will create a Paper layer in the file with the indicated paper color as a fill. This paper color can be edited later. If the Paper color is not active, then the new file will be transparent.



Template is the checkbox where we can load a template into the new file. We'll discuss more about templates in the next section.

The Manga draft settings checkbox activates the Binding and Border size options. Let's discuss the Binding size and Border sizes in more detail.

Binding (finish) size are the dimensions of the finished page after printing. In printing, we have a bleed area that is cut off the edges of papers after they are printed. This is how a full bleed (an image going off the edge of the paper) is achieved. The Width and Height settings in the Canvas area should be the paper size, including any bleed area. The Binding size Width and Height should be the finished dimensions of the page after trimming has occurred. For instance, if you have a 6 x 9 inch finished page with a .25 inch bleed margin, then we would need to add .25 inches to all four sides of the paper. This makes our canvas Width and Height 6.5 x 9.5 inches, but our Binding (finish) size is 6 x 9 inches. Preset finish sizes can be selected from the drop-down menu or entered manually via the text entry boxes.

Default border (inner) size is the size of the margin inside the finished page. This is sometimes called the safe area. We want to keep any important elements of the art in a comic or other printed design away from the very edges of the page, especially when doing a bleed. This is because the very edges of the paper are cut down to the finished size, and sometimes those cuts aren't precise. Having text or other important elements too close to the edge can result in those things getting cut off! As in the Binding size, the Border size can be selected from the drop-down menu or entered manually in the text boxes.

X offset and Y offset are used to offset the border to the left, right, up, or down. This feature is very handy if you need to move the margins to the left or right to compensate for the binding of a book, or if you want to move the inner border up slightly to allow for page numbers or notes at the bottom of the page.

Setting for fanzine is used to export the work with data capable of being used at a fanzine printer. This option is used mainly for Japanese doujinshi.

Multiple pages is an option that's only available in Clip Studio Paint EX. Checking this box allows you to make a file with multiple page files nested in it. This option is invaluable for anyone making graphic novels, or longer chapter comics. By using a multiple page file, you can look at all the pages in the file at once done, check the flow of the work, rearrange pages easily, and delete or add pages.





The Number of pages box controls how many pages should be created in the new file, and can be selected either using the downward pointing arrow to the right of the text entry box, or a number can be typed in manually. The Spread corresponding page checkbox will turn facing pages into a two-page spread automatically. The Binding point controls which side of the book the binding will be on. For instance, English books are bound with the spine on the left-hand side while Japanese books have the spine on the right.

When creating a Multiple page file, the Cover page option can be used. When active, this creates a front and back cover to the file. Note that these covers are included in the page count. Therefore, a 32-page file will yield 28 inner pages, a front outside cover, front inside cover, back inside cover, and back outside cover. The Resolution, Basic expression color, Paper color, and Template can also be set for the cover, just as with the Canvas.

There are also two options for the Cover page layout. The first icon is to make the cover as a two-page spread so that the back and front of the cover are one continuous page and can both be designed and drawn on at the same time. When this option is selected, the Specify spine width option can be used to set the width of the spine of the finished book so that the appropriate amount of spine can be added to the cover. The icon on the right under the Cover page layout separates the cover pages into individual pages. 

The Story Information section of the New file window is optional but can be very helpful, especially if working with a team or when sending files out to a printer. Story name allows you to enter the name for your story. The drop-down menu to the right of the text entry box controls the location the story name will appear on in the new page. By activating the Number of stories checkbox, the number of the current story can be entered. The Subtitle text box can be used to put any additional title information. The Author box can be used to add the name of the author of the comic story, and the drop-down menu to the right can be used to determine where on the page to display the author name. By activating the Page number checkbox, a page number will be displayed automatically in the bleed area of the pages. The drop-down menu to the right of the Page number checkbox can be used to control where to display this number. The Start number box is used to indicate what number should be the first in the number series. 

The Folio section of the New File window is where folio information can be added to the new pages. Folio is another name for page numbering. The Folio option will leave visible page numbers on the new pages, inside of the bleed area. Start number allows us to set the number to begin the page numbering with. The color of the page number can be set with the Color drop-down menu. To add a stroke to the outside of the page numbers, activate the Put edges checkbox and then indicate the desired thickness of the outline in the text entry box to the right. The Folio checkbox is used to activate the Folio options and indicate that Folio information should be included on the new file.





The drop-down menu to the right of the checkbox allows you to customize where the page number shows up on the page. The Format text entry boxes are used to format any text around the page number (for instance, Page 1 of 35 could be entered in the text entry boxes.) Gap with default border is used to set the gap between the folio information and the default border of the page. The larger the number in the gap options, the larger the space between the folio information and the default border line will be. The Font drop-down menu allows us to set the desired font to use for the folio information, and the Size option next to it sets the size of the folio text.

Finally, there is a Blind folio checkbox. The Blind Folio puts a page number on the inside edge of the page, where the spine would be when the pages are bound into a book. These folio numbers are not visible when the book is bound.

Now that we know what all of these terms and options are, we can make a new page! In the next section, we are going to create a custom page, sized to a standard American comic book size paper with the recommended margins. We will save this page as a preset and then create a new file with a template added to it as well. Let's get started!



            

            
        
    
        

                            
                    Creating a custom sized page and saving a preset

                
            
            
                
Though Clip Studio Paint comes with lots of preset page sizes for Japanese and European papers, it doesn't come with the sizes that are most common to American comic books. We are going to create a standard American comic book size page for creating new files and save it as a preset for continued use later.

Follow these steps to complete this activity:


	Go to File - New or press Ctrl + N to open the New dialog box.

	In the Use of Work section, click on the Show all comic settings icon. 

	Change the Unit drop-down menu to the right of the Preset drop down to in (inches). 

	In the Width entry box, enter 7.00.

	In the Height entry box, enter 10.50.

	Set the Resolution to 300 dpi (or more, depending on your computer hardware).

	Set the Basic expression color. I usually leave this on Color, but if the majority of your work is in black and white or grayscale, you may wish to choose a different mode. Individual layers can be adjusted later in the file, so even if we choose a Grayscale mode in this step, we will still be able to color our work later if we decide to.

	Set the Paper Color by clicking on the checkbox if it's not checked already, then click on the color selector box to choose the paper color. For this example, we will be leaving the paper color white.

	Click the checkbox next to Manga draft settings to activate it if it is not already active. In the Binding (finish) size, enter 6.75 as the Width and 10.25 as the Height. 

	Enter a Bleed width of 0.10.

	Under the Default border (inner) size, enter 6.25 as the Width. Enter 9.75 as the Height. Leave the X offset and Y offset both at 0.00. Your settings should look like what's shown in the following screenshot:






	Now, we will save this set of page settings as a preset so that we can use it again later. To do this, click on the Save icon to the right of the Preset drop-down menu. This will bring up the Register to preset window, which is shown in the following screenshot:



 


	Enter a name for the new preset in the Preset name box. Use the checkboxes to indicate which settings should be saved. When finished, click on OK to save the preset. 

	The new preset will be in the Preset drop-down menu and ready to use for future projects!



In the next section, we will learn about adding templates to our files.







            

            
        
    
        

                            
                    Adding templates to a new file

                
            
            
                
Templates can save a lot of time. For instance, if you are making a series of comics that all have the same four-panel layout, then by using Clip Studio Paint EX, you can make a multiple-page file and load the four panels into every page of the file upon creation, saving valuable time! No matter whether you're using the Pro or the EX version, though, using templates can save a lot of tedious work. So., let's learn how to load a page template into a new file by following these simple steps:


	Open the New dialog box by going to File - New (or press Ctrl + N).

	If you saved the preset page from the previous exercise, now is a great time to try it out by selecting it from the Preset drop-down menu.

	Under the Canvas section, click the checkbox next to the word Template. This will bring up the Template dialog box.

	Scroll down through the template selections to find the desired template. For this example, we will be using the 4 frames 2 strips with titles template. Click on the template to select it. 

	Click on OK in the Template window. Now, the chosen template will be shown next to the Template checkbox. To change to a different template, click on the button with the name of the current template on it to bring the Template dialog box up again.

	For EX users, check the box next to the Multiple pages option. In the drop-down menu, select 8 as the number of pages. Add a title for the File name in the text box at the top of the window, and choose a folder to save the new file in.

	Your screen should now look something like the following screenshot. Click on OK to create the new file:







Creating a file with multiple pages can take a few seconds to a few minutes, depending on the number of pages and the speed of your computer system. Be patient!

The following screenshot shows our eight-page file with the framing template we chose on each page:



Framing templates will adjust to fit the Default inner border of any page settings, by the way, so no worries about using them on smaller or larger page sizes!



Now that we've learned all about the program preferences, keyboard shortcuts, workspaces, and how to create a new file, we can move on to something much more fun: Clip Studio Brushes! Read on to learn about using and adjusting brushes in the next chapter.
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In this chapter, we learned how to access the program preferences. We learned what each preference controls in the user interface. We also learned how to access and change keyboard shortcuts. Then, we learned how to make a new file so that we can begin drawing.

In the next chapter, we will begin learning about the different types of brushes in Clip Studio Paint, and the basics of customizing them to fit our personal style.



            

            
        
    
        

                            
                    Clip Studio Paint Brushes: an Introduction

                
            
            
                
In the analog world, drawings are made on paper or canvas with pencils, ink, paint, brushes, and many other tools. In the digital world, we also have a myriad of tools—many that imitate real-world art supplies and techniques. In Clip Studio Paint, the bulk of these mark making tools fall under the heading of brushes, which includes sub-categories like pencils, pens, markers, pastels, oil paints, and more. We're going to get familiar with our toolbox of brushes so that when we get to drawing, we will be familiar with the default tools and how we can change these tools to suit our individual style of working. 

In this chapter, we will cover the following topics:


	The categories of Clip Studio Paint brushes and how to navigate them

	Introduction to the Clip Studio Paint brush engine

	Tool properties and settings

	Copying, saving, and restoring brushes



Let's jump right into learning about these versatile digital art tools!



            

            
        
    
        

                            
                    Navigating the brushes

                
            
            
                
Out in the world of analog art, a brush is a very specific tool. But in Clip Studio Paint, the word brush can refer to several different tools. Usually, we use the term brush to refer to a digital tool that is used with the stylus or mouse to draw lines, as opposed to other tools that fill colors, or select, or perform the other operations that can be performed in digital art.



Most of the tools that we would refer to as brushes can be found in one section of the toolbar in the user interface. These tool icons are labeled as Pen, Pencil, Brush, Airbrush, Decoration, Eraser, and Blend. The icons for these tool categories are shown in the following screenshot:



Clicking on one of these icons in the toolbar makes a change happen in the Sub Tool palette. For instance, when we click on the Pencil icon in the toolbar, we can see the categories of pencils in the Sub Tool palette, as shown in the following screenshot:



The buttons at the top of the Sub Tool palette show the different categories of tool available under the Pencil heading. These include Pencil and Pastel as defaults.

In many of the screenshots in this book, you may see tools that are not included in the default tools of Clip Studio Paint. In many instances, these tools were downloaded through the Clip Studio resources, which we will cover in Chapter 19, What is the Clip Studio App And Getting Animated. Any that have not been obtained through this resource were either made by me or purchased from Flyland Designs (www.flylanddesigns.com) or Ray Frenden (www.frenden.com).

The Pencil and Pastel categories have additional tools beneath them, such as the Darker pencil, Lighter pencil, and Mechanical pencil in the Pencil category. These tools are a collection of settings that change how the stylus interacts with the canvas, and changes the look of the digital marks that are made. For instance, the following screenshot shows circles that have been drawn with the Darker pencil on the left and the Mechanical pencil on the right:



See the difference in the look of the lines? The Darker pencil produces a thicker, bolder line with more variation, like what you would get using a traditional graphite pencil. The Mechanical pencil is a thinner, more uniform line.

Take a moment now to look under each brush tool category and Sub Tool category and check out the different tools. Open a blank canvas and use the tools that look the most interesting to you to make marks on the canvas and test them out. One of the best things about doing digital art is how forgiving it is. If you don't like a mark you made, it can always be erased or undone, so take this opportunity to play around and familiarize yourself with the tools.

When you've done that, let's move ahead to getting familiar with the brush engine, a powerful tool that allows you to customize your tools to suit your personal style!
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Clip Studio Paint makes it easy to create your own tools with their powerful—but simple to use—brush engine. There are lots of options in the brush engine, but once you learn what each one does, they make it easy to make your tools your own. Let's get started right away with looking at the brush options and learning what each one does.
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To access the options for creating and changing brushes, click on one of the brush tools. In this example, we'll be looking at the G-pen, which is a sub-tool under the Pen tool. Once you have chosen a brush tool as your currently active tool, locate the Tool Property palette. In the lower right-hand corner is an icon that looks like a wrench. Click on the wrench icon to open the Sub Tool Detail palette.

The Sub Tool Detail palette is shown in the following screenshot:



The categories of options are listed on the left-hand side column, and the actual options to edit are shown on the right-hand side.

We're going to go over making a custom brush for special effects in Chapter 15, Inking Special Effects, so we're going to cover more of these brush options in that chapter. In this chapter, we're just going to get a feel for customizing the existing tools, so we'll be covering the options that are most useful for tweaking the feel and look of existing brushes. Then, we'll cover the other options later. Now, let's examine the options under the Brush Size, Ink, Anti-aliasing, Correction, and Starting and ending categories of options.
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The Brush Size category has options related to the size of the brush or the line width. This controls how thick or thin the mark being made is. The size of the brush is set using the slider, by clicking on the current number to the right of the slider and using the number pad to enter the size manually, or by adjusting the brush size by using the up and down arrows to the right of the number display. Brush size can also be changed according to other factors, such as the pressure applied to the tablet stylus. To access these settings, click on the rectangular button all the way to the right of the Brush Size screen. The following sub-menu will appear:



There are several other options in the brush engine that can also be adjusted according to source settings. Look for the rectangular button all the way to the right of those options to access the source settings menu for options such as Opacity, Mixing rate, Brush tip thickness, Density, Direction, Particle Size, Particle Density, Direction of Particle, Gap, and Texture Density!

In the source settings, we can set the option to be influenced by various factors. The most common is Pen Pressure. Checking the box to the left of each setting will activate that setting. In the preceding screenshot, the Pen pressure setting is already active. The Minimum value in the case of this option controls how thin the line we are making can get. Having this value set to 0 means that we can go from the thickest possible line with this tool to so thin that it's not making a line anymore, just by varying how lightly we apply the stylus to the tablet's surface. Making the minimum value larger will produce less change between the thickest and thinnest points of the line. 

The brush size can also be changed according to the Tilt of the tablet stylus, or the Velocity of the user's stylus stroke. It can also be set to Random, which will generate a random value as the line is drawn.

Beneath the different factors and the Minimum Value sliders, there are two curve graphs. One is for Pen Pressure and the other is for Tilt. This curve can be altered using the handles along the line to produce different effects.

Now that we've discussed the Source Settings, let's head back to the main Sub Tool Detail menu and continue exploring the other options that we have at our disposal.

Directly under the Brush Size slider, there are two checkboxes. The first is Specify by size on screen. When this option is activated, the size of the brush will be changed according to the amount of zoom. Therefore, a tool that is 4.00 in size when the document is at 100% zoom will be the same size when the document is scaled up or down, instead of becoming larger or smaller as the zoom changes. The other checkbox is At least 1 pixel. This option ensures that the mark being made is at least one pixel, even if the pen pressure becomes so light that the line should be interrupted according to the Pen Pressure settings.
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The next category of options is the Ink category. The options underneath this category are listed as follows:


	Opacity is how opaque (or see-through) the line is.

	Blending mode changes how the line color influences other colors already drawn on the same layer. We will discuss more about blending modes in Chapter 17, Using CSP to Color Your Comics.

	Activating the Mix Ground Color checkbox activates the options below it. Mix Ground Color allows you to make traditional paint and watercolor effects by mixing the current color with other colors already used on the same layer. The following list describes the options beneath the Mix Ground Color checkbox:

	Amount of Paint controls the percentage of the RGB values of the ground color (previous color) and the current color that is mixed. 

	Density of Paint controls the percentage of the transparency of the ground color and the current color that is mixed.

	Color Stretch controls how much of the painting color is kept at the stroke starting point. The higher the number, the more intense the color will be throughout the entire stroke of the brush, instead of being concentrated at the starting point.

	Intensity of Blur is only available if the Mix Ground Color option is set to Running Color instead of Blend. This option allows us to set the width of the blur for color already drawn on the image. If this option is set to Automatic, then the blur is dependent on the size of the brush.

	Mixing rate of sub drawing color allows us to draw with a combination of the main drawing color and the sub drawing color. The larger the value, the stronger the sub drawing color becomes in the drawing.
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The next category that we will look at in this chapter is the Anti-aliasing category. Anti-aliasing is a fancy way to describe how jagged or smooth a digital line looks. Using the icons in the Anti-aliasing category, the smoothing of a line can be set to None, Weak, Middle, or Strong. The following are two examples of lines made with the G-pen. The top one has the anti-aliasing set to None, while the bottom is set to Strong:



Notice how the top line has lots of sharp edges that make it look like it's pixelated. Anti-aliasing adds tones of gray to the edge of a line to smooth it out, avoiding this jagged look. The bottom line, with the option set to Strong, looks soft and almost blurry because of the amount of gray added around the edges. 
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Now, let's jump down the list of Sub Tool Detail categories to the Correction settings. The Correction settings can help assist us in making clean, sharp lines in our drawings, even if we have shaky hands or aren't used to doing digital art and inking yet. The trade-off for relying too heavily on some of these options, however, is that high settings on some of these options can cause computer lag depending on the specs of your system. 

The following is a screenshot of the Correction settings:



Here are each of the Correction options explained:


	Make corner pointed automatically makes corners in drawn lines into sharp points, even if they are slightly curved.

	Stabilization is used to smooth out your lines with the software. The larger the value of the Stabilization, the smoother the line will be (even if the line you actually draw is shaky). The Adjust by speed checkbox will stabilize the line more the faster the stylus moves.

	Post correction will stabilize the line and smooth it out after the line is drawn. There is a slight lag between the line being drawn and the smoothing. Adjust by speed smooths the line more, depending on the speed the line is drawn. Adjust by display ratio controls the amount of smoothing of the line based on the zoom of the canvas. Bezier curve converts the line to a quadratic bezier curve after the correction is completed.

	Brush stroke automatically tapers the end of lines, depending on the value set. The larger the value, the more tapered the end of the line will get after the brush mark is made.

	Able to snap controls whether or not this tool will snap to an active ruler. We'll be learning all about rulers in Chapter 6, All About Rulers.

	Vector magnet is used on vector layers. It allows the new line to merge automatically with existing vector lines. More information about vectors will be presented in Chapter 8, Vector Layers and the Material Palette.



Using Stabilization and Post Correction can make a huge difference in your inking. It's great if you're just getting into working digitally or your hands aren't very steady. For example, in the following screenshot, the line on the left is before Post Correction, and the line on the right is the same line after the correction took place:





Notice how much smoother the line on the right is when compared to the one on the left, especially around the curves. Sometimes, this computer correction can make lines look less organic, though, so depending on your personal art style, you may want to use it sparingly. Or, if your style lends well to super smooth curves, then go crazy!

In the next section, Playing with brush settings, we're going to learn how to copy a tool and make changes to the copy. I like to ink my figures with a very organic looking brush tool, but I also have a copy of that tool with the stabilization set high to ink robotic objects and inorganic backgrounds. Saving copies of your favorite tools can help save time, so give it a try!
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Finally, let's take a look at the Starting and Ending category, the last category that we will cover in this chapter. These options alter how the beginning and end of a drawn line look. If you are struggling to get a perfectly tapered line, these settings will help you achieve the look you desire!

The following is a screenshot of the starting and ending settings screen:



The very first option beneath this category is a drop-down menu with options for the source of changing the beginning and ending of lines. The following is a screenshot of this drop-down menu:



Each of the listed items are factors that the start and end of the line can be modified by. Checking the box next to the desired parameter activates it, and the slider to the right is then used to set the minimum value of that setting.

These options are also in the Starting and ending settings:


	How to specify allows the starting and ending settings to be set by Length, Percentage, or Fade. Length and Percentage will produce lines that go from the set minimum value to the full value and then back to the minimum value depending on the length of the drawn line. Selecting Fade will change only the ending of the line and not the beginning.

	The Starting checkbox and slider allows us to configure the length of the effect at the start of the line. The Ending checkbox and slider do the same thing, except to the end of the line!

	Starting and ending by speed will set the values of the starting and ending effect, according to the speed the line is drawn at.



Not sure what a particular brush setting does? Hover over it with the mouse or stylus, and the bottom of the Sub Tool Detail screen will show a description of the option. 
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Now that we have an idea of what these brush settings do, let's play around with some brushes and the different settings to really see what they do when they're in action. One of the best things about digital art is that almost nothing is permanent. If you make a mark with a pen, you can almost always undo it (or erase it). With Clip Studio Paint, if you make a change to a tool that you don't like, you can always revert the tool to its initial settings. That being said, let's learn how to make a copy of an existing brush tool and then make changes to the brush tool and make marks with the copy to see what some of the brush options do when used.

Follow these steps to create a copy of a brush tool and change the settings:


	Select the tool to be copied. For these instructions, we are going to use the G-pen sub tool.

	At the bottom of the sub tool palette, click on the icon for Create copy of currently selected sub tool to make a copy of the G-pen.

	In the Duplicate sub tool window, enter a name for the new sub tool. I've left the name as G-pen 2 for this example.

	Make sure that a canvas is open in the canvas window so that the new tool can be tested as changes are made. 

	Open the Sub Tool Detail window. Make sure that you can see and draw on the canvas behind the Sub Tool Detail window. We are going to use this blank canvas to test our changes.

	Under the Ink category, change the Opacity to 50. Then, draw a few intersecting lines on the canvas to see how this changed the look of the pen. Refer to the following screenshot and notice that the solid black drawing color is now a gray, and that the intersections of the lines get darker as the pen is overlayed:




	Continue changing the settings and testing the new brush on the canvas to see the changes. Now is the perfect time to play around and discover what fits your personal preferences!

	Once you're finished with changing the settings and seeing what they do in practice, you can either click on the X in the upper right-hand corner of the Sub Tool Detail window to close it and save the tool as it is, or you can reset the tool to its initial settings.

	To reset the tool to its initial settings, press the Reset all settings to default button in the lower left of the Sub Tool Detail window.

	To save the new settings to the Default settings (overwrite the previous default of the tool), press the button marked Register all settings to initial settings in the lower right-hand corner of the Sub Tool Detail window. 



Now that we've copied a brush tool, made changes, and experimented with the settings, let's learn how to save a backup copy of our new brush tool, and how to load a brush into the Sub Tool palette. Read on for more details.





            

            
        
    
        

                            
                    Exporting and loading brushes

                
            
            
                
Whether you simply want to have a backup copy of all your custom tools in case a catastrophe should happen, or you want to share your brushes with the world by giving them away or selling them, knowing how to export your tools is a great thing. It's an extremely simple process that can save your hard work in the future, or provide an income stream if you're particularly good at making specialty brushes! But before we get into making specialty brushes in Chapter 15, Inking Special Effects, let's learn how to export and load brushes to make backup copies of our tools. You can export and import any type of sub tool in Clip Studio Paint, not just brushes!
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	Select a sub tool to export. For this example, we will be using the G-pen 2 that we created in the previous section.

	In the upper left-hand corner of the Sub Tool menu is an icon of a triangle pointing toward three lines. This is the Sub Tool Group Menu. Clicking on it will display the menu, as shown in the following screenshot:
 






	Click on the Export sub tool... option in the menu.

	In the next screen, navigate to the folder to save the sub tool in. Then, enter the name for the tool. In the following screenshot, we are leaving the name as G-pen 2:




	Click Save to complete the export.



Now, let's learn how to load a tool into Clip Studio Paint.
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Now that we've exported our custom tool, let's learn how to import a tool. There are actually two ways to do this, so we'll cover both of them here!

The following are the steps for the first method of importing a tool:


	Click on the tool category in the toolbar, then on the category in the Sub Tool palette where the tool is to be exported. For the G-pen 2, we will choose the Pen category in the toolbar, and then the Pen category in the Sub Tool palette.

	Click on the Sub Tool Group Menu icon in the upper left-hand corner of the Sub Tool palette. Click on the Import sub tool... option.

	Navigate to the folder where the sub tool file is located. Click on the file of the sub tool and then click on the Open button to complete the import.



The following is the second method for importing a tool, which can also be used to import many tools at one time:


	In your operating system (for example, Windows), open the folder containing the tools to be imported. 

	In Clip Studio Paint, choose the Sub Tool palette category that the tool or tools will be stored in.

	Move the window with the folder the tool files are in so that Clip Studio Paint's sub tool palette can be seen at the same time as the folder. This is shown in the following screenshot:



 


	Select the tool or tools to be imported. Click and drag the tool or tool files over the Sub tool palette. The mouse cursor will turn into a + symbol. Release the mouse button to complete the import.

	The import of the tool or tools will then be completed. In the following screenshot, we can see that the Ball Chain, Chain (round), Chain (small), Chain (square), Japanese Beads, and Pencil Rope have been added to this sub tool group:
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In this chapter, we have learned how to navigate the brush categories and sub tools. We have also learned how to customize our brushes using some of the options in Clip Studio Paint's brush engine. Then, we learned how to export our tools to make backups or share them with others, and two ways to import new tools into our software.

Now that we've learned about brushes, in the next chapter, we will learn about one of the most versatile tools in digital art: layers. Read on to learn more!
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One of the best features of working in a digital art program is the ability to work in layers. Most digital art software allows the creation of layers, and Clip Studio Paint is no exception. In this chapter, it's all about the layers!

Topics discussed in this chapter will include the following:


	The Layer palette

	Properties of layers

	Different types of layers

	Layer groups and layer colors

	Layer Effects



Let's jump right in!
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A layer in a piece of digital art is a magical thing that can make our workflow smoother and easier, and can also save a lot of headaches in the future when we go from pencils to inks to colors. Okay, so maybe it's not actually magic. But it's pretty darn close!

But what is a layer and how do they work? Let's look at the following example image. The drawing in this screenshot is made from five layers:



What exactly are those layers? In the following screenshot, we can see exactly what they are:



The white background is a paper layer. Then, there is a layer of the base flat colors for each part of the drawing. Above that is a layer of shading and highlights. Then, above that in the stack, is the actual line art (inks) for the character and the motorcycle. Finally, above all the other layers is the text for the cover. 

Think of layers like a stack of transparencies. (For you younger readers who may not know what a transparency is, it's a thin piece of clear plastic the size of a sheet of paper that was previously used to display information in school via an overhead projector.) Every transparency has its own text or part of the image, and when they are stacked on top of each other, they form the entire image.

It's entirely possible to create digital art without using layers, but layers can make your digital life easier. Here are some of the benefits of using layers:


	Ability to change and edit inks even after coloring has begun

	Ability to professionally flat an image for color




	Ability to add special effects to certain parts of an image

	Ability to easily color correct using adjustment layers, blending modes, and layer masks

	Ability to quickly revert your image back to inks only if a mistake is made in coloring

	Ability to create color holds easily online art layers

	Ability to separate out individual characters or elements for reuse in other images

	Ability to organize image elements



There are many more benefits to using layers. Of course, there are also some downsides. Depending on how many layers you choose to use, the number of layers may begin to slow down computers with less RAM and disk space. Keep this in mind, especially when working on larger images with a high DPI. 

Now that we know what a layer is and why we'd want to use them, let's explore the layers palette and talk about different types of layers.
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Just like most options in Clip Studio Paint, Layers has a palette that acts as a Command Center for managing and creating the layers. When we look at the Layer palette in the following screenshot, we see that there are many icons and options that apply to the layers themselves:



If you cannot locate the Layer palette on your Clip Studio Paint interface, go to Window in the File Menu and click on Layer to display it. At the very top left-hand corner of the Layer palette is a menu icon (shaped like a right-facing triangle next to three horizontal lines). Clicking on this icon brings up a menu similar to the Layer menu under the File Menu, but with a few options that are unique to the Layer palette. Those options are shown in the following screenshot:



Next to each layer name, there is a thumbnail of the layer contents. Under the Thumbnail size in the options menu, the size of this thumbnail can be set from very small to very large, or to not have any thumbnail displayed at all. This is one way to cut down on the amount of system resources that Clip Studio Paint uses, since these thumbnails of the layers update in real-time as the layers are changed. Setting the layer thumbnail smaller, or electing not to have one displayed at all, can greatly reduce the amount of RAM being used. 

The Thumbnail display settings can also help to manage system resources and make it easier to tell what is on your layers. Under this option, we have settings to display either the entire layer, just the contents of the layer, and to display the transparent area. Setting the Thumbnail display to just the layer area will make the thumbnail show only what is actually drawn on that layer. So, instead of showing the entire area around the layer, it will show only what is actually drawn on that layer, even if all that's there is a tiny dot. Enabling this can manage some of the RAM requirements, because the program doesn't have to continually redraw the entire area, it only has to update the actual contents of the layer. 

Under the palette option menu in the Layer palette is a drop-down menu and a slider. The drop-down menu controls the layer Blending Mode.

To the right of the Blending Mode drop-down menu is a slider. This controls the opacity of the layer. Opacity is the amount of transparency that objects on the layer have. If the slider is set to 100, then the layer contents are at full opacity. If it is set to zero, then the layer contents will be completely transparent.

Remember that brush tools also have opacity settings! Using a 50% opacity brush on a 50% opacity layer will give a very different look than using a 50% opacity brush on a 100% opacity layer.

Below the blending mode and the opacity slider are a group of icons. Following is a list of them from left to right and a description of what each one does:


	Change palette color: Changes the color of the icons next to the layer name in the layer palette. Used to organize layers easily by grouping them by color. For instance, when doing an image with many characters, each layer related to one character can be assigned a layer color for easy identification.

	Clip at layer below: Clips the current layer using the layer below. Information in the layer will only be shown in areas where there is also information on the layer below.

	Set as reference layer: Some tools, such as the Fill tool, can be set to reference their parameters with another layer. This icon turns the currently selected layer into a reference layer for these tools.

	Set as draft layer: This option turns the layer into a draft layer. Exporting and printing images can be set to ignore a draft layer, even if that layer is visible in the file.

	Lock layer: Sets the layer so that it cannot be drawn on or changed at all until it is unlocked.

	Lock transparent pixel: Sets the layer so that transparent pixels cannot be drawn on. Only pixels that are currently drawn in will be able to be changed.

	Enable mask: This enables or disables the layer mask.

	Set showing area of ruler: Controls what layers or layer folders the ruler is visible on, such as only being visible when on the layer that contains the ruler or being able to see the ruler from any layer of the drawing.

	Change layer color: This changes the color of everything within the currently selected layer to the color designated by the user. This is a temporary change and can be undone by simply turning this option off. 



Directly below these icons is the list of current layers in the image. Each one has a symbol, which looks like an eye, that indicates whether or not the layer is visible. To the right of the eye icon on the currently active layer, there is an icon that looks like the tip of a pen. This indicates that the layer is the one currently being worked on. Above the layer name, the current blending mode and opacity is displayed so that specific layers can be found easily. 

Below the list of layers is another set of icons called the Command Bar. This set of icons allows us to execute many common layer operations directly from the Layer palette. It looks like the following screenshot:



Let's explore these icons, once again going from left to right:


	Show layer in two panes: This option splits the list of layers horizontally and shows two copies of the layer list, as in the following example:






	New raster layer: Creates a new layer for raster art.

	Create vector layer: Creates a new layer for vector art.

	New layer folder: Creates a new folder that layers can be placed into for organization.

	Transfer to layer below: This option transfers the contents of the currently selected layer to the layer below it in the stack, while leaving the empty layer behind.

	Combine to layer below: This layer merges the currently selected layer with the layer below it while getting rid of the empty layer.

	Create layer mask: Creates a mask on the currently selected layer. 

	Apply mask to layer: Makes the layer mask change permanent on the layer.

	Delete layer: Deletes the currently selected layer and all its contents. 



Now that we've learned all about the Layer palette, let's look at its companion: the Layer Property palette.
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The Layer Property palette is shown above the Layer palette in the default interface layout. If you cannot find the Layer Property palette, it can be restored by going to the File Menu and clicking on Window - Layer Property.

The Layer Property palette gives us some more options for working with layers. It is shown in the following screenshot:



Though it's a little palette, it can do big things. Let's explore each of its options now.
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The Border effect icon can be used to get two different looks on a layer. The most common way to use it is to add a stroke to the outside of the content of a layer. To do this, click on the Border effect icon and make sure that the Edge option is active. Following is a screenshot of the Edge Border effect in action on a layer of text:



By setting the Thickness of edges, the thickness of the border can be made thicker or thinner by adjusting the slider or using the up and down arrows to the right of the slider. The Edge color can be set by clicking on the rectangle showing the current color and choosing a new color using the color picker window. 

The Border effect also has another setting though, and that is the Border of watercolor edge effect. This effect looks much different than the edge effect and has a lot more options, and it can be used to give a piece of art a slick look that is reminiscent of traditional watercolor.

To access the Border of watercolor effect, click on the icon next to the Edge option under the Border effect heading of the Layer Property palette. (It looks like a dark gray circle that's smudged on the bottom right edge!)

In the following screenshot, the Border of watercolor effect has been applied to the shadows on this drawing:



Notice how the edges of the shadows have a dark edge along the outsides, just the way that watercolor paint would react if it was layered over dry paint. The look of this effect can be changed by moving the sliders for Area, Transparency effect, Luminosity effect, and Blurring width. There is no ideal setting for this option, but moving the sliders around will update the layer in real time, so it's very easy—and fun!—to play with.

Now that we know about the Border effect option, let's explore another: the Layer Property effect.
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The Extract line icon is another icon under the Effect options in the Layer Property palette. This option is especially useful for incorporating 3D objects into your art.

In the following screenshot, I have taken a photo of a horse and used the Extract line effect on it. The settings used are shown in the Layer Property palette, and also in the following screenshot:



Using this option turns the photo into a line drawing. By adjusting the options in the Layer Property palette, we get a real-time preview of the line drawing. Using this layer effect does not change the source photo permanently, as the effect can be turned off at any time if we change our mind, so feel free to play around with the sliders!

This option also has another look, called an LT conversion. This is mostly used by comic artists on 3D objects or background photographs, but we can also keep using it on our horse photo. Once we have the settings shown in the preceding screenshot to how we like them, click on the Execution of LT conversion of layer button at the bottom of the Line Extraction settings. The following screenshot will appear:



Settings can be modified in this window again before performing the action. To see the changes being made, make sure to check the Preview checkbox below the Cancel button. Note that the preview may be slow on computer systems with a low amount of RAM or hard disk space. 

Once we click on OK, we will get a photo like the one shown as follows:



Clip Studio Paint automatically creates an outline layer and several layers of tones, depending on the settings we specified in the previous window. Looking in the Layer palette, we can also see our original image safely saved on a layer below the tones and the outline layer. Using this option, we don't have to worry about making changes to a photo and then not being able to undo them. If we don't like the final results of the LT Conversion, the action can be undone, or the layers deleted, and we can try again to get a different result.

The next Effect option is similar, but can give us an entirely different look!



            

            
        
    
        

                            
                    Tone

                
            
            
                
The next icon in our Layer Property effect options is the Tone effect. Just like the name implies, this takes our layer and turns it into screentones, depending on the contents of the layer.

What is a screentone? If you read Japanese manga, you've probably seen screentones, but never knew what they were called! A screentone is a pattern of dots, lines, or hatches used to apply shading or texture to any area. In traditional pen-and-paper drawing, these tones were applied using a sticker-like sheet of pre-printed patterns that would be applied over the top of the drawing. Some companies even started printing background images, such as photos of city skylines or forests, for use to make the comic creation process faster and easier. This look is now easy to create using digital means. Using digital tones means we don't have to replenish your tone supplies, because we never run out, and we can make custom tone backgrounds using photos.

Only use photographs in your art that you have taken yourself or that you have permission to use. Remember, just because you found a photo through a Google search doesn't mean that you have the rights to use it! Be sure that the owner of the photo is okay with it being used, even if you're not going to be selling the piece of art that you're making.

In the following screenshot, a photo of a tower has been used and the Tone layer effect has been applied to it:



We also have several options in this effect, such as setting the Number of screen frequency, which will make the lines of screentone dots larger or smaller depending on how large the number is. Note that the larger the number in this setting slider, the smaller the lines of dots will become. The Density can be set according to the color of the image, or the brightness of the image. Changing this setting to increase the brightness will make lighter parts of the image more transparent. The Dot Settings can be used to change the shape of the dots that make up the screentone pattern. There are many options, from the standard circle to stars, flowers, hearts, and more! 

Now let's talk about the last effect option.



            

            
        
    
        

                            
                    Layer color

                
            
            
                
The Layer color effect is simple and is the one that I use the most in my day-to-day artwork. Here's an example of the layer color effect at work in the following screenshot, using our photo of the tower again:



The Layer color option takes the contents of the selected layer and tints them based on the color set by the user in the Layer color selection box. By default, this is set to a light blue color that is reminiscent of non-photo blue pencils from traditional comic techniques. This is a non-destructive way to tint our layer, as we can simply click on the Layer color icon again to change the layer back to its original colors.

The most common way to use this option is to make your finished pencil sketch layer blue before inking.
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The final part of the Layer Property palette is the Expression color drop-down menu. This menu is shown in the following screenshot:



With this menu, we can set the color mode of each layer in our document. For instance, for crisp lineart, we could set our inks layer to be only white and black pixels by selecting the Monochrome option. Layers for pencil sketches can be set to Gray, and only layers that will contain color information can be set to Color. This control over the individual layers' color modes can help to reduce file size in large files with lots of layers, so keep it in mind when you're working!

Now that we know what the icons and menus in the Layer and Layer Property palette do, let's explore some common activities that you can do with layers.
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Layers are a powerful digital art software tool, but only if you know how to use them effectively. Many artists switching from doing their pieces on paper have a difficult time figuring out how to work in layers. In this section, we are going to create a few new layers and keep them organized by renaming them, and changing their color in the Layer palette.

Follow these steps in order to create a new file with layers set up to take a drawing from roughs to inks:


	Create a new file. Use the A4 Color template under the Show all comic settings icon for more information on creating new files and using templates. If you are using Clip Studio Paint EX, don't turn on the Multiple Page option for this file. We just want one page to work on for this exercise.

	Once we hit OK and our file is created, we should have a Layer palette that looks like the following screenshot:



 


	Double-click on the words Layer 1 in the Layer palette to rename the layer. When the text entry box appears, name the layer Roughs. Hit the Enter key on your keyboard to confirm the new layer name. Now our Layer palette looks like the following screenshot:



 


	Use the Change Palette Color drop-down menu to change the Roughs layer to blue. This is to allow us to quickly identify the Roughs layer from the stack of layers. Now our Layer palette looks like the following screenshot:






	Create a new layer by either clicking on the New Raster Layer icon at the bottom of the Layer palette, or going to Layer - New Raster Layer in the File Menu at the top of the screen. Using the process outlined in steps three and four, name this new layer Finished Pencils and set the color to green. Now our Layer palette should look as it does in the following screenshot:



 


	Using the preceding steps, create another layer with the name Inks and set the Palette Color to Red.

	Now we are going to create a Layer Folder to hold our Roughs and Finished Pencils layers. Create a Layer Folder by clicking on the Finished Pencils layer in the stack to select it (the currently selected layer will display as blue in the Layer palette). Now click on the New Layer Folder icon at the bottom of the Layer palette or use Layer - New Layer Folder in the File Menu. Now our layer palette looks like the following screenshot:



 


	Double-click on the words Folder 1 to bring up the text entry box to rename the folder. Change the name to Pencils and press the Enter key on the keyboard to finalize the name change.

	Select the Finished Pencils layer and hold down the Shift or Ctrl button on the keyboard as you click on the Roughs layer in order to select both pencil layers at one time. Both layers will turn blue when they are selected together. Now use the mouse to drag the layers into the Pencils folder. You will know they are in the correct position when a red rectangle displays around the folder while the mouse is over it, as in the following screenshot:



 


	Release the mouse button to complete the move to the layer folder. 

	Save your file. We will be drawing on these layers in the next chapter.



We now have a stack of layers (and a layer folder!) that looks like the following screenshot:



Of course, this is just one of the many ways to use and organize layers. As you continue to work in digital layers, you will become aware of your own style of using them. Some artists use many, many layers in a completed work, while some may only use a few layers. Personally, I try to keep my layers down to a minimum, but larger color pieces with lots of characters can quickly have the stack get pretty high!

Got lots of layers and having a hard time finding the one that you need to work on? Use the Search Layer palette to quickly display layers by type and modifier in order to find your layers fast. The Search Layer palette can be found as a tab in the same window as the Layer Property palette. 
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In this chapter, we learned all about layers. We learned what a layer is and their benefits in the digital art world. We learned about the Layer palette and the various options and icons it has. We also learned about the Layer Property palette and the different effects it can have on our layers. Then we made a file and set it up with three new layers, and a layer folder that is ready for us to begin creating with.
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Whether you draw with pencils and ink digitally or draw digitally from start to finish, there is a certain amount of refinement needed in most art processes. We will use a variety of tools in this chapter to refine our images, from erasers to get rid of mistakes to selection tools that allow us to scale and rotate sections of our image. We will also learn about a great feature of Clip Studio Paint that allows us to store and use reference images easily.

In this chapter, we will cover the following topics:


	Erasers and using transparent color as an eraser

	Lassos and other selection tools

	Loading Reference images to the Subview Palette

	Using Layer Color to prepare a sketch for inks



Let's get started with refining our pencil work!
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There is a selection of dedicated eraser tools in Clip Studio Paint, accessed by clicking on the Eraser icon in the Toolbar and then choosing an option from the Sub Tool palette. Each of these eraser sub tools has a different use. But, by using the transparent color selection in the color picker option in the toolbar, we can also transform any mark-making tool into an eraser. Before we get into the transparent color, though, let's talk about some of the eraser tools in Clip Studio Paint and what they do.



            

            
        
    
        

                            
                    The Eraser Tools

                
            
            
                
The following screenshot shows the eraser sub tools in Clip Studio Paint:



Each of these tools has a different look and use. Let's briefly explore each one now. 

If you are using a graphics tablet that has an eraser end to the stylus, like some models of Wacom tablets have, then the currently selected eraser sub tool will be the one used when the eraser button on the stylus is activated. 



            

            
        
    
        

                            
                    Hard eraser

                
            
            
                
The hard eraser is a pressure-sensitive eraser tool with a hard edge. Since it is pressure sensitive when a graphics tablet is being used, it is a very versatile tool because simply varying how hard you are pressing with the stylus changes how small or large the area being erased becomes. This is my personal go-to eraser tool because of its versatility!

The following screenshot shows an example of the hard eraser tool in action:





            

            
        
    
        

                            
                    Soft eraser

                
            
            
                
The soft eraser is also a pressure sensitive tool. It has a soft blurry edge to it, as shown in the following screenshot:



This eraser is great for using in effects, such as fading one color to another or making a subtle gradient. It can also be used for general erasing as well.



            

            
        
    
        

                            
                    Block Eraser

                
            
            
                
The Block Eraser tool is a non-pressure sensitive tool with a hard edge. Because it is not pressure sensitive by default, the size of the tool will remain consistent, despite any variations in the pressure on the stylus. 

The following screenshot shows an example of the Block Eraser in use:





            

            
        
    
        

                            
                    Vector Eraser

                
            
            
                
The Vector Eraser can be used on Raster layers, but it is most useful on Vector layers. We will be discussing vector layers in detail in Chapter 8, Vector Layers and the Materials Palette. 



            

            
        
    
        

                            
                    Multiple Layers Eraser

                
            
            
                
The Multiple Layers eraser tool erases content from multiple layers at one time. It will delete the content from the area where it is used from every layer in the stack. The following screenshot is an image composed of two layers, a background color layer and a layer with a light colored square on top of the background:

For better quality images, download the graphics bundle from the following: https://www.packtpub.com/sites/default/files/downloads/9781789347036_ColorImages.pdf.




When the Multiple Layers eraser is used, parts of the top layer with the square on it is erased, but parts of the bottom background color layer are also erased at the same time. This is shown in the following screenshot:



Got a speck or splotch in your image that shouldn't be there, but can't find the layer it's on? The Multiple Layers eraser can take care of it quickly. Just make sure you're not erasing part of the image that you want to keep in the process of using it, though!

Now that we've talked about our dedicated eraser tools, let's talk about using the transparent option in the color picker to turn any tool into an eraser.



            

            
        
    
        

                            
                    Using Transparent "Color"

                
            
            
                
At the bottom of the toolbar in the Clip Studio interface are two squares that show the currently selected foreground and background colors. Below these is also a rectangle filled with a checkerboard pattern. This is shown in the following screenshot, underneath the foreground and background color selections:



The checkerboard pattern is how transparency is shown in digital art programs. Having this transparent swatch means that we can quickly turn any tool into an eraser just by changing our color selection to transparent. How is this helpful? Imagine drawing or inking and seeing that an error has been made that needs to be erased. Instead of switching to an eraser tool (a process that can sometimes take two button clicks), a simple click of the transparent swatch turns your current pencil or pen into a convenient eraser!

This option can also be used to make special effects with textured erasers. The following screenshot shows the Chalk tool (under the Pastel sub tool category) being used as an eraser with the transparent option:



Even tools such as the pattern brushes in the Decoration category can be used as erasers. The Star A brush is shown here:



Of course, these are just a few examples of the effects that can be achieved by using transparency as a painting color.

Now that we have explored the eraser tools, let's talk about the various selection tools that can be utilized in Clip Studio Paint to edit a piece of art.



            

            
        
    
        

                            
                    Lassos and other selection tools

                
            
            
                
One of the most useful features of creating art in a digital space is the ability to move, scale, rotate, flip, and otherwise transform all or portions of the drawing to obtain exactly the right look. In this section, we will use selection tools to clean up and correct a sketch with several errors on it. You can follow along with a sketch of your own, or use the following section as a reference for the various selection tools.

The following is the sketch that we will be looking at for this section:



There are several issues with this drawing, which we will use the selection and transformation tools to correct. The character's head is too small, the left arm is out too far, and the left hand is backward. Let's use the marquee and other selection tools to fix these problems.



            

            
        
    
        

                            
                    The rectangle and circle marquee tools

                
            
            
                
The Rectangle and Circle Marquee Tools both work the same way; the only difference is the shape of the selection they produce. This is probably obvious, but the Rectangle tool produces squares and rectangles, and the Circle tool produces circles and ellipses. We can use these tools when our selection doesn't need to be precise. For the sketch we are going to be correcting, we will use the rectangle tool to correct the size of the character's head in our drawing. 

Even though we are going to use the rectangle tool, the circle marquee tool operates in exactly the same way.

Let's use the Rectangle marquee tool and the Selection Command Bar options to resize a portion of our drawing by following the steps here:


	Identify the area of the drawing that needs refining. In the case of our sketch, we will be resizing the character's head to correct the proportions.

	Select the Marquee icon from the Toolbar. Then select the Rectangle marquee from the Sub Tool palette. 




	Using the mouse or stylus, hold down and drag with the marquee tool around the section of the drawing to be selected. When the appropriate area is outlined, release the mouse or stylus button to complete the selection. The following screenshot shows an example of the Rectangle marquee selection:






	Select the Scale up | Scale down | Rotate icon from the Selection Command Bar. (For a detailed description of the Selection Command Bar, refer to Chapter 1, Installing Clip Studio Paint Pro, Recommended Systems, and Interface Basics.) Use the square handles at the corners of the selection to resize the section of the drawing by dragging them in or out.

	If an undesired change is made, click on the Cancel icon beneath the selected area.

	Once the area matches the newly desired size, click on the OK icon beneath the selection or press Enter on the keyboard to commit the changes. Note that if you try to select a different tool or perform another operation while the selection is still in transform mode, a message will appear asking if you would like to commit the changes.




	Use the eraser and brush tools to correct any areas in the sketch that do not align. In the following screenshot, the line of the neck and the collar of the shirt was redrawn after the head was resized:





Rectangles and circles are all well and good, but what about when we have an area that is a much more complicated shape than that? Let's learn about the Lasso marquee and Polyline marquee next.



            

            
        
    
        

                            
                    Lasso and polyline marquee tools

                
            
            
                
For more complicated selections, the Lasso and polyline marquee tools are good tools to know about. These both work relatively the same way. The Lasso tool is being used in the next set of instructions, but the Polyline tool will also be covered.

Follow these steps to select and horizontally flip a section of a drawing:


	Identify the area of the drawing to be selected and choose the appropriate tool from the Marquee category of sub tools. The Lasso tool allows for curves and rounded selections, while the Polyline tool can make complex shapes but each segment of the selection must be a straight line. 




	To use the Lasso selection tool, hold down the mouse or stylus button and drag to trace around the area, releasing the button once you're back to the starting point. An example of the lasso marquee tool is shown below, around the character's hand:



 




	To use the Polyline marquee tool, click with the mouse or stylus and move to another area. Click again to set another point of the selection. Continue this process until you come around to the beginning point to complete the selection, or double-click to draw a straight line from the current point to the starting point. 

	To begin the transformation process, click on the Scale up | Scale down | Rotate icon in the Selection Command Bar.

	In order to flip the selection horizontally, we need to look at the Tool Property palette. The Tool property palette is shown in the following screenshot:






	In the set of rectangular icons at the top of the Transforming Settings, click on the Flip horizontal at center of rotation icon to mirror the currently selected area horizontally. 

	Adjust the selection to the correct position, then click on the OK icon beneath the selection or press Enter on the keyboard.

	The flipped and adjusted section of the drawing is shown here:



 



            

            
        
    
        

                            
                    Tool Property palette when scaling or rotating a selection

                
            
            
                
As mentioned previously, the Tool Property palette for the Marquee tools changes its contents when the Scale Up, Scale Down, and Rotate function is activated with a selection. The tool property palette becomes a transformation command center, and it's really important to know what it's capable of! Let's take a closer look at this palette before we move on. 

The Transforming settings in the Tool property palette are shown here:



These settings are accessible when either a selection or the contents of an entire layer are being scaled or rotated. To transform the contents of an entire layer, simply select the layer from the Layer palette, then click on the Scale up | Scale down | Rotate icon in the main Command Bar at the top of interface window, between the File menu and the Canvas Display area. A bounding box will appear around the contents of the layer.

The Transforming Settings has five icons at the top of the palette. From left to right, the following list describes the function of each of these icons:


	Reset current transformation will undo all changes made to the current area being transformed and revert it to the initial settings.

	Flip horizontal at center of rotation flips the area being transformed in the horizontal direction based on the Center of Rotation.

	Flip vertical at center of rotation flips the area being transformed in the vertical direction based on the Center of Rotation.

	Confirm current transformation commits the transformation change. This icon is the same as pressing the OK icon below the bounding box or pressing the Enter key on the keyboard. 

	Cancel current transformation cancels the changes. This icon is the same as pressing the Cancel icon below the transformation bounding box.



Below these icons are other transformation options, described here:


	Center of rotation allows the rotation point to be set in the current bounding box. The default setting is the Center of the area being transformed, but other options can be chosen from the drop-down menu.

	Change vector width is only used when transforming vector images. We will discuss vectors in more detail in Chapter 8, Vector Layers and the Material Palette.

	Keep the original image will retain the original image when the transformation takes place. For instance, with this box checked, if we move a selection to the left, then Clip Studio Paint will copy the area being transformed and create two instances of it. In the following screenshot, the character sketch has been moved while this box is checked, resulting in a twin of the original sketch being created:






	Scale ratio controls the ratio of both the width and height of the area being transformed. Using the sliders, the selection can be transformed precisely on either axis. Activating the Keep ratio of original image checkbox below the sliders will ensure that the original proportions of the transformed area are preserved so that the image doesn't become skewed in either direction.

	Rotation angle is a slider that controls the rotation of the area being transformed. This slider can be used to rotate precisely. Alternatively, moving the mouse cursor to a corner of the bounding box and slightly to the outside of it will produce a curved double-headed arrow that can be used to free rotate the selection. 

	Adjust position is a drop-down menu that controls the position of the transformed area. Setting this to Free position allows us to move, rotate, and scale however we wish. Another setting is Canvas, which automatically resizes the selection area to the size of the canvas and sets it in the center. On canvases where the Default border, Crop border, or Bleed border is in use, settings for these borders also appear in the drop-down menu.

	How to correct contains the options for how Clip Studio Paint blends colors of adjacent pixels during scaling up and down. The Smooth setting blends colors of adjacent pixels and smooths them, but this may lead to a blurry outline depending on the content being transformed. Hard outline maintains a sharp color separation by not blending based on adjacent pixels; however, this may lead to unwanted rough edges. Emphasize outline blends and smooths the color separations for a smooth transition, and when the image is rotated, the outline is processed so that it is more emphasized than the Smooth option. White noise may occur around the outline, however.



Now let's learn about some more organic selection tools.



            

            
        
    
        

                            
                    Selection pen

                
            
            
                
The Selection Pen is another sub tool of the Marquee category. To use the Selection Pen, select it from the Sub Tool palette. Then use the mouse or stylus to draw out a selection. The green area in the following screenshot is our area for selection:



Any area highlighted by the selection pen (which defaults to a bright green color for highlighting), will be included in the selection. The following screenshot shows the selection that is made from the highlighted area:



The Selection Pen makes highly precise selections easier. If you need to make a smaller selection, simply make the selection pen brush size smaller. To fill large areas, make the brush size larger.

To add more areas to a selection, hold down the Shift button on the keyboard. To remove areas from a selection, hold down the Alt key. A + or - will show next to the selection tool cursor to indicate whether areas are being added or taken away. 



            

            
        
    
        

                            
                    Shrink Selection

                
            
            
                
The Shrink Selection tool allows us to quickly and easily isolate elements of a drawing without the tedium of having to be overly precise. Follow these steps to use the Shrink Selection tool:


	Select the Shrink Selection sub tool from the Marquee category of tools.

	Use the mouse or stylus to drag around the elements to be selected. As shown in the following screenshot, this selection does not need to be precise:






	Once the mouse button or stylus is released, Clip Studio Paint will automatically shrink the selection down to the outside of the elements that were in the selection area. The selection made is shown in the following screenshot:






	Note that some refinement may be needed, as is the case in the selection made in the preceding screenshot. The middle line was not included in the final selection. The Shrink Selection tool makes its best selections on areas with sharp, clearly defined lines, such as ones created with the Pen tools.





            

            
        
    
        

                            
                    Clear Selection

                
            
            
                
The final sub tool in the Marquee category we are going to learn about is the Clear Selection tool. The following steps outline how to use the Clear Selection tool:


	Make a selection with one of the other selection tools.

	Select the Clear Selection sub tool from the Sub Tool palette. 




	Use the Clear Selection tool to draw in the areas that are currently selected and that should be deselected. Those areas will highlight in green as they are drawn on, as shown in the following screenshot:






	Release the mouse button or stylus when all areas to be cleared have been highlighted.

	Clip Studio Paint automatically deselects areas based on the highlighted area, as shown in the following screenshot where now only the left-most line is selected:





Now that we've learned all about the selection tools, let's learn about a palette that is a big help in organizing your reference images. Read on to learn about the Subview Palette.



            

            
        
    
        

                            
                    The Subview Palette

                
            
            
                
The Subview Palette can seem like an enigma to some, but in truth I find it to be one of the handiest palettes in the entire Clip Studio Paint interface. Let's delve into this simple, yet powerful, little palette.

When you first start using Clip Studio Paint, the Subview palette looks like the following screenshot:



It doesn't seem to have any purpose when you first look at it! So, what is it for?

The Subview palette allows us to load images into it and view, zoom, rotate, flip, and select colors from those images. If you are a comic book artist, this palette can be used to hold character designs, concept art, background design sketches, color swatches, and any other images you may need access to on a regular basis while making comics. For illustrators, this can be used to hold reference images or other inspiration. It's a little reference library that remembers the images loaded into it so that you don't have to go through the process of opening them in new windows every time that you open Clip Studio Paint. 

Let's learn how to use the Subview Palette now.



            

            
        
    
        

                            
                    Loading images into the Subview Palette

                
            
            
                
Follow these steps to load images into the Subview palette and navigate through the images in the library:


	In the Subview palette, click on the Import icon (it looks like a folder with an arrow pointing to the right). This will open your file browser.

	In the file browser, navigate to the image to be imported. Click on the file to select it. Click Open to complete the import.




	To add several images at once, hold down the Shift or Ctrl key on the keyboard and select the files, then click Open to import all the selected files at once. 

	Once images are loaded into the Subview palette, we can see them in this palette and flip through them. The following is a screenshot of the Subview palette with some of the character designs from my comic Adrastus loaded into it:






	To see the other images loaded into the Subview palette, locate the left and right arrows next to the Import icon. Clicking on either of these arrows will navigate to the previous or next image in the subview palette. Note that these arrows will only be active if more than one image is imported into the Subview palette.

	To delete an image from the Subview palette, click on the Clear icon in the lower-right corner of the palette. This icon looks like a trash can. This will only clear the image from the subview palette and will not delete it from your computer.





            

            
        
    
        

                            
                    Zooming, rotating, and color picking Subview images

                
            
            
                
In addition to being able to build a reference library in the Subview palette, we can also zoom, rotate, flip, and select colors from those images.

To zoom into an image loaded into the Subview, use the slider located directly below the image view area of the palette. Alternatively, the - and + magnifying glass icons located to the right of the slider can also be used to zoom in and out in steps. The Fit to navigator icon ensures that the image resizes to fit the Subview window as the palette is resized. When an image is zoomed in and the color picker is not active, placing the cursor over the image will change it to the Hand tool and allow for dragging the image around to view specific areas.

To Rotate an image in the Subview, the slider below the Zoom slider can be used. Drag the rectangle in the center of the slider to the left or right to rotate the image. The Rotate left and Rotate right arrows can also be used to rotate the image incrementally and precisely in either direction. The following screenshot shows a Subview image rotated:



To reset the image to its original rotation, click on the Reset Rotate icon to the right of the rotate arrows.

To the right of the Rotation settings are two icons. They are Flip Horizontal and Flip Vertical, and they flip the current Subview image on either axis. The following is our Subview image example, flipped horizontally: 



As mentioned previously, color selection is also possible from Subview images. To switch from the default hand tool used to interact with the loaded image to the color picker, click on the Eyedropper icon located to the right of the Fit to navigator icon in the top row of icons. The eyedropper will now be active over the Subview image. Clicking with the eyedropper will select the color from the image and make it the active foreground or background color, depending on which is selected in the Toolbar.

The next section will teach us how to prepare a sketch for digital inking using the Layer Color setting that was briefly mentioned in the previous chapter. Read on to learn more. 



            

            
        
    
        

                            
                    Using Layer Color to prepare a sketch for inks

                
            
            
                
We're going to wrap up this chapter by learning about one way that Clip Studio Paint solves a common digital art problem. Those of you reading this book who have done digital art in the past might be familiar with the following scenario.

You get your sketch finalized and create a layer for your final inks. You ink for a bit and then realize that something in the sketch needs to be changed. You switch back to the sketch layer and make the correction, then continue inking. It isn't until you finish inking that you realize you never switched back to your ink layer, and now you have your inks on the same layer as the pencil sketch and must start over.

This is an extremely frustrating and common problem when working with digital layers. Thankfully, the makers of Clip Studio Paint gave us a feature that makes this a thing of the past. Sure, you could lock the sketch layer so that no changes can be made to it at all to prevent this, but then if a change needs to be made, you have to spend the time unlocking it before you can correct an error or adjust a detail. This seems minor, but locking and unlocking a layer takes precious time, and I am all about streamlining the workflow as much as possible!

Follow these steps to turn a sketch layer blue and begin inking over it on another layer: 


	Open a file with a sketch layer. If you don't have one, use the directions in Chapter 4, Pencilling and Layer Properties, to set up a file with layers, then make a sketch on the sketch layer.




	Once we have our finished sketch layer and make sure it is the active layer in the Layer palette, we click on the Layer color icon in the Layer Property palette. This will make the entire contents of the selected layer into a blue color that is reminiscent of non-photo blue used in traditional pencil and paper art. In the following screenshot, the pencil layer has been turned blue:






	To change the color of the layer, click on the blue rectangle that will now show in the Layer Property palette. This will bring up the color picker. You can select any color from the color picker to use as the Layer Color.

	In the following screenshot, we can see that our colored layer is easy to discern in the list of layers because of the icon that shows above the layer's name. Look for this icon if you have lots of layers and need to find the one that has been colored:






	With the Layer Color option active, any new marks made on this layer will show up in the layer color. In the following image, an inking pen tool has been used to make a mark on the sketch layer. Since it shows up as blue, we know that we are still on the pencil layer and not on the ink layer:






	Select the Inks layer in the Layer palette, above the Finished Pencils layer, and begin inking. The ink lines will now show up in the currently selected color in the Toolbar instead of using the Layer Color. In the following screenshot, the ink line shows as black because we are on the correct layer:





This is such a simple solution to a common digital art problem, but it's a useful feature that I hope you'll incorporate into your own workflow!



            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, we talked about eraser tools and using the transparent color to turn any brush tool into an eraser. We talked about the different selection tools and how to make adjustments to a piece of art with them. We also discussed the Subview palette and how to use it to store various reference images. Finally, we learned about how the Layer Color feature can completely eliminate a common digital art problem.

In the next chapter, we are going to learn all about the ruler tools that make Clip Studio Paint a truly powerful art software. Keep reading to learn more.



            

            
        
    
        

                            
                    All About Rulers

                
            
            
                
One of the handiest tools in an artist's toolbox is the humble ruler. Whether it's a regular straight ruler, an at-square, or a set of French curves, rulers can really make a difference to your artwork, which is why the digital rulers in Clip Studio Paint are some of my favorite features. I actually first started using Clip Studio Paint (back when it was known as Manga Studio) because I saw a demonstration of the perspective ruler tool and knew that I needed to have it in my workflow. 

Ruler tools in Clip Studio Paint work just like straight rulers or curved rulers in real life, except that they're digital – and they can be customized and made to produce certain special effects easily, such as all lines going to a specific focal point (or even curving to a specific focal point). If you draw or ink in the digital realm, you want to make sure you're familiar with these amazing tools.

In this chapter, we are going to take a deep dive into the special rulers in Clip Studio Paint. We will briefly cover the basic rulers and then we'll take a more in-depth look at the other ruler options.

The following topics will be covered in this chapter:


	Using rulers in Clip Studio Paint

	Using the symmetry ruler

	Focus and parallel line rulers

	Perspective rulers

	Drawing ellipses in perspective

	Switching the active ruler

	Using the grid



Now let's get right into rulers!



            

            
        
    
        

                            
                    Using rulers in Clip Studio Paint

                
            
            
                
You will find the ruler sub tools under the Figure section in the toolbar. Click on Figure, then click on the Ruler category in the Sub Tool palette to see the ruler options:



The first four tools: Linear Ruler, Curve Ruler, Figure Ruler, and Ruler pen are the tools that we will be briefly covering in this section. The tools listed below those four are a little more complex and we'll delve into those in more detail as the chapter continues.



            

            
        
    
        

                            
                    Ruler snapping options

                
            
            
                
Before we get into how to use each of the ruler tools, we need to learn about the snapping options. When a ruler isn't working as expected, most of the time, it is because snapping is turned on or off. So, when getting undesired results with the ruler tools, it is best to check these options first.

The three snapping options can be found in the Command Bar above the area where the currently active document is displayed. They are shown in the following screenshot: 



From left to right, these options are: Snap to Ruler, Snap to Special Ruler, Snap to Grid. In the preceding screenshot, the Snap to Ruler option is the only one currently turned on and is marked by a slightly darker box around the icon than the other two options. 

Snap to Ruler constricts the marks made by the current tools to any active basic ruler (Linear ruler, Figure ruler, Ruler pen, and so on). If the active ruler is a special ruler, such as a Perspective ruler, this option will not force the drawing tool to follow that ruler.

Snap to Special Ruler forces tools to restrict their marks to any currently active special ruler, such as Symmetry, Focus Line, and Perspective Rulers. 

Snap to Grid forces tools to stay within the confines of the grid, when it is visible. More on the grid later in this chapter.

To turn a snap option on or off, simply click on it. Multiple snapping options can be active at one time. Remember that the snapping options will force your tools to constrain themselves to any currently active ruler that fits their criteria, so if you have a drawing tool that isn't drawing where you want it to, and you have a ruler in your image, check the snapping option first to see if that is the issue!

Now that we've discussed snapping, let's move on to the basic rulers and their functions.



            

            
        
    
        

                            
                    Linear ruler

                
            
            
                
The Linear ruler works just the same as a regular old ruler that you might buy in any store. These are the simplest of rulers, making a single straight line. 

To use the Linear Ruler, select the sub tool, click on your canvas and drag. Release your mouse or stylus once you have reached the end of where you want the ruler to be. The ruler will be shown as a single colored line, as shown in the following screenshot: 



When the Snap to Ruler option is active, using a tool such as the G-pen will make a line along the ruler that we just made, as shown in the following screenshot:



Need to adjust a ruler that you already made? Use the Operation - Object tool and select the ruler. A bounding box will show up around the ruler, and a handle will appear on either end. Using this bounding box and the handles on either end, the angle and length of the ruler can be changed, the ruler can be resized, and it can even be rotated!



            

            
        
    
        

                            
                    Curve ruler

                
            
            
                
The Curve ruler's name is a little bit misleading because it can be used to make polyline straight-line rulers, as well as rulers with smooth curves, as shown in the following screenshot:



To use the Curve Ruler, select it from the Ruler sub tool category. In the Tool Property palette, you will see four options under the Curve setting. The very first icon will produce straight lines between the points of your ruler, and the second option is the Spline setting, which will create curves between each point of the ruler. To use either of these options, simply click on the point on the canvas where you want the ruler to start. Then, click again where the second point should be. Continue clicking on each corner of the ruler until you reach the end of where you want the ruler to be. Double-click to end the ruler.

You can also go all the way around to the point where you started the ruler and click on the first point to end it, if you are making an enclosed shape, as shown in the following screenshot: 



The final two icons under the Curve setting in the Tool Property palette are Quadratic Bezier and Cubic Bezier, which are simply two alternate ways to make and control the curve of the ruler. (We will see these controls again later, in Chapter 8, Vector Layers and the Material Palette.) Let's learn how to create curves using each of these methods.



            

            
        
    
        

                            
                    Using the quadratic Bézier

                
            
            
                
Using the quadratic Bézier creation for a ruler takes a little getting used to, and usually, some refinement after the initial points are laid out. Follow these steps to create a curve ruler with quadratic Bézier:


	Select the Curve Ruler and then the Quadratic Bezier option from the Tool Property palette.

	Click on the canvas once, at the point where you'd like the ruler to start. 

	Click on the point where you would like the ruler to start curving. This will create a small square handle at the clicked point.

	Move the cursor to another point on the canvas. The line of the ruler will bend according to where the second click was placed and where the cursor is now. 

	Continue clicking to add boxes and curves to the ruler until it is the desired length. Double-click to end the ruler.




	To adjust the ruler, select the Operation category of tools and then the Object tool. Click on the ruler to select it and reveal the handle controls. In the following screenshot, the control handles are on the straight lines and the actual ruler is the curved lines:






	To adjust the curve of the ruler, use the Object tool to click on one of the cross-shaped handles on the control line and drag it to a new position. The ruler in the preceding screenshot has been modified in the following screenshot: 







            

            
        
    
        

                            
                    Using the Cubic Bezier

                
            
            
                
Another option for making curves is using the Cubic Bezier setting. Follow these steps to create a ruler using Cubic Bezier:


	Select the Cubic Bezier setting from the Tool Property palette of the Curve Ruler.

	Click on the first point of the ruler.

	When clicking to add the first curve, hold down the mouse button and drag the mouse in the direction your line is going. For example, if you are starting on the left side of the canvas and heading toward the right, drag the mouse to the right while holding down the button. Going in the direction of the line will prevent the control handles from getting reversed and making "snarls" in the line. The line between the two clicked points will curve.

	Click on a third point and drag with the mouse while holding down the button to continue making the curve.

	To end the ruler, double-click on another point. In this mode, the ruler will end at the point created before the double-click, so be sure the ruler is as long as necessary and click on the endpoint, then double-click to finish the ruler.

	To edit the Cubic Bezier ruler, select the operation category of tools and select the Object tool. Click on the ruler to reveal the control handles. The control handles are shown by the red lines in the following screenshot:






	Using the Object tool, the handles along the red lines can be used to adjust the individual curves by clicking on the handles and dragging them. Clicking on the red squares that appear at the control points allows us to adjust their position. Dragging the + handles on either end of the red control line allows us to change the curve on either side of the control point. 
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The figure ruler allows us to create easy circle, rectangle, and polygon rulers with a few simple clicks. Follow these steps to use the Figure ruler:


	Select the Figure Ruler subtool.

	In the Tool Property palette, select one of the shapes from the Figure category. 

	Click on the canvas and hold down the mouse button. Drag to create the selected shape ruler on the canvas. 

	When using the Polygon figure option, the number of vertices can be adjusted to create shapes such as triangles, pentagons, hexagons, and others. To edit the number of vertices, select the ruler and then click on the Show Sub Tool Detail Palette icon in the lower right of the Tool Property palette. Click on the Figure category in the Sub Tool Detail palette. Beneath the Figure category is the option for Number of vertexes of polygon, which can be adjusted by using the slider or clicking on the number entry box and entering a number using the keyboard. In the following screenshot, the number of vertices is 3, and will produce a triangle:





The final basic ruler we will cover in this section is the versatile Ruler pen. Read on to learn more about this tool.
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The Ruler pen is a versatile tool that allows us to draw a ruler of any shape. In the following screenshot, I have created a ruler of my signature with the ruler pen:



To use the ruler pen, follow these steps:


	Select the Ruler pen sub tool from the Subtool Palette.

	Use the mouse or tablet stylus to draw your desired ruler. Releasing the mouse button or stylus will end the ruler automatically.



Now any drawing tool can be used to trace the ruler!

We have covered basic rulers, and now we will move on to specialty ruler tools in the following sections.
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Have you ever wanted to create a design that was perfectly symmetrical on both sides, or make a beautiful digital mandala? If so, the Symmetry ruler is the answer to your prayers. As a bonus, it's really very simple to use! 

To begin using the Symmetry ruler, select the Ruler category from the Toolbox and then select the Symmetrical ruler from the Subtool Palette. The Tool Property palette is shown in the following screenshot:



The most important option here in the Tool Property palette is the Number of lines option. This controls how many sides of symmetry there will be in the completed ruler. Any number from 2 to 16 can be used in the number of lines option. The following is an example of a ruler with the Number of lines set to 2:



The thin line in the center of the design is the ruler, and the design is mirrored on each side of the ruler's line. The following screenshot is a design drawn with the Number of lines set to 8:



The design now has eight symmetrical parts that radiate out from the center of the ruler. 

The following screenshot is a design made with 16 lines, the maximum number a Symmetrical ruler can have in Clip Studio Paint:





Creating a symmetrical ruler is easy and can be done by following these steps:


	If desired, sketch a rough layout of the design before creating the ruler.

	Select the Symmetrical ruler sub tool from the ruler category.

	Set the desired Number of lines in the Tool Property palette.

	Click and hold on the image canvas. While still holding down the mouse or stylus button, drag across the canvas to create a line. To constrain the ruler line to being perfectly straight or a 45-degree angle, hold down the Shift key on the keyboard as you drag the mouse. 

	Release the mouse or stylus to finish creating the ruler. 

	Ensure that the Snap to special ruler icon in the top command bar is active in order to use the ruler.



Instead of holding down the Shift key to constrain the angle of the ruler, the Step of Angle option can be used in the Tool Property palette. Simply check the box next to the option and then set the desired angle using the slider or text entry.

Now that we know how to create and use a Symmetrical ruler, let's learn about some more of the specialty rulers and how to use them. 
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Manga is usually known for its striking linework. Most manga is in black and white, and so the lines must be bold and clearly show action, as well as the point on which the reader should focus their attention. One way that many manga artists do this is by using parallel lines to show motion, and focus lines to lead the reader's eyes to the point of interest in a frame. Clip Studio Paint comes with rulers ready to make parallel lines and focus lines already in it, making the process of creating these effects much easier than with pen and paper.

Let's look at the following page from my comic, Adrastus, for some examples of how to use focus and parallel lines in a comic:



In the first panel, parallel lines are used to show the motion of Andromeda pulling back on the controls and to show the robot backing up in response to that action. Then, in the second panel, focus lines are used to draw the reader's eyes to the enemy robot's closed fists. In the third panel, more parallel lines are used to show the direction of the enemy robot's swing, as well as the flying robot spinning and being knocked out. Focus lines are also used to show where the strike occurred in the panel. 
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The focus line ruler allows us to set a central point and then draw lines that radiate out from that point. Using the snapping feature of Clip Studio Paint's rulers, making focus lines is much quicker and easier than making them in the traditional way with pen and paper. Simply set your central point and start drawing! Follow these steps to make a focus line ruler:


	Select the Ruler category from the toolbar, then select the Special Ruler sub tool.

	In the Tool Property palette, click on the drop-down menu to choose the Focus Line option. The drop-down menu is shown in the following screenshot:






	Click on the desired central point for the Focus Line. This is the point that all the lines drawn using the ruler will radiate out from. 




	Use your desired drawing tool to draw the focus lines. In the following screenshot, the focus lines have been drawn with the G-pen:





A focus curve ruler can also be made. With a focus curve ruler, the lines still share the same central point, but they are curved instead of being straight. Follow these steps to create a focus curve ruler:


	Select the Focus Curve option from the drop-down menu in the Tool Property palette. 

	Click where the central point of the focus curve ruler should be. Click again at the next point of the curve. Continue clicking until the desired curve is reached. 

	Double-click to end the curve. 

	Use a drawing tool of your choice to draw the focus curves. The following screenshot was done with the G-pen tool:





Note that the options for how to shape the curve are Spline and Quadratic Bezier. For a more in-depth explanation of these curve creation methods, see the Curve Ruler section earlier in this chapter.

Now that you know how to create focus lines, let's study the other ruler we will be covering in this section, the Parallel line ruler.
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Follow these steps to create a Parallel line ruler:


	Select the Ruler category from the toolbar. Then, select the Special Ruler sub tool.

	From the drop-down menu in the Tool Property palette, select the Parallel Line option.

	Click on the canvas and drag to set the angle of the ruler. The ruler can be constrained to straight and 45-degree angles by holding down the Shift key on the keyboard.

	Release the mouse button or stylus to finish creating the ruler.

	Use the drawing tool of your choice to create parallel lines.



The following screenshot shows an example of parallel lines drawn with a ruler:



As with the Focus Ruler, we covered previously, parallel curves can also be made with a ruler. Follow these steps to create a Parallel Curve ruler:


	Select the Parallel Curve from the drop-down menu in the Tool Property palette. 

	Click on the canvas to begin the ruler. Click on the next point of the curve.

	Select another point and click to continue the curve.

	Continue clicking until the number and length of curves have been achieved. To end the ruler, double-click.

	Use a drawing tool to draw your parallel curves. The lines in the following screenshot have been made with a G-pen:





Note that the options for how to shape the curve are Spline and Quadratic Bezier. For a more in-depth explanation of these curve creation methods, see the Curve Ruler section earlier in this chapter.

Do you need to change the angle or shape of your ruler once you've created it? Simply select the Operation - Object tool and click on the ruler to reveal the control handles. The Object tool can be used to move, rotate, and fine-tune your rulers.

Now that we've covered some of the simpler ruler tools, let's move on to the one that everyone is most excited about learning.
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Perspective rulers are a game-changer, especially if you're a comic artist or any artist that draws backgrounds. Creating detailed cityscapes and backgrounds is easier than ever with the digital perspective ruler. However, having perspective rulers at your disposal will not suddenly make you an expert in perspective if you've never studied it before. Just like a real ruler in the physical world, Perspective Rulers are a tool that can make the drawing process easier.

Having access to a tool like the Perspective Rulers does not replace knowledge and practice with drawing in perspective. If you don't know the principles of drawing with depth, then these rulers will only aid you so much. A great resource that I recommend for learning how to draw in perspective, specifically with a focus on comic books, is a book called Vanishing Point: Perspective for Comics by Jason Cheeseman-Meyer. It is full of tips and tricks that will get you drawing in dynamic perspective in no time.

Perspective rulers in Clip Studio Paint can be made as one-, two-, or three-point perspective rulers. You can also add other points as you get more comfortable with drawing in perspective, but for the purposes of this book, we'll keep it down to one, two, and three points of perspective.

Let's start with the easiest perspective ruler to grasp, the one-point perspective ruler. For each of the following ruler instructions, you will need a canvas to draw on, and a rough sketch of the scene in perspective to draw. This is where that knowledge of perspective comes in! Personally, I find it much easier to properly place the perspective vanishing points when I have a rough sketch of the scene I'm making. 
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As mentioned, we will start with a canvas with a rough sketch on it. For the one-point perspective, we are going to draw some buildings and a road going into the distance. For ideas, work from reference if you need to! 

The following screenshot shows the sketch I will be basing my perspective ruler on. Having the rough sketch available makes it much easier to place the vanishing points and guidelines:



Now that the rough sketch is done, we can follow these steps to make the one-point perspective ruler:


	In the Menu Bar, click on Layer, go to Ruler - Frame, then click on Create Perspective Ruler.

	The following box will appear:



 


	Select 1 point perspective fromType. Leaving the Create new layer box unchecked will create the ruler on the currently active layer. Since we want to create a layer to refine our rough sketch on above the rough sketch layer, we will leave the Create new layer box checked. 

	Click on OK to create the new ruler. 

	When the ruler is created on the canvas, the currently active tool will automatically switch to the Object tool. This will allow us to adjust our perspective ruler on the canvas.

	The following is a screenshot of the perspective ruler without the rough sketch behind it, so that it can be clearly seen. The horizontal line is our horizon line. The + icons on the horizon line control the tilt of the horizon line. The circular point on the horizon line is the vanishing point for our perspective. The two lines radiating out from the vanishing point are guidelines that will help us to place our perspective ruler in the correct spot:



 




	Using the Object tool, click on the vanishing point and drag it so that it is in the same place as the vanishing point on the rough sketch. Ensure that the horizon line of the perspective ruler also matches the horizon on the rough sketch. The handles of the guidelines can be used to check the perspective and ensure that the ruler is in the correct position. The following screenshot shows the perspective ruler in the correct position:






	Now that the perspective ruler is in position, we will ensure that the Snap to special ruler icon in the main Command Bar is active. We can now draw in our cleaned-up scene and the drawing tools will snap to the lines of the ruler. The following are the finished pencils for this perspective scene:






	Once the scene is sketched out, we can add another layer above the sketch layer to ink on and still be able to see and snap tools to our perspective ruler. In order to do this, look in the Layer palette. With the ruler layer selected, click on the drop-down Set showing area of ruler. The following menu will appear:






	Set the option to Show in All Layers, in order to see and use the perspective ruler no matter what layer is currently active. 



The Showing areas for the rulers are All Layers, Same Folder, and Only When Editing Target. Descriptions for each of these options follow here:


	When a ruler layer is set to Show in All Layers, the ruler will show and be able to be snapped to any layer in the current canvas.

	When set to Show in Same Folder, the ruler will be shown only when it is on layers that are in the same layer folder as the ruler. (For instance, if our canvas includes a folder labeled Sketches that has a ruler in it, the ruler will only be visible and usable when on layers grouped in that same folder.)

	When set to Show Only When Editing Target, the ruler will only be shown when the ruler layer is the currently active layer.
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Creating a two-point perspective ruler can be achieved with the same method as shown in the One-point perspective section of this chapter. However, additional perspective vanishing points can also be added to an existing ruler. 

To create a basic two-point ruler, follow the instructions in the preceding section but select the 2 points perspective option from the dialog box in step 2. To add a point to an existing ruler, follow these steps: 


	Click on the existing ruler with the Object sub tool to select it. If a ruler is currently selected, the control handles will be visible.

	Right-click with the mouse or stylus on the ruler to bring up the following menu: 






	Click on the Add vanishing point option to create a new vanishing point. Adjust the position of the vanishing point to match the rough sketch.



Vanishing points that are created by using the right-click method do not have to be fixed to the horizon line. This is useful for tricky perspective points!

As you can see from the screenshot in step 1, the right-click menu has several options under it that can assist us with drawing perspective rulers. We have already covered the Add vanishing point option, and the following list describes the rest of the perspective ruler tools available in this pop-up menu:


	Delete vanishing point will delete the currently selected vanishing point.

	Add guide will create a new guide coming from the current vanishing point.

	Delete guide will delete the selected guide from the vanishing point.

	Fix vanishing point locks the selected vanishing point to its current position.

	Infinitize moves the vanishing point to infinity when selected.




	Fix eye level will lock the horizon line into its current position and make it unmoveable when checked.

	Horizontalize eye level will correct a tilted horizon line to be straight again. Handy if you accidentally rotate your horizon line!
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Once you have mastered one- and two-point perspectives, you can start creating some very cool scenes using three-point perspective. Scenes created in three-point perspective look flashy and cool, and really add character to your comic scenes. The following is an example of a three-point perspective cityscape I drew for a comic a few years ago:



By zooming out, we can see how the perspective ruler was set up to create this bird's eye view of a city at night. The following is the zoomed out view of the page with the perspective ruler showing. Note how far away the vanishing points are from the edges of the canvas:



Three-point perspective rulers can be created by using either method described in the one-point and two-point perspective sections of this chapter. They are trickier to work with, since there are so many points that the program is trying to snap to. Sometimes the program may pick up on the wrong guideline and you may have to undo your line and try again. But once you master them, they are an invaluable part of drawing really cool environments for your characters to inhabit. 

Before we get away from perspective rulers, did you know that you can draw perfect ellipses and other shapes with them? Let's learn more in the next section!
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Did you know that you can use shape and line tools with perspective rulers? Follow these steps to use the Direct Draw sub tools with perspective rulers:


	Using one of the methods listed previously in this chapter, create a perspective ruler on your canvas.

	Select the Figure category in the Toolbar.




	Select the Direct Draw sub tool category.

	Select the rectangle tool.

	Ensure that the Snap to Special Ruler icon in the main Command Bar is active. Then, click and drag with the rectangle tool to create a rectangle. The shape will conform to the perspective ruler automatically, so long as Snap to Special Ruler is active. 



In the following screenshot, a circle, a rectangle, and a polygon have all been drawn in perspective using the Snap to Special Ruler option:



Using shape tools can allow you to create buildings quickly by using the rectangle tool to draw the sides. Or, you can add a circular rug to the interior of a room. The straight line and curve tools will also follow perspective rulers, allowing for the quick rendering of details, or the creation of architectural elements such as arches. 
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In some instances, you may find it necessary to have multiple rulers in the same image. This can become confusing for the program, and for us as well! So, in this section, we will go over the quick process of making rulers and vanishing points active or inactive. This will allow us to control how rulers work and what areas of a ruler are active at any time. 
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Making a ruler active or inactive is simple but invaluable. Knowing how to manage multiple rulers can mean the difference between a smooth and easy drawing experience and hours of frustration fighting with your tools! Follow these steps to make an active ruler inactive:


	Create a ruler on a new canvas. In this example, we will be looking at a concentric circle ruler, but just about any ruler tool will do. 

	Click on the ruler with the Object sub tool if the ruler is not already selected. The currently selected ruler will show the control handles. In the following screenshot, the control handles are the circular and square shaped icons around the ruler that allow us to edit the ruler and change its shape and rotation:






	Locate the control handle shaped like a diamond. In the preceding screenshot, it is located just to the right of the center of the circle ruler. Click on the diamond-shaped control handle to make the ruler inactive. The ruler will change colors, as shown in the following screenshot:






	To make the ruler active again, click on the diamond-shaped control handle again. The ruler will change back to its active color and will be able to be snapped to.



You can change the color of the active and inactive rulers in the Clip Studio Paint preferences. For more information, see Chapter 2, Preferences, Shortcuts, and Other Commands.

This method can also be applied to individual vanishing points in a perspective ruler. In the following screenshot, the upper and left-hand vanishing points have been made inactive so that tools will only snap to the right-hand vanishing point:



Now that we've learned about all these specialty rulers, let's cover an often overlooked tool that can save a lot of headache and time if you know how to use it.
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Many new users of Clip Studio Paint don't know that the software comes with a customizable grid that can be shown or hidden, or that you can create guides in the program as well. Grids and guidelines are handy for many tasks, of course, and provide a visual measurement that is easy to count and divide. Also, the grids and guidelines in Clip Studio Paint can be snapped to, making it very easy to get elements lined up precisely as they need to be. 

In this section, we will learn how to show and hide the grid, and how to make guidelines. 
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Before we learn how to show and hide the grid, let's take a look at the Preferences that control its appearance. We covered them a little bit in Chapter 2, Preferences, Shortcuts, and Other Commands, but let's give them another look now. 

To access the Preferences, go to File in the Main Menu, then click on Preferences. In the left-hand menu of the Preferences menu, click on the Ruler/Unit option:



From here, we can change the color and the opacity of the grid dividing lines. Color of grid line controls the primary division of the grids and can be set by clicking on the color swatch to the right of the option and selecting a color from the color picker. The Color of grid dividing line controls the sub-division lines that are present between the larger grid lines. 

To see the grid in action, let's look at the following screenshot.



Looking closely, we can see that some of the lines are darker. These darker lines are our grid lines. Between each grid line are three grid dividing lines that break each larger square of the grid into four sections in each direction, for a total of 16 squares between each line of the grid. The color of these lines can be changed, as discussed in the preceding section about preferences. 

Follow these steps to show the grid on your own work:


	In the File Menu, click on the View option.

	Click on Grid to show the grid.

	To hide a visible grid, click on View and then Grid again to uncheck the option.
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In addition to the grid color settings in the system Preferences, there are also grid settings that allow us to change grid divisions. These settings are accessible by clicking on View in the File Menu and then clicking on Grid Settings.

The Grid Settings menu is shown in the following screenshot:



In the Original point of grid ruler, the point of origin of the grid can be set. By default, it is set to the top left, meaning that the grid will appear with its origin at the top-left corner of the canvas. The other options for the point of origin are Top right, Center, Bottom left, Bottom right, and Center. There is also an option to set a Custom point of origin. Clicking the radio button next to the Custom option will activate the text entry box, and custom values for the number of pixels of offset for both the width and height of the document can be set. For instance, if a value of 10 is entered in W and a value of 20 in the H setting, then the point of origin for the grid will be 10 pixels in from the left side, and 20 pixels down. 

Under Settings of grid, the Gap and Number of divisions can be set. The Gap is the space between the grid lines, which is set to 100 pixels in the preceding screenshot. The Number of divisions is the setting for how many times the larger grid lines should be divided. Setting this to a higher number will result in smaller squares occurring in the grid overall because of the additional divisions. 
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Guide rulers are simple to use but their applications are endless. They can be used in combination with a grid to mark the margins of a document, to find the center of a canvas, or to align design elements such as different layers of text and illustrations. 

Guides work like the Line ruler sub tool, but a guide can only go straight horizontal or straight vertical on the canvas. Follow these steps to make guidelines on your canvas:


	Click on the Figure category in the Tool bar.

	Click on the Ruler sub tool category.

	Click on the Guide sub tool.

	Click on the canvas and drag either horizontally or vertically, depending on in which direction you want your guide to go.

	When the mouse button is released, the guide will be made.



Guides automatically continue all the way across and beyond the constraints of the canvas, no matter the length of the line that was dragged to create them. 
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Wow, that was a lot of information about rulers! I hope that you learned some great new tips and tricks that will help you with your digital art creation in the future.

In this chapter, we learned how to work with the basic rulers of Clip Studio Paint, as well as the Focus, Parallel, and Symmetry rulers. We created one-point, two-point, and three-point perspective rulers, and learned how to use the direct drawing tools with them. We learned how to make rulers active or inactive, and how to use the Snapping settings. Finally, we learned about grids and guides.

In the next chapter, we're going to enter a new dimension: the third dimension! Keep reading to learn more about how to use 3D figures and objects in Clip Studio Paint.
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Clip Studio Paint is one of the leading software for creating top-notch comics and illustrations. But did you know that it can also display and import 3D assets? Many 3D assets come ready in the Materials Library and can be applied to your page. While I usually use the 3D assets as pose or background references, you could conceivably use the 3D characters and imported 3D assets to create entire comics. 

In this chapter, we'll take a trip into the third dimension and learn about the following topics:


	The 3D Material Palette

	Loading a 3D object into the canvas

	Moving 3D assets in space

	Using preset poses

	Customizing characters

	Saving custom 3D information as a Material

	Importing a 3D object from another program
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The Material Palette is what we call the digital library of assets that are available through Clip Studio Paint. Clip Studio comes with a huge library of brushes, images, screentones, 3D poses, and objects and more are already available inside. More assets can be easily downloaded through the Clip Studio App, which we will cover in Chapter 19, What is the Clip Studio App And Getting Animated. You can also save your own artwork to the Material palette, which will be covered in Chapter 8, Vector Layers and the Materials Palette.

For now, we will just concentrate on the 3D categories of the materials palette. 

To access the Material Palette, locate the appropriate palette location in your interface. If you cannot locate the Materials Palette, you can click on Window in the File Menu and then navigate down to Material. From the menu under the Material option, click on Material [3D] to open the 3D Material Library, as shown in the following screenshot:



Now, we can take a look at the Material Palette to see the contents of the 3D category. The Materials Palette is shown in the following screenshot:



On the left-hand side of the Material Palette is a list of the different categories of materials and their sub-categories. These categories organize our library of material assets and allow us to quickly find a specific material. The currently selected category will show up from the list with a blue highlight around the name. Any category name with a triangle symbol next to it means that that category can be expanded to show the sub-categories beneath it. Sometimes, even sub-categories have more sub-categories, as can be seen next to the Pose sub-category in the preceding screenshot!

The right-hand side of the Material window shows a list of the materials in the library. The currently selected material will have a blue highlight around it. Details about the current selection are shown in the bottom section of the Materials Palette. 

If a Material in the list has a cloud icon with a down-facing arrow in the top corner of the preview image, this means that the material must be downloaded from the Clip Studio App before it will become available for use. These assets are usually available at no cost to you, but they will increase the storage space Clip Studio needs on your hard drive!

Follow these steps to add a 3D element to a canvas:


	Open a new canvas, if one is not already open. Material assets can only be added to a currently open document.

	In the 3D Material Palette, click on the 3D asset to be added to the canvas. In this example, we are using the 3D drawing figure-Ver.2 (Male) asset.

	Once the material is selected, click on the Paste selected material to canvas icon at the bottom of the Material Palette window. This icon looks like a small clipboard.

	The material will be pasted to the canvas. Note that depending on your computer's specifications and the 3D material, this may take a few minutes to complete.



The 3D figure we chose in the preceding steps is shown in the following screenshot:



As you can see, this is a decent 3D drawing doll that makes for a pretty good reference! But this pose is static, and we need to move the limbs around to get some personality and life into this pose reference. Let's move this 3D figure and the camera around.
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Now that we've learned how to add a 3D object to our canvas, we can move and pose that object in our scene. It requires time, practice, and patience to learn how to pose the 3D characters in Clip Studio Paint, but once you know the basics of 3D space, then you'll be able to become an expert in no time!

The screenshots in the following instructions show the 3D character model School girl B-Ver. 3. This model is available as a free download through the 3D Character Materials and the Clip Studio App. For more information on how to download assets with the Clip Studio App, see Chapter 19, What is the Clip Studio App And Getting Animated.
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To get your 3D asset into the correct position on the canvas for your scene, you may need to move or rotate it on the x, y, or z axis. This is true for both 3D figures, objects, or any of the 3D backgrounds that can be used in Clip Studio Paint. Follow these instructions to learn how to move objects through the 3D space:


	Be sure that the Operation - Object tool is selected before continuing.

	Click on the 3D object that you wish to manipulate, if it is not already selected. A box will appear around the outside of the 3D object and a Command Bar of icons will appear both above and below the object. We will be using the top set of icons to move the object around in the space.

	To move the entire object up, down, left, or right, hover the mouse cursor over the fourth icon in the top left of the box around the selected object. Click and hold the left mouse button and drag it to move the object in the desired direction. The following screenshot shows the location of the icon being used to move the object up, down, left, or right. It is highlighted in pink and also shown over the 3D character: 






	To rotate the object along the y axis (the horizontal axis), hover the mouse cursor over the fifth icon in the top left of the box around the selected object. Click and hold the left mouse button and drag. The object will rotate along the y axis, as shown in the following screenshot:






	To rotate the object along the x axis (the vertical axis), hover the mouse cursor over the sixth icon in the top left of the box around the selected object. Click and hold the left mouse button and drag. The object will rotate around its center, vertically, as shown in the following screenshot:






	To move the object back and forth in a 3D space, hover the mouse cursor over the seventh icon in the top left of the box around the selected object. Click and hold the left mouse button and drag. The icon is shown in the following screenshot, highlighted in pink, and the character has been moved back, away from the camera:







            

            
        
    
        

                            
                    Moving parts of a model

                
            
            
                
Some models, such as figures and characters, as well as certain object models, can have individual parts of them moved. In this section, we will continue with the School Girl B model and move her arm as an example of how to pose a character:


	With the Object sub-tool, click on the model you'd like to pose. Once the model is selected, the movement controls will show. In the following screenshot, the blue circles are the movement handles for the major joints of the body:



 


	Click on the motion control handle of the body part you want to move. While holding down the mouse button, drag the control handle to move that part of the model. 

	When a control handle is selected, a sphere made of red, green, and blue lines will also be visible. This control allows you finer access to the movement of a part of the model in the x, y, and z axes. Simply click and hold down the mouse button on the line of the sphere corresponding to the axis you wish to move the part of the model in and drag to complete the movement.



Using the motion control handles, a character can be posed quickly! The following screenshot was created in just a few moments by clicking and dragging the handles. The slight rotation of the right foot was achieved using the axis control lines:









            

            
        
    
        

                            
                    Posing hands

                
            
            
                
Hands can be posed on a character either by clicking on each individual finger joint or by using the Sub Tool Detail menu to adjust the fingers. Let's take a quick look at the hand control in the Sub Tool Detail menu because it's a much faster way to pose hands than doing it by individual finger joints!

Click on one of the hands of the character to pose. Then, in the Tool Property palette, click on the icon in the lower right corner to open the Sub Tool Detail palette. Choose the Pose category from the menu on the left-hand side of the Sub Tool Detail palette.

The following screen will appear:

 

By moving the crosshair icon inside of the triangle shape overlayed on the hand icon, the fingers of the model can be made to spread far apart or come in close together, and also open or close into a fist. Above the large icon of the hand, there are five icons that look like links in a chain. Clicking on one of these will lock the corresponding finger into the current position while allowing the other fingers to continue to be posed. 

The best way to really understand these hand controls is to play around with them yourself and get a feel for them! So, give them a try and see if you like them. Posing the hand through the Sub Tool Detail menu is much faster, but can be much less precise than posing each finger individually. 

Not only can you move the 3D objects in Clip Studio Paint, but you can also move the 3D camera as well. Let's explore how to do this in the next section.



            

            
        
    
        

                            
                    Moving the 3D camera

                
            
            
                
The 3D camera is another way of saying from what angle we are looking at the 3D object or scene. Instead of moving the 3D character or object, we can instead move from the position where we are looking at the model. 

When moving the camera around the object, the object model will remain stationary. Follow these instructions to move the 3D camera:


	To move the camera up, down, left or right, hover the mouse cursor over the second icon in the top left of the box around the selected object. Click and hold the left mouse button and drag. The icon and camera movement are shown in the following screenshot:



 


	To rotate the camera around the object, hover the mouse cursor over the first icon in the top left of the box around the selected object. Click and hold the left mouse button and drag. The icon and the camera rotation are shown in the following screenshot:






	To move the camera back and forth in the 3D space, hover the mouse cursor over the third icon in the top left of the box around the selected object. Click and hold the left mouse button and drag. The following screenshot shows the zoom icon in pink at the top and overlaid on top of the character. Note how the hand of the character and the top of the head are now off the page since the camera is closer to her and she appears larger on the canvas: 





Rotate the camera often when posing your character to check the position of the limbs for accuracy. See the Moving parts of a model section of this chapter for instructions on posing characters.



            

            
        
    
        

                            
                    Using preset poses on figure models

                
            
            
                
The 3D section of the Materials Library includes many sub-categories. One of these categories is an entire library of pre-made poses that you can drag and drop onto a character model or one of the generic male or female figure models. Using these poses is a great way to get your character or figure reference into a pose quickly. You may need to make a tweak or two to get the pose absolutely perfect, but many of these poses work well on their own or are a fantastic starting point for creating your own poses. 

As a bonus, they're easy to use, too!


	In the 3D category of the Materials Library, find the Pose category and expand it by clicking on the triangle to the left of the category. Then, click on the Entire Body sub-category.

	Select a pose to add to the character. In this example, we are using a pose called P_soccer 01. 

	Click on the desired pose to select it. It will be highlighted in blue when selected.

	Click on the pose again and hold down the mouse button. Drag the mouse cursor over the top of the character or figure model while still holding down the button. The cursor will display a + symbol next to it when you're in the right spot.

	Release the mouse button over the character. The pose will change automatically to the selected pre-set pose, as shown in the following screenshot:





Preset poses can also be added to the canvas without a character or drawing figure model already being there. They will show up as generic drawing figures if loaded by themselves instead of when applied to a figure.



            

            
        
    
        

                            
                    Customizing character and figure models

                
            
            
                
Clip Studio Paint allows for the customization of both the character models and the generic figure models that come with its 3D library. The character models can have their expressions, hairstyles, clothes, and accessories changed, while the generic figures can have their proportions altered. In this section, we will customize the Schoolgirl B-Ver. 3 model into a cute catgirl, and we will alter the proportions of a generic figure. 



            

            
        
    
        

                            
                    Customizing characters

                
            
            
                
Follow these steps to learn how to customize the downloadable character models:


	Click on the 3D model with the Object sub-tool to select it. 

	Below the character will be a long horizontal menu of icons. The right-hand side of this menu will look like the following screenshot. These are the character customization controls:



 


	Click on the Select face of character icon to bring up any facial options for the character. The Schoolgirl B 03 model has only a Basic face option, as shown in the following screenshot:



 


	Click on the Select facial expression of character icon to show and select from a variety of facial expressions for the character. As shown in the following screenshot, each is named and has a preview image:






	Click on the Select hair style of character icon to show the different hairstyle options available for the character model. Most characters have a selection of long and short styles. Click on the desired hairstyle to select it. As shown in the following screenshot, each hairstyle has a name and a preview image to make selection easy:






	Click on the Select body of character icon to show the clothing options for the selected character. In the following screenshot, you will see that this character has three school uniform options and one street clothes option:






	Click on the Set display status of accessories of character icon to show additional hair options (for example, more bangs, ponytails, hair bows, and so on) as well as some other fun options like cat and bunny rabbit ears. Multiples of the accessories can be displayed at once, so clicking on both Bangs 01 and Bangs 02 will overlap the bangs, one on top of the other, rather than displaying one at a time. The following screenshot shows some of the extra hair options:





The character customization options allow us to take a generic school girl with long straight hair and make a character with a little more personality. Perhaps the character in the following screenshot is a catgirl from outer space?



With a little work, some customization, and importing some other models, it's easy to see that even someone who doesn't want to draw 2D characters could make a 3D rendered comic with Clip Studio Paint. But for those who are more interested in using the generic dolls as a reference for drawing your own characters, read on!



            

            
        
    
        

                            
                    Customizing figure models

                
            
            
                
The generic Male and Female drawing dolls don't have accessories and clothes to change. However, their body types can be altered to more accurately reflect the character you're drawing.

In this section, we will discover how to adjust the proportions of the drawing figure. Follow these steps to complete this task:


	Follow the instructions in the preceding The 3D Material Palette section to load the Male drawing figure model into the canvas.














	In the Command Bar, below the selected 3D figure, click on the icon all the way to the right, labeled Adjust body shape and size of 3D drawing figure in detail. This will open the Sub Tool Detail palette for the 3D model, as shown in the following screenshot:



 


	To the right of the image of the full body is a square menu that is divided into four smaller squares. By dragging the white + icon into the center of the four squares, we can change the proportions of the model by mixing attributes such as skinny, muscular, and fat. The Height and Head to body ratio sliders below this menu can also be used to adjust the model.




	To adjust the height and width of a specific part of the model, click on the corresponding section in the drawing of the figure to the left of the square menu. In the following screenshot, the torso is the currently selected body part being adjusted:



 


	Adjust any part of the model as needed to achieve the desired look for the drawing figure. Then, close the Sub Tool Detail window.



The following screenshot shows the figure model with proportions inspired by a chibi anime character!





In the next section, we are going to save our customized model to our material library so that we can use it again later.



            

            
        
    
        

                            
                    Saving 3D information to the Materials Palette

                
            
            
                
Two types of 3D information can be saved to the 3D Materials Library: Pose Information and 3D drawing figures. Pose information can be saved both from the generic Male and Female figures as well as from the character models. 3D drawing figure (proportions) information can only be saved from the generic Male and Female drawing figures. Currently, there is no way to save changes to the character figures as custom materials. 







            

            
        
    
        

                            
                    Saving Pose Information

                
            
            
                
Follow these steps to save a character's pose information to the Materials Library.


	Click on the character or drawing figure whose pose you'd like to save.

	In the Command Bar below the figure, locate the Register pose to material palette icon. (At the time of writing this book, it is the sixth icon from the left.) Click on the icon to bring up the Material property screen, as shown in the following screenshot:






	Under the Material Name, enter a catchy name for your pose.

	In the Location to save material section, navigate through the categories until you get to the 3D - Pose - Entire Body folder and select it as the location to save the material.

	Click on the icon in the lower right corner of the Search tag window to bring up the text box for tag entry. Type in a tag and press Enter. Then, click the icon again to add another tag.

	Once you have finished naming and tagging your pose, click on the OK button to finish saving the pose information.





I always recommend tagging every material that you save to the material library. It's an extra step, but it could save you a lot of time in the long run! In addition to tagging with terms that describe the material itself, I always use a custom tag for anything that I save to the Materials Library so that I can enter that search term and find everything I've saved.

Now, you can use this pose information on any figure or character! For instructions on using preset poses, see the Using preset poses on figure models section of this chapter.



            

            
        
    
        

                            
                    Saving 3D drawing figure information

                
            
            
                
These instructions allow you to save any changes to the generic Male and Female drawing figures proportions that you may have made in the Customizing figure models section of this chapter. Follow these steps to save custom proportions to the Materials Library:


	Click on the drawing figure you'd like to save.

	In the Command Bar below the figure, locate the Register 3D drawing figure to material palette icon. (At the time of writing this book, it is the ninth icon from the left.) Click on the icon to bring up the Material property screen, as shown in the following screenshot:








	Under the Material Name, enter a unique name for your figure.

	In the Location to save material section, navigate through the categories until you get to the 3D - Body Type folder and select it as the location to save the material.

	Click on the icon in the lower right corner of the Search tag window to bring up the text box for tag entry. Type in a tag and press Enter. Then, click the icon again to add another tag.

	Once you have finished naming and tagging your figure, click on the OK button to finish saving the information. 





            

            
        
    
        

                            
                    Importing 3D models into CSP

                
            
            
                
Using the 3D assets in the Materials Library is all well and good, but what about importing a unique model from another program? Clip Studio Paint can import 3D information from other programs, with some limitations. For instance, sometimes color and texture information on a model from an outside source may not import into Clip Studio Paint correctly. 

The file types that can be imported into Clip Studio Paint are CLIP STUDIO 3D Character format (extension: cs3c), CLIP STUDIO 3D Object format (extension: cs3o), CLIP STUDIO 3D Background format (extension: cs3s), and fbx, 6kt, 6kh, lwo, lws, and obj files.

Follow these steps to import 3D information into Clip Studio Paint:


	In the File Menu, click on File - Import - 3D Data, as shown in the following screenshot:






	In the Open window, navigate to the location on your computer where the 3D data file is stored. Click on the file that you wish to select, and then click Open. 




	It may take a moment for the 3D data to show in the file. Once it does, you will be able to position it and rotate the camera around it as normal.



The following screenshot shows a 3D model of a motorcycle that I used in a cover for my comic, Adrastus:



Once you import a 3D model, you can turn it into a line drawing by using a LT Conversion. To do this, click on Layer in the File Menu, then click on LT Conversion of layer to bring up the settings menu for the LT Conversion. The following screenshot shows our good friend School Girl B after the default settings on the LT conversion were used on her character model:







            

            
        
    
        

                            
                    Summary

                
            
            
                
This chapter took us deep into the third dimension and got us familiar with the 3D assets available in the Materials Library. We learned how to add 3D assets to our canvas, as well as how to move them in the 3D space. We learned how to rotate and move our camera to give us a different perspective on the 3D models. We learned how to use saved poses from the Materials Library, as well as how to customize the character models that come with our Materials Library. Then, we learned how to save our own 3D information as materials that we can use later. Finally, we learned how to import models from other 3D applications and how to turn those models into line drawings using LT Conversion. 

In the next chapter, we're going to continue exploring the Materials Palette, but we'll also be talking about creating Vector graphics using Clip Studio Paint. 



            

            
        
    
        

                            
                    Vector Layers and the Material Palette

                
            
            
                
One of the benefits of using Clip Studio Paint is that it is capable of producing both raster and vector images. In fact, raster and vectors can be achieved on different layers in the same canvas simply by creating the corresponding layer type. Creating vectors in Clip Studio Paint, however, is different in many ways to other vector programs.

Vector images are different from raster images. Raster images are made up of small squares of color, called pixels. Raster images are used in many situations, but they do have some disadvantages—mainly that since they are composed of pixels, they lose quality when made larger. Vector images are made of points that are connected together in the program, and are able to be edited on the fly and resized at will without a loss in quality. 

In this chapter, we will learn about both how to create vectors in Clip Studio Paint and also how to save artwork to the Materials Library for use again later. The following topics will be covered:


	Creating a vector layer

	Drawing on vector layers

	Editing vectors

	Saving art to the Materials Library



Let's get started with vectors!



            

            
        
    
        

                            
                    Vectors in Clip Studio Paint

                
            
            
                
Vector images are made from points, lines, and curves that are based on mathematical expressions. Because these images are made from mathematical expressions instead of pixels, it means that they can be scaled up or down infinitely without losing quality or becoming pixelated.

Vectors are most often used for logos, but they can be useful for creating comics or illustrations as well. The lines can be adjusted without being redrawn, so if you have trouble making confident lines for inking, then working with vectors may be a solution for you.

Some graphics software will only work with either vector or raster information. Manga Studio can do both, even within the same image file. We can have one layer of the image filled with vector information while all the others are filled with raster information if that's the way we want to do our work!

It's worth noting here that if you are already familiar with working in vectors in another program, you may need to adjust to the way that Clip Studio Paint handles vector graphics. Also, Clip Studio Paint's vectors are not exportable from the program as vectors, and vector graphics from other programs cannot be imported as vectors into Clip Studio Paint. 



            

            
        
    
        

                            
                    Creating a vector layer

                
            
            
                
To start working with vectors, we will need to create a vector layer. There are two ways to do this: through the File menu or through the Layer palette. 



            

            
        
    
        

                            
                    Creating a vector layer via the File menu

                
            
            
                
Follow these steps to create a vector layer using the File menu:


	In the File menu, click on File, then go to New Layer, and finally click on Vector Layer.

	Enter a name for the layer in the New vector layer dialog box that appears.

	Choose an Expression Color (Black and White, Gray, or Color) from the drop-down menu in the New vector layer dialog box.

	If applicable, choose a Blending mode from the drop-down menu.

	Click on OK to create the new layer.





            

            
        
    
        

                            
                    Creating a vector layer via the Layer palette

                
            
            
                
Follow these steps to create a vector layer using the Layer palette:


	Locate the Layer palette in the user interface.

	Click on the New Vector Layer icon in the bottom right-hand section of the palette. 




	The new layer will be created and will show up in the layer stack in the palette. To rename the layer, double-click on the layer's current name in the Layer palette. 



Anything drawn on a vector layer will be a vector image, meaning that it is not made up of pixels, but of control points. In the next section, we will learn how to draw on a vector layer with our favorite tools.



            

            
        
    
        

                            
                    Drawing on vector layers

                
            
            
                
Once you have created a vector layer, you can use any tool that you'd like to draw on it, including pencil tools, pen tools, or the direct drawing tools (line, curve, ellipse, and so on). To get a smooth and easily edited line, however, some editing may be needed to create a line with the fewest control points.

Let's look at two similar vector lines, as shown in the following screenshot:



The line on the top was created using the Continuous Curve tool. The line on the bottom was created using a Pen tool. The small squares shown along the center of each line are the control points that are used for editing vector lines. On the line that was created with the Continuous Curve tool, three control points are shown: one at the beginning of the line, and one at each point where the curve changes direction. The line created by drawing a curve with the pen tool has many more control points because Clip Studio Paint automatically places them wherever the program thinks they may be needed. This makes editing the vector lines more difficult without some editing beforehand.

Thankfully, Clip Studio Paint provides us with tools to make the cleanup process easier, which is exactly what we'll explore in the next section.



            

            
        
    
        

                            
                    Editing vectors

                
            
            
                
One of the advantages to using vector graphics is that the lines can be tweaked and edited endlessly until they are perfect. Unlike working with Raster layers, where a line must be erased and redrawn until it's just right, vector lines can be manipulated and reshaped using their control points. 

Clip Studio Paint has tools that allow for the easy cleanup and editing of vector lines. These tools can be found in the Correct Line category of tools, as shown in the following screenshot:



Let's take a closer look at some of these Correct line tools and what they do.
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The Control Point sub tool can be used to perform various actions on the control points along a vector line. These functions can be accessed via the Sub Tool Property palette when the Control Point sub tool is selected. The different modes of the Control Point tool are described as follows:


	Move Control Point: Allows the control point to be moved by clicking and dragging.

	Add Control Point: Adds a control point by clicking on the vector line at the point where the additional control point should be placed.




	Delete Control Point: Deletes control points with a click of the mouse.

	Switch corner: Switches the corner of the control point. Control Points can be hard corners or curves, and using this tool will change a hard corner on a vector line into a curve, and vice versa.

	Correct line width: Easily manipulate the width of the vector line by clicking and dragging to the right or left on a control point. Dragging in either direction will either make the line thinner or thicker at that control point.

	Correct line density: This is similar to the Correct line width option, but changes the opacity of the line at the control point by clicking and dragging.

	Cut line: Separates the vector line at the point where the tool is clicked.





            

            
        
    
        

                            
                    Simplify Vector Line

                
            
            
                
This is the tool that I use the most when creating vector graphics in Clip Studio Paint. I love the look of hand-inked lines for most of my art, especially lines that go from thin to thick and back again, like they are being made using a traditional brush pen. However, as seen in the Drawing on vector layers section of this chapter, using the drawing tools on a vector layer produces a line with an abundance of control points, making editing the line difficult.

The Simplify Vector Line tool can be used to reduce the number of control points in a hand-drawn line to only the points needed. The line in the following screenshot has had the Simplify Vector Line tool used on the left-hand side, while the right still has the control points that were created automatically:



Notice how close together the control points are on the curve on the right when compared to the control points on the left. This is because Clip Studio Paint puts too many control points along vector lines when they are drawn with a brush tool.

Using the Simplify Vector Line tool is easy. Simply select the tool, set the brush size, and then click and drag it over the areas of the vector lines that need to be simplified. A green highlight shows where you've already used the tool during that stroke. When the tool is released, the program will simplify the line automatically.

Note that after using this tool, some control points may need slight tweaking for accuracy.



            

            
        
    
        

                            
                    Correct Line Width

                
            
            
                
The Correct Line Width sub tool under the Correct Line category allows for a vector's line width to be changed at a whim. This is only one of the tools that allows us to change the width of the line. Let's take a look at the Correct Line Width sub tool properties, which is shown in the following screenshot:



The white circle to the left of the option name indicates which operation is currently active. Thicken width will make the vector line thicker, depending on what value the slider is currently on and where the tool is used. The Thin width option does the same, only making the vector line thinner. Scale up width and Scale down width also makes the line thicker and thinner by scaling it up or down, according to the value set under those options. The line in the following screenshot had various parts of it thickened and thinned using this tool:



The Fix Width option will set any part of the line the tool is used on to the width indicated by the slider, no matter how thick or thin it is before being used.

The Process whole line checkbox will complete the indicated action on the entire vector line at once. This can be a great time saver when wanting to make an entire line thicker or thinner, because one click anywhere along the line will change the whole line at once, instead of us needing to select the entire line with the tool!

The Brush size slider controls the size of the cursor of the Correct line width tool. 
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The Redraw Vector Line sub tool is pretty neat because it allows you to push or pull the vector line around at will with it. Simply select the tool, click along a vector line, and drag around to change the line. It's an easy way to adjust vector lines quickly and organically without having to completely redraw them!



            

            
        
    
        

                            
                    Redraw Vector Line Width

                
            
            
                
The Redraw Vector Line Width sub tool is another method of adjusting the thickness or thinness of our vector lines after they've been created. Honestly, this is the tool I tend to use the most when needing to adjust vector line thickness, simply because it is much more visual than the Correct Line Width tool. 

The Redraw Vector Line Width sub tool uses the Brush Size setting to adjust the thickness of the line. The larger the brush size is set, the thicker the tool will make the parts of the line it is used on. When the brush is set to a size smaller than the current line, the tool will make the line thinner. 

In the following screenshot, this tool was used in varying sizes along the length of the line:



Whatever size the brush was set to is the size that the line becomes after the tool is used. The large blob in the center of the line was created by making the brush size much, much larger than the current width. This was done by clicking the tool just once in that section of the line.
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Back in Chapter 5, Erasers, Selections, and the Subview Palette, I mentioned that we would talk about the Vector Eraser in a later chapter. Now is the time to talk about the Vector Eraser! 

The Vector Eraser can be used just like a regular eraser, but it also has some settings that turns it into an incredible time-saving device when working with vectors. Let's take a closer look at these settings now, as shown in the following screenshot:



Take special note of the Vector eraser section of the Tool Properties, as these are what set the Vector Eraser tool apart from other eraser tools. In this section, we can see three icons, each with a black and blue + sign being shown. These icons are Erase touching part, Erase up to intersection, and Overal line. To illustrate what each of these settings does, a simple grid of straight lines on a vector layer will assist us. 

The Erase touching part option will erase only what is gone over with the tool, just like any of the other eraser tools will do normally. In the following screenshot, this setting was used, and then a stroke was taken down through the grid of lines with it. Only the sections of line that the tool went through are erased:



Using the Erase up to intersection option allows us to clean up a grid of lines quickly and easily. This setting will erase the vector line up to the point where it intersects with another vector line. In the following screenshot, it was used to make one stroke down through the second column of the grid. Note that all of the horizontal lines from that section have disappeared, despite the fact that the tool only touched through the center of the column:



This setting can be used to quickly clean up the edges of the grid in the preceding screenshot. One swipe around the edges of the grid of squares, and stray lines are erased entirely, up to where they intersect with other vector lines, as shown in the following screenshot:



Instead of tediously erasing the ends of the lines and trying desperately to get them perfect, the Erase up to Intersection tool does it for you with one stroke!

The Overall line setting will erase the entirety of the vector line that is clicked on, no matter how small of a brush size the eraser tool is set to. In the following screenshot, this setting was used on every other horizontal grid line to make a set of rectangles instead of squares:



Need to draw windows on the side of a building quickly? Create a vector layer. Draw a grid of vector lines in perspective with the building, then use the vector eraser to quickly clean up the edges of the grid and put spaces between the windows with the Erase up to Intersection setting!



            

            
        
    
        

                            
                    Saving art to the Material Palette

                
            
            
                
We touched on the Material palette a little in Chapter 7, Using 3D Figures and Objects, but we concentrated specifically on the 3D assets of the Material Library in that chapter. We can also save 2D art to the Material Library for use later as patterns, designs, backgrounds, and more.



In this section, we are going to take a design and save it to the Material Library so that it can be used as a design on a character's shirt. First, though, let's take a look at the Materials Library categories, which are shown in the following screenshot:



In the left-hand side of the palette is a list of the different categories of materials. These are Color Pattern, Monochromatic pattern, Manga material, Image material, 3D, and Download. The following is a description of each of these categories:


	Color Pattern contains patterns and background assets that are in color. Most of these assets are seamless tiles, but not all of them. They are separated into sub-categories according to type.

	Monochromatic pattern is for monochrome patterns, backgrounds, and textures. Included in this category are many different types of screentone patterns for manga creation.

	Manga material contains assets like framing templates for comic page creation, speech balloons, sound effects, and effect lines.

	Image material contains illustration and photo assets, as well as any assets for brush tip materials.

	3D contains all 3D assets. For more information on 3D materials, see Chapter 7, Using 3D Figures and Objects.

	Download contains any assets downloaded from the Clip Studio App. For more information on downloading new materials, see Chapter 19, What is the Clip Studio App And Getting Animated.



Now that we know about the different types of assets in the Materials library, we can save our own artwork to the library as well.



            

            
        
    
        

                            
                    Saving artwork to the Materials Library

                
            
            
                
There are many reasons why we might want to save a piece of art to the Materials Library. Perhaps it's the title logo for your comic series and you want to be able to easily add it to your covers. Maybe it's a watermark that you intend to put over any image that you post online to deter art theft. Maybe it's a special speech balloon you designed for the villain of your graphic novel, or it's a special repeating plaid pattern for your protagonist's outfit. You can also lay out complex tattoos and save them to the Materials Library so that you can use them again instead of drawing them over and over every time you draw the character. Alternatively, you can create a T-shirt design for a character and simply paste it in and edit it slightly to fit the angle your character is standing at instead of redrawing the design each time! 

Materials can be as endless as your own imagination, and the preceding points are just a few ideas of ways to use them. 

The artwork in the following screenshot is going to be the artwork that will be used for the following instructions on how to save your own art assets to the Materials Library:



I have left the design with a transparent background because it will be used for a character's shirt in another creation, and so I want to be able to change the color behind the shirt and to isolate just the design itself when needed.

The following steps will walk us through the process of saving an image to the Materials Library:


	If your image is made of multiple layers, either flatten the image or go to Layer - Combine copy of displayed layer to create a new layer with a copy of the layers on it. Only the contents of the currently active layer will be saved to the Material Library, so be sure that all of the parts of the image that are going to be saved are on the same layer, and that that layer is selected before continuing.

	In the File menu, click on Edit and then go to Register Material and click on Image.

	The Material Property window will appear, as shown in the following screenshot:






	Enter a name in the Material Name text entry box.

	The Material Image box will show a preview of the image that is being saved. If this image isn't correct, click on the Cancel button and follow the instructions in Step 1 to ensure that your image is all on one layer.

	Under Paste Operation, make sure that the Scale up/down option is checked, and that Adjust after pasting is selected in the drop-down menu. This will allow us to resize the material after adding it to the canvas.

	The Specify Overlay slider allows us to choose where in the stack of layers the material will be added. For instance, if we were adding a background image, we could drag the slider all the way to the bottom of the stack so that the image will always be pasted beneath the other layers in the stack. Since we are creating a T-shirt design for this example, we will leave the slider at the top of the slider so that the design will appear over the top of the characters and will be adjusted as needed.

	Choose the desired category to save the Material in under the Location to save material window. In this example, we are using the Image Material - Illustration - Decoration folder to save this design. 

	Click on the icon in the lower right corner of the Search tag box to add tags to the Material. I always recommend using a unique tag on any materials you create and save so that you can find all of your assets quickly. I use the tag custom, but you can use your name, or maybe even the name of your comic project if that is what you want!

	Click on OK to complete saving the design to the Library.



Once our image is saved to the Material library, we can view it in the Materials palette. In the following screenshot, the robot unicorn art we saved by following the preceding instructions is shown at the top of the list under All materials, since it has just been added:



By selecting the material and clicking on the Paste selected material to canvas icon at the bottom of the Material palette, the material will be added to the currently active canvas. In the following screenshot, the design has been added to the character's —shirtno redrawing the image over and over again required!







            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, we started off by getting familiar with vectors. We learned what a vector is and how vectors in Clip Studio Paint differ from vectors in other programs. We learned how to create a vector layer and how to draw on it with both the direct drawing tools and the brush tools. Then, we learned about the different tools we can use to fine-tune our vector drawings. Finally, we learned how to save our art to the Materials Library for use in other creations.

Did you know that Clip Studio Paint includes a powerful set of text editing tools, as well as tools that make creating word balloons easy and quick? In the next chapter, we'll learn about adding and editing text, and about creating stylish, professional looking word balloons in just a couple of clicks!



            

            
        
    
        

                            
                    Using Text and Balloon Tools

                
            
            
                
Lettering for comics is a complex and nuanced topic that could make an entire book of its own. The rules and conventions for lettering a comic are varied, and lettering in and of itself is a skill that takes lots of time and practice to master. Back in the day before computers, a comic would have a dedicated letterer who would draw all of the dialog and words by hand using various tools. Thankfully, we can letter using Clip Studio Paint and the fonts installed on our computer rather than having to draw every letter on our own!

In this chapter, we are going to concentrate not on the theory and how-to's of lettering for comics specifically, but on how to use the type and balloon tools in Clip Studio Paint. Since Clip Studio is made for comic book artists, it has tools to make the creation of speech balloons easy, as well as tools to create different balloon tails and more. 

The following topics will be covered in this chapter:


	Text tool basics

	Advanced text settings

	Creating custom text tools

	Making and editing speech balloons

	Connecting speech balloons

	Using speech balloon materials



Let's get started!

Want more specific information on lettering for comics, as well as a selection of some of the best paid and free comic fonts ever? Look no further than www.blambot.com for both articles about the art of lettering as well as a huge selection of dialog and specialty fonts for comics.
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In this section, we're going to get a basic look at how to use the text tools and the basic settings before building on that knowledge in the sections that follow. Let's add some text to a drawing using the following steps:


	Open a blank canvas or a drawing to add some text to.

	Choose the Text category of the tools from the tool bar.

	Make sure that the Text subcategory is chosen in the Sub Tool palette.

	Select the Text tool.

	In the Tool Property palette, select the desired Font from the drop-down menu. This menu will populate with fonts that have been installed on your computer system. 

	Select the Size of the font by using the slider or the up and down arrows.

	The alignment of the text (Left, Center, or Right) can be set in the Justify section of the Tool property palette.

	Set the Text Direction to either horizontal or vertical.

	Set the Text Color using the options shown. Text color can either be the currently selected Main Color, the currently selected Sub color, or a User Color. 

	Click on the canvas where you'd like to place the text and type out your desired dialog or words.



The following screenshot shows a panel from my comic, Adrastus, with the dialog text added:



The text in the preceding screenshot is center justified and set at a size of 9.0 points. Depending on the font you are using, as well as your style of writing and art, a larger or smaller size may be more appropriate for you. Keep readability in mind, though, as you don't want to make your words so small that they are illegible! If you are posting your comic to the internet and also printing it, make sure to test that your text is legible in both formats. Sometimes, text that is legible in print can become illegible on the internet.

Once your text is typed out, you can resize it on the fly by using the control boxes around the text. In the preceding screenshot, they are the circular and rectangular handles around the outside of the box surrounding the text. Clicking and dragging on one of these boxes will make the text inside larger or smaller.

Those are the basic controls for making words in Clip Studio Paint. In the next section, we will take a deeper look at the text settings in order to make finer adjustments to things like line and character spacing.



            

            
        
    
        

                            
                    Advanced text settings

                
            
            
                
In some cases, you may need to adjust parts of the font that you are using. Whether that is the spacing between individual characters or the spacing between lines of text, Clip Studio Paint gives you the options to fine-tune your fonts to perfection. Let's look at these settings now.

To access these settings, open the Sub Tool Detail palette from the Tool Property palette in the user interface.
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The left-hand side of the Sub Tool Detail palette contains categories of options. In this section, we will take a look at the first category, the Font category. This category contains options for the font and size of characters, to word and character spacing and the style of the font.

The following screenshot shows this category of font options:





The following list describes each of the preceding options:


	Font: This drop-down menu lists the currently selected font. This list is populated with fonts that have been installed on your computer's operating system.

	Mixing font: This option is used mainly when mixing Japanese and Chinese characters with English characters, so we will not be using it in this book.

	Size: Set the size of the font.

	Horizontal ratio: This option sets the horizontal spread of the letters, making them wider or thinner.




	Vertical ratio: Use this option to control the vertical ratio of the font, making the letters taller or shorter.

	Word space: Controls the spacing between the individual words.

	Character spacing: Adjusts the spacing between the letters of the font.

	Style: This option allows you to set the font to the Bold, Italic, Underline, or Strikethrough font styles.

	Open face: Turns the font into an outline only font, where the letters are not filled in with a solid color.





            

            
        
    
        

                            
                    Line space/alignment settings

                
            
            
                
The second category of options in the Sub Tool Detail palette is the Line space | alignment. This category of options is shown in the following screenshot:



These settings are described in the following bulleted list:


	Justify: Set the alignment of the lines of text to Left, Center, or Right.

	Line space: Adjust the spacing between lines of text to have more or less space. 

	How to specify: This dropdown menu controls how to specify the Line space option. It can be set to either Specify length or Specify percentage.
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The following screenshot shows the Text category of the Sub Tool Detail palette:



Each of the Text settings is described in the following list:


	Text direction: Sets the text direction to either horizontal or vertical.

	Anti-aliasing: Sets the anti-aliasing used for text. The options are Use canvas settings, Off, and On.

	Use half-width punctuation marks: Having the checkbox selected uses punctuation marks that are half the width of the normal size.

	Wrap text at frame: This checkbox, when checked, will cause the text to be automatically wrapped when it gets to the end of the current line of text. If checked before the text entry begins, Clip Studio Paint will automatically create a small bounding box around the text to act as the text box. If it is checked after the typing has begun, the program will use the length of the current line of text to determine the size of the text box. Using this option disables being able to control the font size of the words by using the control handles around the edge of the bounding box.

	Align frames: When the Wrap text at frame option is used, this option becomes active as well. Allows the user to set the lines of text in the text box to align to the Top, Center, or Bottom of the text entry area.

	Edge: Adds an outline around the selected text. The thickness of the outline can be controlled using the slider that is activated after the checkbox is clicked.

	Edge color: Allows the user to select the color of the Edge outline. Click on the rectangle to the right of the option name to select the color.

	Background color: Sets a background color for around the text.

	Opacity: Controls the opacity of the background color.
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The following screenshot shows the Reading category of text settings:



These settings are used mainly for comics in Japanese so that you can add reading text to characters in Japanese dialog bubbles. Selecting a string of Japanese characters and then using the Reading settings allows the user to set a font for displaying reading characters next to the selected text automatically.
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The following screenshot shows the Edit settings category of text options:



The following is a list explaining these options:


	Show resize handle: Hides or shows the control handles around the bounding box of the text.

	Text color: Controls the text color by setting it to either Main color, Sub color, or a User color. User color can be selected by clicking on the User Color icon and then selecting the color from the color picker.

	How to add: This dropdown menu controls how Clip Studio Paint inserts the text, like adding to the current layer or always creating a new layer.



Now that we're familiar with all the different options available to edit and fine-tune our text, let's create a custom text tool to save these settings for a specific comic project.

Do you find yourself opening the Sub Tool Detail window often to get to a setting? The Sub Tool Detail settings for any tool can be added to the Tool Property palette in the interface by clicking on the rectangle to the left of the setting name. Settings with an eye icon next to them will be shown in the Tool property palette, making them easily accessible!



            

            
        
    
        

                            
                    Creating custom text tools

                
            
            
                
For some projects, you may to use the same set of text settings many times. Making a comic is just one example of when you may want to make a text tool that saves your font, font size, justification, and other settings so that you don't have to set them over and over again!

Creating a custom text tool is easy. Follow these steps to make a saved text tool:


	Select the Text sub tool.

	At the bottom right of the Sub Tool palette, click on the icon for Create copy of currently selected sub tool. 

	The Duplicate sub tool window will appear. It is shown in the following screenshot:



 


	Enter a name for your new text tool in the Name text entry box.

	Select a Tool icon, if desired.

	Click on the checkbox for Background color of icon and select a color to display around the icon when this sub tool is selected.




	Click on OK to create the new sub tool.

	Using the text settings and advanced settings, make changes to the new Text tool to set the font, font size, and any other options to make the text look as desired.



Now, whenever you need text with these settings, you can select your custom text tool and get right to typing!



            

            
        
    
        

                            
                    Making and editing speech balloons

                
            
            
                
Since Clip Studio Paint is made primarily for creating comics, there are tools included for creating speech balloons easily in the program. With just a few clicks, we can make speech balloons and tails that can be edited like vector objects.

Follow these steps to create a speech balloon and a tail:


	Add some text to your canvas using the directions that we given previously.

	The Balloon tools are in the same category of tools as the Text tool. They are shown in the following screenshot:



 


	Select the desired balloon tool. For this set of instructions, we will be using the Ellipse balloon tool.

	With the text layer selected, click with the Ellipse balloon tool and drag it to make a balloon surrounding the text. Don't worry about making it perfect – we will adjust the position in the next step.




	With the Operation - Object tool, click on the previously created balloon. Clicking directly on the balloon with this tool will reveal the individual control points and allow them to be manipulated like the vector points we learned about in Chapter 8, Vector Layers and the Material Palette. Use the handles around the outside of the bounding box to resize the balloon as needed, as shown in the following screenshot:



 


	To reposition the text inside of the balloon, use the Object tool to click on the text to reveal the text bounding box. Clicking and dragging on the text within the box will reposition the text, and the outside handles can be used to resize the text.

	To create the balloon tail, select the Balloon tail sub tool from the Text category. 

	In the Tool property palette, select the desired option from the How to bend drop-down menu. In this example, we will be using the Spline option. 

	Click inside of the speech balloon to start the tail. When using the Spline option, click for a second time on the point where the balloon tail should curve. Continue clicking to place curve points until the desired length of the tail has been reached, and then double-click to end the tail.

	The Object tool can be used to edit the look of the balloon tail as well as the balloon.



The preceding instructions show us how to make a simple balloon and tail. Let's take a few minutes now to look at the Tool Property options for the Ellipse balloon tool before we discuss the other balloon tools.



            

            
        
    
        

                            
                    Ellipse balloon tool

                
            
            
                
The following screenshot shows the Tool property palette for the Ellipse balloon tool:



The following list describes each of the options shown in the Tool property window:


	Line color: The color of the outline around the edge of the balloon.

	Fill color: Sets the color of the inside of the speech balloon.

	How to add: Controls how the balloon will be added to the image. The options are Create new layer and Add to selected layer. 

	Toning: Creates the balloon by using a dot tone effect.

	Figure: Set the shape of the balloon. A Rectangle, Ellipse, or Polygon can be created. 

	Brush size: Controls the thickness of the outline. 

	Anti-aliasing: Sets the anti-aliasing level for the outline of the created balloon.

	Brush shape: This drop-down allows a variety of effects to be applied to the outline of the balloon. In addition to settings such as Pencil, Airbrush, and Watercolor edge effects, such designs as Hearts, Dashed Lines, Dotted Lines, and more can be applied to the outline.
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The following screenshot shows the options for the Balloon Tail tool:



The following list describes each of the options for the Balloon Tail tool:


	How to bend: Sets the type of tail to be created. These are Straight line, Polyline, and Spline. 

	Width of tail: Controls the width of the tail at the starting point.
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The Curve Balloon tool is another way to create speech balloons. The following screenshot shows the options for this tool:



Many of these options are the same as the Ellipse balloon tool. The following list explains the options that are unique to this tool:


	Curve: Controls how to make the curves of the balloon. For a detailed description of each of the curve options, see the Curve Ruler section in Chapter 6, All About Rulers.

	Make corner pointed: Makes corners from smooth curves to hard corners.
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The Balloon Pen tool allows us to create speech balloons by drawing them freehand. The following screenshot shows the Tool property options for this tool:



The following is a description of the options in this tool that are not described in the Ellipse balloon section:


	Post correction: When this option is checked, the program will smooth out lines after they are drawn. The amount of correction is based on the value selected in the bar to the right of the option name.





            

            
        
    
        

                            
                    Connecting speech balloons

                
            
            
                
Connected speech balloons are common in comics. These are when you have dialog in multiple speech balloons that are connected together with balloon tails, as shown in the following screenshot:



This style of speech balloon is easy to do in Clip Studio Paint, but it does require a bit of forethought. Setting up the connected speech balloons actually occurs during the text tool phase of making the speech balloons. Follow these steps to create connected speech balloons:


	Type in the text for the first speech balloon by using the Text tool. Click on the Circle icon below the text entry to commit the text. This icon is shown in the following screenshot:



 


	With the Text tool, move the cursor close to the box surrounding the text for Balloon One. A + will appear next to the cursor when you are in the correct spot to make a connecting text box. Click and enter the text for the second balloon.




	Click on the Circle icon once the second area of text is entered. A box will appear around any text areas that are connected, as shown in the following screenshot:



 


	Create a balloon around each section of text, using the instructions in the Making and editing speech balloons section of this chapter.

	Select the Balloon Tail tool and drag a tail from the first balloon to the second, as shown in the following screenshot:






	When the tail is created, it will automatically connect the two balloons, as shown in the following screenshot:
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In addition to having the speech balloon sub tools at your disposal, Clip Studio Paint also has a library of speech balloon materials for special dialog, emotional moments, and almost anything else you can imagine.

We covered Materials in more depth in Chapter 8, Vector Layers and the Materials Palette, but let's take a look at the specific Speech balloons in the Materials Library now. This section of the Material Library is shown in the following section:





Balloon materials are located in the Manga materials category of the library. There are three sub-categories of balloons, as detailed in the following list:


	Dialog: The Dialog balloons include balloons for shouting, mumbling, announcements, whispering, thought clouds, and more

	Feeling: Feeling balloons are more specialized, with color borders of flowers, stars, and more

	Narration: The Narration category contains various rectangle balloons perfect for narration in comics



Note that some of these materials may need to be downloaded from the Clip Studio App before use. For more information, please refer to Chapter 19, What is the Clip Studio App And Getting Animated. 

To use a speech balloon material, select the material to highlight it, and then click on the Paste selected material to canvas icon at the bottom of the Material library. Speech balloon materials will not automatically attach themselves to text that is present in the image, so the material may need to be re-positioned and resized to fit the text.



            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, we learned about how to use the Text tool and about the settings for editing and fine-tuning text. We learned how to create a custom text tool to save text settings for our comic projects. Then, we learned how to create speech balloons with tails, how to connect speech balloons, and about the speech balloon materials.

In the next chapter, we will learn about some techniques for creating sound effects for our comics by using font effects and the Mesh Transform tools.



            

            
        
    
        

                            
                    Creating Sound Effects

                
            
            
                
Making sound effects for a comic is an art form in and of itself. It takes a lot of work and skill to turn sound into words! The letters that you choose to represent a sound are important, but so are the font, the colors, and even whether or not you choose to distort those letters for emphasis.

In this chapter, we will cover the following topics.


	Using fonts for sound effects

	Adding color and lines to fonts

	Using the Mesh Transform tool to wrap text



Let's dive right into these tools!



            

            
        
    
        

                            
                    Using fonts for sound effects

                
            
            
                
The easiest way to make sound effects is to use fonts. Many specialty fonts exist that are perfect for creating the feeling of explosions, cracking, gunfire, and more. 

Some great resources for these types of fonts are www.blambot.com and www.1001freefonts.com, but be sure to check the terms of use for any free font that you download! Some free font creators do not allow their fonts to be used in commercial projects, so if you're making a comic to sell, you need to be certain you are not breaking any copyright laws!

After downloading a new font and installing it on your computer, you may need to shut down Clip Studio Paint and restart the program in order to get the font to appear in the font list in the Text tool. Once it appears in the Font list, you can use the instructions in Chapter 9, Using Text and Balloon Tools, to lay out your basic text.

I have a confession to make: I am a font junkie! I love collecting new fonts for every occasion that I can think of! When you have a lot of fonts, the font list can get a little confusing and overwhelming. It can take a lot of time to find that specific font you downloaded last February for just this specific panel you knew was coming up in your script!

This is when it's hard to change how the font list is displayed in Clip Studio Paint. Click on the Font drop-down menu in the Tool property panel when the text tool is active. An example of the font list is shown in the following screenshot:





At the bottom of the font list, on the left-hand side, are three icons that control how the font list is displayed. The first icon is Display font name, and it shows the font list in the default font of Clip Studio Paint's user interface. The second icon is Display font name in specific font, which is the option shown in the preceding screenshot. Each font name is displayed in that font, making them easy to identify. The third icon is Display text in specific font, and it will use the currently selected text to display the font name. This is especially handy when doing sound effects because you can type out your letters and then see the way those letters will look in all the fonts that you have!

The following is an explosion sound effect that has been typed in the font Highjinks BB, which is available for free from www.blambot.com:



This is a perfectly acceptable sound effect for an explosion, but what if we want to really make it pop and add some color? Read on to find out how!



            

            
        
    
        

                            
                    Adding outlines and color to text

                
            
            
                
Of course, you can select a color other than black or white to make your text while entering it, but what if you want to apply a gradient, a texture, or create an outline for the text to really make it pop off the page? In this section, we'll cover those exact topics! All of these are easy effects to accomplish with just a few button clicks and some tricks in the Layer and Layer Property palettes.
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This technique works for anything on a layer that you may want to add an outline to, not just text. Here, we'll use our BOOM! sound effect as an example. It's very easy to create an outline in Clip Studio Paint using the Layer Property palette.

Follow these easy steps to add an outline to the contents of a layer. In this case, we're using a text sound effect:


	Ensure that your text layer is the currently active layer by checking that it is selected in the Layer palette.

	Locate the Layer Property palette. If you cannot locate it, ensure that there is a check mark next to the Layer Property option under the Window section of the File Menu.




	In the Layer Property palette, locate the Effect section of settings. Click on the Border Effect icon to show the options that are shown in the following screenshot:



 




	Use the slider or the arrows next in the Thickness of edges option to set the width of the outline.

	Click on the box next to Edge color to set the color for the outline from the color picker.



The following is our sound effect from the previous section, with the font color set to white and with a black outline around it:



Creating an outline with the Border Effect options allows for the outline to be edited later, so if you decide to make your outline a different color or to make the border thicker or thinner, simply select the layer again and change the settings in the Layer Property palette! No need to recreate your entire text layer from scratch!



            

            
        
    
        

                            
                    Adding gradients to text with Lock Transparent Pixels

                
            
            
                
A great way to add real punch to sound effects is to add a gradient. This can help your effect pop off the page when used correctly. Again, we can do this in just a few clicks! The following steps show you how to create a copy of a layer, rasterize it, and add a gradient:


	Ensure that your text layer is active by locating it in the Layer palette and clicking on it to highlight it.

	In the File Menu, click on Layer, and then click on Duplicate Layer to create a copy of the text layer. Alternatively, you can also click on the layer in the Layer palette and drag it to the New Layer icon in the bottom corner to create a copy of the layer. 

	With the layer copy selected, click on Layer in the File menu and then click on Rasterize to convert the layer to raster.

	In the Layer Palette, click on the icon labeled Lock Transparent Pixels. This will allow us to apply our effects only to the filled pixels in the layer. The Layer palette with the Lock Transparent Pixels icon selected is shown in the following screenshot:






	Select the Gradient category of tools in the toolbar, then select one of the Gradient sub tools. Click and drag it to apply the gradient to the text.

	In the Layer Properties palette, add the Border Effect option to give an outline to your sound effect, if desired. In the following screenshot, the Clip Studio Paint preset gradient Sunset Glow was used to give the sound effect a fiery look, and then a black outline was added to make the sound effect stand out:





When a text layer is Rasterized, it becomes pixels that cannot be edited with the Text tools. If you need to rasterize text to apply an effect, it is recommended that you make a copy of the text layer and rasterize the copy so that you can go back to the original text if changes need to be made.
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For extra special sound effects, you may want to add a pattern to your text for added emphasis. This is where Clipping Layers come in handy. A clipping layer is a layer that clips to the layer below it, only showing the contents of the top layer in places where the bottom layer has pixels filled in. Clipping layers are useful in all sorts of situations, but we'll use creating a striking sound effect as our example of how to use them.

Follow these steps to create a sound effect with a color pattern from the Materials library applied over it:


	Ensure that your text layer is active by locating it in the Layer palette and clicking on it to highlight it. 

	In the File Menu, click on Layer, and then click on Duplicate Layer to create a copy of the text layer. Alternatively, you can also click on the layer in the Layer palette and drag it to the New Layer icon in the bottom corner to create a copy of the layer. 




	With the layer copy selected, click on Layer in the File menu and then click on Rasterize to convert the layer to raster.

	Open the Materials library and select a pattern from the Color Pattern category to add to the text. For more information on using Materials, see Chapter 8, Vector Layers and the Material Palette. 

	The pattern Material may paste in a layer below the rasterized text layer. Click and drag the layer in the Layer palette to above the rasterized text layer. Your Layer palette should look something like what's shown in the following screenshot:






	In the File Menu, click on Layer, then go to Layer Settings, and click on Clip at layer below. Alternatively, you can right-click on the pattern layer in the Layer palette and go to Layer Settings, then click on Clip at layer below, as shown in the following screenshot:



 


	The pattern will now only be shown on the contents of the layer below it. The clipping layer is marked in the Layer palette by a red marker next to the layer thumbnail, which is next to the Shock 01 layer, as shown in the following screenshot:






	To add an outline to the sound effect, follow the instructions in the Adding an outline section of this chapter, but apply it to the original text layer at the bottom of the stack. This will produce a sound effect that looks like the following screenshot:
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Lots of sound effects in comics follow curves or the line of action to emphasize the art on the page. In the following screenshot, the sound effect for the explosion is angled and shaped to emphasize the action:



Though you can hand-draw sound effects like this if you want to (and hand-lettering is a great skill to have!), you can also create curved and warped text using the Mesh Transform tool.

Follow these steps to create a warped sound effect:


	Ensure that your text layer is active by locating it in the Layer palette and clicking on it to highlight it. 

	In the File Menu, click on Layer, and then click on Duplicate Layer to create a copy of the text layer. Alternatively, you can also click on the layer in the Layer palette and drag it to the New Layer icon in the bottom corner to create a copy of the layer. 

	With the layer copy selected, click on Layer in the File menu and then click on Rasterize to convert the layer to raster.

	In the File menu, click on Edit, then go down to Transform, and click on Mesh Transformation. 

	A grid of lines and points will appear over the layer contents. 

	In the Tool property palette, check the Number of horizontal lattice points and Number of vertical lattice points options. These both default to 4 points. For more fine control over the distortion of the text, make the number of lattice points higher. This must be done before you start moving any of the points around. The option to add more points will disappear after you start distorting the mesh! In the following screenshot, the number of horizontal points has been increased to 6 to accommodate for the longer length of the sound effect:



 


	Click on the points at the intersections of the grid and drag them to distort the sound effect. The areas around the moved point will shift and distort as the points are moved, as shown in the following screenshot:






	Continue moving the points around to reshape the contents of the mesh. In the following screenshot, a curved effect has been created by staggering the control points:



 


	Click on OK to commit the transformation. The final sound effect we've created in this example is shown in the following screenshot:





Mesh transformation isn't just for sound effects! It can also be used on pattern materials to create more realistic clothing patterns. What will you use the mesh transformation for?



            

            
        
    
        

                            
                    Summary

                
            
            
                
In this concise chapter, we have explored ways to create sound effects. We have used specialized fonts to make sound effects, and have learned how to punch up those fonts with outlines and gradient effects. We used clipping layers to add a pattern to a sound effect. Finally, we learned about mesh transformation to distort and curve our text effects. 

In the next chapter, we will explore the wonderful world of masks. Not like masks for costumes, but layer masks! Read on to learn more about this feature of Clip Studio Paint.



            

            
        
    
        

                            
                    Making Layer Masks and Screentones

                
            
            
                
Layer masks are an extremely useful feature in digital art that have many applications. Screentones are used less and less in modern printing, but are still quite popular in black and white manga printing. In this chapter, we will learn about the following topics.


	What is a layer mask?

	Using a layer mask

	Using selections to create layer masks

	Adding screentones to a large area

	Using Quick Tones



Let's dive right in!



            

            
        
    
        

                            
                    What is a Layer Mask?

                
            
            
                
A layer mask is a feature of digital art that allows parts of a layer to be hidden without being erased for good. This allows us to fine-tune a drawing or part of a drawing without losing what has already been done. Layer masks can be adjusted over and over, hiding parts of a drawing and then being removed again to bring those parts back. 

A good way to think about a layer mask is as being like a Halloween mask. Putting a mask on your face would make your real face unable to be seen. Take the mask off, and your face would be visible again.

Unlike using eraser tools, layer masks are impermanent and allow changes to be made without losing any data. We can see what a character looks like with a different hairstyle or temporarily hide parts of a background, for example. The best thing is that layer masks are easy to use and to edit!



            

            
        
    
        

                            
                    Using a layer mask

                
            
            
                
In order to make a layer mask, you will need a canvas open, with one layer with some sort of content on it. This could be a sketch, an ink drawing, a photo, or anything else you desire, so long as there is some sort of content to mask out so that we can see how the layer mask works. 

Follow these steps to create a layer mask and hide and restore content:


	Select the layer to add the mask to by clicking on it in the Layer palette. 

	Click on the Create layer mask icon at the bottom of the Layer palette. This icon is shown in the circle in the following screenshot:






	A new thumbnail will appear to the right of the layer thumbnail in the Layer palette. This is the layer mask. When the layer mask is selected, a secondary black outline will appear around it. The following screenshot shows a layer with an actively selected layer mask:






	To hide the content on the layer, select an Eraser sub tool. Erase the section of the layer that needs to be hidden. The masked-out area will show up in the layer thumbnail as a blacked-out space. The following screenshot shows the black area where the layer has been masked:






	To make masked-out content visible again, select any pen or brush tool. Draw over the masked area again with the tool to show the masked content. The following screenshot shows that the middle of the masked area has been shown again because the area inside of the black mask is white again:





If you are having trouble editing the layer mask or the layer that the mask is attached to, double-check the Layer palette to ensure that the layer mask or the layer is selected before moving on to other troubleshooting. Sometimes, the layer can be selected instead of the layer mask, or vice versa, which can cause an undesired situation.

Want a part of your drawing to have a ghostly or faded look? Use the Soft Eraser on a layer mask to fade out the edges of the drawing.



            

            
        
    
        

                            
                    Using selections to make Quick Masks

                
            
            
                
Layer masks can be created quickly by using the Selection tools to select the areas of the drawing we want to hide and then adding the mask with active selection. 

We covered a multitude of ways to make selections in Chapter 5, Erasers, Selections, and the Subview Palette, so if you need a refresher on making selections, now is a great time to go back and review that chapter before continuing on with using a selection to make a quick layer mask.

Once you've familiarized yourself with the Selection tools, follow these steps to create a layer mask quickly:


	First, make a selection using one of the Selection tools. In the following screenshot, the lasso marquee tool has been used to make a selection around the character's mouth:



 


	In the File menu, click on Layer, then navigate to Layer Mask and click on Mask Selection. This path is shown in the following screenshot:






	Using this method, the area inside the selection will be masked but everything outside of the selection will be visible. In the following screenshot, the mouth is now hidden by the layer mask:






	To mask everything outside of the selection, in the File menu, click on Layer, then navigate to Layer Mask and click on Mask Outside Selection. In the following screenshot, only the character's mouth is visible, because it was inside of the selection and so has not been masked:



 


	Make any necessary edits to the mask, as detailed in the Using a layer mask section of this chapter.



Want to mask everything outside of the selection quickly? Make your selection and then click on the Create layer mask icon in the Layer palette. A mask will automatically be generated for the outside of the selection.

Using the selection tools allows us to make masks more quickly and easily. Rather than having to go over large areas with the eraser tools, instead we can make a simple selection and create a layer mask for that selection with the press of a button. What a time-saver!



            

            
        
    
        

                            
                    Adding screentones to large areas

                
            
            
                
Screentones, or halftones, are made of a pattern of dots that provide shading. Back in the days before digital art, these tones would be bought printed on a big sheet of sticky-backed plastic. Artists would apply this large, clear sticker over their art and then carefully use a sharp knife to cut out the areas that didn't need tone on them and peel away the excess. The downsides to this method were that you had to continue buying new screentone sheets, and that, sometimes, a careless stroke would cut through your original artwork, ruining it!

But now, we can mimic these patterns of dots digitally. And, thanks to layer masks, we can simply mask out the areas that don't need to be shaded without doing any damage to the screentone pattern or to our original sketch or inks. This makes the screentone process easier and less stressful! 

The following is an example using digital screentones. Note that the shadows are created using a pattern of circles that provide depth for the image:



Follow these steps to add tone to a large area:


	Open a new file. For this set of instructions, the size and resolution don't really matter. 

	Open the Material library palette. 

	Open the folder under the Monochromatic pattern category in the Material library by clicking on the triangle next to the folder name to view the contents beneath it.

	Click on the triangle next to the Basic sub-folder to view the contents of that folder. 

	Click on the Dot sub-folder to view the materials located in this folder. 




	Select the desired screentone material to apply to the image. In this example, we are using the 50.0 line 50% Circle Monochrome material. Once you have selected the desired screentone material, click on the Paste selected material to canvas icon at the bottom of the Material palette. 

	The tone material will be applied to the entire canvas, as shown in the following screenshot:






	The new Material layer will be made with an empty layer mask already attached to it. Use this layer mask to edit the screentone so that it only shows in the shadowed areas.



The following image shows our drawing with screentone shadows:







            

            
        
    
        

                            
                    Lines and percentages in screentone names

                
            
            
                
Before we continue on with our next method for adding tone to images, let's take a moment to understand the terminology in the screentone names. The following is a screenshot of four of the tone materials in the library:



Beneath each tone material is the name of the tone. We can break these names into four parts. Each of these parts of the name are detailed as follows:


	Number of screen frequency: This is the number at the very beginning of each filename, before the word line. For example, in the first material in the preceding image, the number for the screen frequency is 55.0. This number refers to how many lines of the pattern are repeated in a set area. Much like DPI, the larger this number, the smaller the overall shapes in the tone pattern will be. Compare the 75.0 thumbnail to the 25.0 one and note how much larger the circles are in the 25.0 example. The larger the number at the beginning of the material name, the smaller the dot pattern will be.




	Density: This part of the name refers to the number with the percent sign behind it in the screenshot. Density controls how dark the created shadow will appear to be. For example, a density of 10% would be a very light shadow, made of very small dots in the screentone pattern. However, a density of 95% would be made of very large black dots that might only have very small white dots in the pattern because of the overlap. A density of 100% would be pure black. Each tone in the image has a 50% density, which will provide medium shadow in the completed artwork.

	Type: This refers to the shape that the pattern is created from. Most commonly, screentones are made of solid circles. However, as you will see in the Quick Tones section coming up, we can make tone patterns from many different shapes and symbols. Each of the tones in the screenshot are the Circle type. 

	Gradient Style: Each of the tones in the screenshot are of the Monochrome variety because they are located in the Dot screentone folder. This means that the tone is comprised of only one density and the number of screen frequency throughout the entire tone. However, if we look in the Gradient folder instead of the Dot folder, we will find tones that have Linear and Circular gradients that fade from dark to light and back again in a pattern. These specialty tones can be used for effects or to get soft shading.



Now that we know a bit more about the terminology of screentones, let's look at the fastest way to apply tones in Clip Studio Paint: the Simple Tone options.



            

            
        
    
        

                            
                    Using selections to make simple tones

                
            
            
                
We can also make our selection beforehand and then fill the selection with a customized tone, instead of one that is already in the Material library. 

The following steps show how to add a screentone to a selection. You will need to have an open file ready to follow these steps:


	Use a selection tool of your choosing to make a selection. 

	In the command bar beneath the active selection, click on the New Tone icon. This is shown in the following screenshot:



 


	Choose the desired settings from the Simple Tone settings dialog box that will appear. Note that the Number of screen frequency, Density, and Type terms that we addressed earlier are also used for this dialog box's options. We can also adjust the Angle of how the pattern is applied: 






	Click on OK to fill the selection with the new tone. 



If you will be using the same Simple Tone settings in multiple selections, checking the If there are tones with the same settings, combine them into one option box will create all of those new tones on one layer. This can help save system resources and make layers easier to navigate. 

In the following screenshot, we have used screentones over flat gray fills to add more dimension to the comic panel:



Let's talk for a moment about the different options available under the Type drop-down menu in the Simple Tone dialog box. This allows us to choose shapes other than simple circles to other shapes. These shapes include hearts, stars, asterisks, and flowers, amongst others. They can be used to create special effects in certain scenes, or just to provide some variety amongst tones. In the following image, the star shape has been made with the star screentone:



The Size and Factor options in the Simple Tone Settings dialog box are only available when using the Noise option under the Type option. The following is an example of the Noise screentone:







            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, we learned what a layer mask is and how to create one. We also learned how to make a layer mask using the selection tools to save time. We then learned about the benefits of using layer masks in comparison with the eraser tools. To finish off the chapter, we used screentone materials and created simple tones by using selections and layer masks.

In the next chapter, we're going to take a deep dive into the tools that Clip Studio Paint provides for comic artists to create panels with. This software makes creating panels a breeze and offers lots of options for doing so. So, I hope you'll join me in exploring these tools in the next chapter!



            

            
        
    
        

                            
                    Making Comic Panels

                
            
            
                
Clip Studio Paint is a program made with comic and manga artists in mind. As such, it has many features that are useful to comic artists, such as the screentone materials and the ability to easily create word balloons. 

Also included for comic artists are a variety of tools and options for making frame border Layers. These frame borders make comic panels – the individual boxes that each piece of sequential art in a story is drawn inside of. These frame border layers can be created easily, edited in just a few clicks, and even set to mask out any content outside of the panel – which makes for a much easier drawing experience.

In this chapter, the following topics will be covered:


	What are frame border layers?

	Creating frames

	One layer and many panels, or one layer for each panel?

	Dividing and editing panels

	Using Framing template materials



Let's start making some comic panels!



            

            
        
    
        

                            
                    What are frame border layers?

                
            
            
                
As stated in the introduction to this chapter, frame border layers are what Clip Studio Paint calls the specific type of layers that it makes comic panels from. Panels in comics are like shots in a movie or TV show. They contain the action and can also give a sense of the amount of time that's passed or how much weight the action contains. Panels can also bring lots of drama and excitement to a page, and can lead the reader's eye around the composition, telling them what is important and what they should be looking at. 

Panel layouts can be straightforward or much more exciting. Let's take a look at a few comic panel examples, along with the way that their frame border layers are laid out in the Layer palette. All of the examples are taken from Chapter 18 of my comic, Adrastus. 

Here is the first example:



In the preceding example, all of the panels are rectangular and contained within the inner border of the page. The top panel is given the most visual weight because it contains the end of a fight that has been going on in the previous pages. The four panels below it have less visual weight and are meant to reestablish where the main characters are inside of the giant robot, as well as starting to introduce the small flying robot character.

In the Layer palette at the bottom-right of the screenshot, you will see the various frames of the comic. Each panel is created in its own frame border folder, and you can tell which panel it is by looking at the black and white mask of each of the layers. (For more information on layer masks, see Chapter 11, Making Layer Masks.)

The following screenshot shows another example of comic paneling:



In the preceding example, the bottom three frames stay within the inner border of the page, but the top panel has been extended out beyond the margins. This is called a bleed, and it refers to any art that goes off the edge of the page. When printed, the paper would be trimmed down to the final finished size so that there is no white margin around the edge of the paper. This trimming of the paper after printing occurs in traditional book publishing, which is why we must always keep the interior margins of the page (the Default Border size in the New file options in Clip Studio Paint – see Chapter 2, Preferences, Shortcuts, and Other Commands, for more information on creating a new file) in mind. Artwork, text, and anything else that is too close to the edge of the page is at risk of being cut off in the trimming process, so it is a good idea to keep anything important, such as dialog and speech balloons, inside the inner margins at all times.

Here is a third example of a comic panel layout, along with its corresponding Layer palette from Clip Studio Paint:



This page is supposed to be dynamic and exciting, as it shows the climactic strike in the battle taking place. The panels are not squares or rectangles, but instead are dynamic angled shapes that lead the eye around the page. Believe it or not, this set of panels was just as easy to create as the other panel examples; it just required a little bit of pre-planning to keep everything together!

Of course, these three examples do not cover the entire spectrum of comic book paneling. Just like shooting a movie, there are countless ways to tell a story. Page compositions depend on the style of the artist and the type of story they are telling to inform the style of paneling. American comic books tend to use strict panel guidelines, only breaking out of the borders for splash pages or for particularly dramatic moments, whereas some manga tends to do away with panels altogether at times and let the art float across the page – especially in romance-driven manga aimed at young girls!

You will discover the page compositions that work for your style and story with lots of practice and study. The point of this chapter is not to teach you how to lay out a well-paneled page, but to teach you how to use the tools in Clip Studio Paint to create those panels in the digital world! So, now that we've talked about panels and what they are, let's get into the tools we use to make them.



            

            
        
    
        

                            
                    Creating frames

                
            
            
                
In order to create frame border panels, you will need an open page. I recommend using one of the templates under the comic category to test out the panel creation tools, but use any size canvas that you feel comfortable with! I recommend the comic templates because they already have the Inner border size set, so it's easy to see where you should keep the panels to avoid them getting cut off.

Before we get into actually creating some panels, let's take a look at the sub tools used to make them and some of the options for those sub tools. The Frame Border sub tools can be found under the Figure category of tools in the Toolbar. These sub tools are shown in the following screenshot:



In this section, we are going to concentrate on the Rectangle frame, Polyline frame, and Frame border pen tools. We will discuss the other two sub tools in the Dividing and Editing Panels section coming up later in this chapter.

The following screenshot shows the Tool property options for the Rectangle frame sub tool:



The list that follows provides details about each of these options:


	Draw border: This checkbox controls whether a line is drawn around the outside of the created frame or not. When unchecked, Clip Studio Paint will create a panel with no outline.

	How to add: The options under this drop-down menu are Create a new folder and Add to selected folder. Depending on the setting selected, new panels will either be made in a folder of their own or will be created all in the same folder. We will discuss this more in the next section of this chapter.

	Raster layer: When checked, this option will automatically create a new raster layer underneath the new panel folder.




	Fill inside the frame: Automatically creates a background fill layer in the new frame.

	Aspect type: When checked, this option controls the aspect ratio of the created panel with either a set ratio or a set length. For example, to create frames that are all exactly the same size, that size can be specified by setting the Width and Height under the Set Length option.

	Brush size: Controls the thickness of the created border outline.

	Anti-aliasing: Sets the anti-aliasing of the border outline.

	Brush shape: Controls the brush used to draw the outside border. For example, a border of dashed lines or hearts can be set using this drop-down menu. 



Now that we know a little about the panel options, let's create some panels using the first three sub tools in the Frame border category.



            

            
        
    
        

                            
                    Using the rectangle frame tool

                
            
            
                
Follow these steps to create a comic panel using the Rectangle frame tool:


	Select the Rectangle frame tool from the Frame border category. 

	Edit the tool properties to your desired settings.

	Decide where you want your panel to be located on your open page.

	Click and hold down the mouse button or stylus where you want the panel to begin.

	Drag to create the panel and release when the panel is the desired shape and size.

	Repeat to create additional panels.



The Rectangle frame tool can be used to create circle- and polygon-shaped panels, as well as squares and rectangles. Simply click on the icon at the bottom of the Tool property palette to bring up the following screen:



Under the Figure options, you will find icons to change the shape to a circle or a polygon, as shown in the preceding screenshot.

Want to see options from the Sub Tool Detail screen in the Tool property palette for easier access? Click on the box to the left of the option name to turn on the eye icon. Any options with the eye icon next to them will be available in the Tool property palette.



            

            
        
    
        

                            
                    Using the Polyline frame tool

                
            
            
                
The Polyline frame tool allows us to create more complicated and irregularly shaped frames.

Select the Polyline frame tool and look at the Tool property palette. If the Curve options are not visible, they can be accessed through the Sub tool detail palette, as shown in the following screenshot: 



The very first icon will produce straight lines between the points of your frame, and the second option is the Spline setting, which will create curves between each point of the frame. To use either of these options, simply click on the point in the canvas where you want the frame to start. Then, click again where the second point should be. Continue clicking on each corner of the frame until you reach the starting point, and double-click to finish the frame.

A frame made using the Straight line option is shown in the following screenshot: 





            

            
        
    
        

                            
                    Using the Quadratic Bezier option

                
            
            
                
Using the Quadratic Bezier option for a panel takes a little getting used to and usually requires some refinement after the initial points are laid out. Follow these steps to create a curved panel with Quadratic Bezier:


	Select the Polyline frame and then the Quadratic Bezier option from the Tool property palette.

	Click on the canvas once, at the point where you'd like the frame to start. 

	Click on the point where you would like the frame to start curving. This will create a small square handle at the clicked point.

	Move the cursor to another point on the canvas. The line of the frame will bend according to where the second click was placed and where the cursor is now. 

	Continue clicking to add boxes and curves to the frame until it is the desired length. Double-click to end the frame when the starting point is reached.




	To adjust the frame, select the Operation category of tools and then the Object tool. Click on the frame outline to select it and reveal the handle controls. In the following screenshot, the control handles are on the straight lines and the frame is the curved lines:







            

            
        
    
        

                            
                    Using the Cubic Bezier option

                
            
            
                
Another option for making curved frames is using the Cubic Bezier setting. Follow these steps to create a frame using Cubic Bezier:


	Select the Cubic Bezier setting from the Tool property palette of the Polyline frame tool.

	Click on the first point of the frame.

	When clicking to add the first curve, hold down the mouse button and drag in the direction your line is going. (For example, if you are starting on the left-hand side of the canvas and heading toward the right, drag the mouse to the right while holding down the button. Going in the direction of the line will prevent the control handles from getting reversed and making "snarls" in the line.) The line between the two clicked points will curve.




	Click on a third point and drag with the mouse while holding down the button to continue making the curve.

	To end the frame creation process, click on the starting point to enclose the frame.

	To edit the Cubic Bezier frame, select the Operation category of tools and select the Object tool. Click on the frame to reveal the control handles. The control handles are shown by the red lines in the following screenshot:







            

            
        
    
        

                            
                    Using the Frame border pen

                
            
            
                
The Frame border pen is a versatile tool that allows you to freehand any shape into a frame border. It's as easy to use as any of the other drawing tools, too!

Follow these steps to create a frame with the Frame border pen:


	Select the Frame border pen sub tool from the Frame border category. 

	Using the mouse or tablet stylus, draw the desired shape for the panel outline. 

	When the entire shape is enclosed, release the pressure on the mouse button or stylus tip to complete the frame creation process.



As shown in the following screenshot, more complex frame shapes can be made with the Frame border pen than with the other frame creation tools:





            

            
        
    
        

                            
                    One layer and many panels, or one layer for each panel?

                
            
            
                
You may be wondering: why use the Frame Border tools to create panels when we can use the various shape tools to simply draw a border and create our art inside of it? 

Frame Border panels come with a feature that makes them a lot more convenient than just using the Direct Draw tools to make a square and drawing your comic art inside of it. As you may have noticed from the screenshots in the previous section, the outsides of the comic borders are shaded in with the color purple or blue. This is because the frame borders are made with a layer mask automatically on the outsides of them. Because of this layer mask being generated, we can create artwork that goes outside of the panel but that is automatically cleaned up.

For instance, let's look at the line in the following screenshot:



This line was drawn on a layer inside a frame border panel. So, even though a large line was drawn, inside of the frame, only the parts of the line seen in the following screenshot were visible:



Because of this layer mask, we don't need to spend time tediously making sure that our art doesn't go outside the confines of our panels. 

However, we can create our panels either all on their own layer or with every panel on the same layer. In the following screenshot, one panel has been created on its own layer and two more panels have been created on the same layer:





You can see the outlines of each layer by looking at the black and white layer mask icons to the left of the layer names. The Frame 1 layer contains one panel in the upper-left corner, while the Frame 2 layer contains a panel in the top-right, and another panel below the previous two. These were created by toggling between the two options in the How to add drop-down menu in the Tool Properties for the Rectangle frame tool. 

As shown in the following screenshot, the Frame 1 layer allows us to see only what is inside of the attached layer mask. The other two panels are shaded out and the contents of those frames will not be visible in the single frame:



If we create all our panels on separate layers, then each will be independent of the others. However, with panels created on the same layer, artwork can be shown in multiple panels continuously. In the following screenshot, the drawing from the top-right panel continues down behind the layer mask and through the lower panel:



Ultimately, the decision of whether to put all your frames on their own layers or all on one layer is yours to make. Putting each on its own layer means more layers to manage and more clicking around to complete your comic page. But putting them all on one layer means more managing of your creation process to ensure that artwork is only in the frame it's supposed to be in. Personally, I am a messy artist when I sketch and ink, so I put each frame on its own layer so that I don't have to do so much micro-management. But of course, the right choice for you will depend on your working style and preferences!



            

            
        
    
        

                            
                    Dividing and editing panels

                
            
            
                
A big advantage to working in the digital realm is the ability to make edits on the fly. Just as with almost everything in Clip Studio Paint, our frame border panels can be edited even after we've created them. Resizing, rotating, and even completely changing the position of our frames is possible, as is adding new frames or deleting frames entirely. In this section, we will learn how to make changes to the frames we've created. 

Obviously, to follow along with this section, you will need to create some frames. So, if you haven't done that already, follow the instructions in the Creating frames section of this chapter and put some panels on a page!



            

            
        
    
        

                            
                    Resizing, rotating, and moving panels

                
            
            
                
To resize a comic panel, you'll need to first select the Object tool from the Operation category of tools. With the Object tool selected, click on the outside edge of the comic panel to select it. When the Frame Border is selected, a red line will show along the outline of the panel, as well as some light-blue and yellow handles, and small yellow arrows. Around the outside edge of the panel, a rectangle with a light-blue handle at each corner and a handle at the center-top will also show. 

To resize the panel manually, click on one of the light-blue handles and drag. Once the desired size is reached, let go of the mouse button. 

The small yellow arrows can also be used to resize a panel quickly. Clicking on one of the yellow arrows will automatically take that edge of the panel out to either the same size as a nearby panel (if there are any nearby panels), or take that side of the panel to the edge of the page. In the following screenshot, the yellow arrow on the left-hand side of the panel was used to quickly make the panel bleed off the edge of the page:



Rotating a panel is just as simple as resizing one! To rotate a panel, simply move the mouse over the light-blue handle sticking up outside of the bounding box at the top of the panel. The cursor will change to a curved double-headed arrow once it is in the correct position for rotating. Click and drag to rotate the panel to the desired position. 

In the following screenshot, the handle was used to rotate the panel clockwise:



To move the selected panel, put the Object tool over the red outline around the edge of the panel. Click and drag to move the panel to the new location. Release the button once the new position is reached to stop moving the panel.

The following screenshot shows that the panel has been moved down and to the right from its starting position:





            

            
        
    
        

                            
                    Dividing existing frames

                
            
            
                
Remember how I said earlier that we would cover the Divide frame folder and Divide frame border tools later? Now is the time! 

These two tools can take one frame and turn it into two. But, just as their names suggest, they each perform that division a little differently. Earlier, we discussed how we can either make our frames all on one layer or each on their own layer. These two dividing tools divide the existing frames into either separate layers or frames all on one layer. Let's look at each tool and how to use it. 

Here is a screenshot showing the Tool property palette for the Divide frame folder tool:



In the following list, you will find a description of each of these settings:


	Shape of division: Controls how the panel is divided. The options are Divide by straight line, Divide by polyline, and Divide by spline. Using the straight line option will produce a panel division that is one straight line. Polyline division allows us to create a panel division using a segmented line. The spline division option allows us to create a curved panel division. 

	Dividing method: Controls how the panel division operation is carried out. These are Divide frame folder and duplicate inside layer, Divide frame folder and create empty layer, and Divide not folder but frame border. The first two options will create a new panel folder after the division is completed, but the first option will duplicate the layer inside the existing panel, while the second will create an empty layer inside the folder. The third option turns the Divide frame folder tool into the Divide frame border tool by splitting the frame but keeping both new frames on the same layer. 

	Space of frame border in preference: Uses the value set in the program preferences to set the gutter space between panels.

	Horizontal space: When the preceding option is not checked, this sets the height of the horizontal gap between panels.

	Vertical space: When the option to use program preferences isn't in use, this sets the width of the vertical gap between panels.



Using the Divide frame folder tool is easy. Simply select the tool and click on or near the edge of the panel to divide. While holding down the mouse button or stylus, drag to where you want to divide the panel. A set of lines will show a preview of the panel division so you can see exactly what your new panels will look like. Once the preview lines are in the correct spot, release the mouse button to complete the division. 

In the following screenshot, our panel has been divided into two panels, each in its own folder:



The Divide by straight line option under Shape of Division was used to split the preceding frames.

Here is a screenshot of the Tool property palette for the Divide frame border tool:



See the preceding list for a breakdown of each of these options. 

This tool divides an existing frame but keeps each new frame on the same layer, making connected panels. In the following screenshot, the panel has been split using the Divide by spline setting, in order to make a curved division:



Now we know how to create, edit, and divide panels. We can also use panel templates to help save time with page creation. Keep reading to find out how!
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As you may know from reading Chapter 8, Vector Layers and the Materials Palette, the Material Library has tons of useful resources that can save lots of time when working on your creative projects. Included in the Materials Library are a large number of framing templates that can be used to easily and quickly set up a comic page. 

The comic panel templates can be found in the Materials Library, under the Manga Materials folder and in the Framing template sub-folder. This folder is shown in the following screenshot:



The icons on the right-hand side of the Material Library show a preview of the layout of the comic panels. To add one of these to your page, locate the desired Framing template and click on it to select it. The selection will be highlighted in blue. To add the material to your page, click on the Paste selected material to canvas icon at the bottom of the Material Library.

The following screenshot shows the 8 frames with title Framing template added to it:



And this screenshot shows that each panel in the template is in its own empty folder in the Layer palette:





By using the framing templates, we can get to the art creation part of our work without having to set up our panels by hand, streamlining our workflow and saving a lot of time. We can also concentrate more on the art of drawing our comics!

A Framing template can be applied to an entire story file at one time. For instructions on how to do this, see the Adding templates to a new file section of Chapter 2, Preferences, Shortcuts, and Other Commands.

Want to save some time by using a Framing template, but each of your comic pages has a different panel layout? Create a Framing template with one large panel around the inner border of the page and apply it to the story file. Then, use the Divide Frame Folder or Divide Frame Border tools to slice one large panel into smaller panels!
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In this chapter, we covered all manner of comic panel related topics! First, we learned what Frame Border Layers are in Clip Studio Paint. Then, we learned how to create comic panels using the Frame Border tools, and discussed the difference between keeping all the panels on one layer and creating them each in their own folder. We learned how to resize, rotate, and divide existing panels, and also how to use the framing templates in the Materials Library. 

In the next chapter, we are going to start talking about Auto-Actions. Auto-Actions are tools that can help you save a lot of time and effort when creating your digital art. Read on to learn how!
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Auto actions are an amazing feature of digital art. They can simplify your workflow and save you time and effort when creating your drawings.

What are auto actions? Auto actions are sets of recorded steps that can be played back, automating a task or tasks and completing them with the press of a button. 

What sorts of tasks can be made into an auto action? Just about anything that you can dream up! In this chapter, we will cover the following topics.


	The Auto Action palette

	Using Auto Actions

	Creating a custom Auto Action

	Auto Action shortcuts



Let's get started.
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The Auto Action palette can be found by clicking on the Window heading in the File Menu and then clicking on Auto Action. If this menu item is already checked, then the palette is already in the interface somewhere. By default, it is a tab in the Layer palette. 

The following screenshot shows the Auto Action palette:



Let's break down the parts of this palette. The drop-down menu at the top of the palette allows us to switch between different sets of auto actions. The set of actions in the preceding screenshot is the Default set, and comes included in Clip Studio Paint. The icons to the right of the drop-down menu are Create new auto action set and Import auto action set from material. 
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In the main window of the Auto Action palette are the names of the auto actions we can choose from. The small, dark gray triangle to the left of the action's name can be clicked on to view the recorded steps that comprise the action. In the following screenshot, the steps under the Bevel and emboss action are shown:



In the preceding screenshot, you will see that there are two rows of checkboxes on the left-hand side of the palette, next to the names of both the auto actions and the steps that they are comprised of. The first column (the one that has all the boxes checked in the screenshot) controls which steps or which entire actions are able to be played. If the checkbox is empty, then that step or action will not play. The second column of checkboxes indicates whether a step will produce a dialog box where we have to enter information or make a choice. In the screenshot of the Bevel and emboss action, for example, if we click on the second column of checkboxes next to the Hue | Saturation | Luminosity steps, then when these steps come up in the action set when it's played, we will get to set the options ourselves before the action continues.

When we select an action and click on the Play action button at the bottom-right of the palette, or double-click the action name, the action steps will play on the currently active layer or selection. In the following screenshot, the purple layer has had the Bevel and emboss action applied to it, making the purple background rectangle now have a 3D effect around the edges:



Some actions require you to have an active selection made for them to work, instead of just playing on an entire layer. Most of the actions that require an active selection in the Default action set have selected area in the title, so look for these clues when playing actions!

Now that we know the uses of actions and some of the things they can do because of the Default actions, let's create a custom action in the next section. 
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We're going to create a custom action that will set up a new file with rough sketch, final sketch, and ink layers with the press of a button. You can make almost anything into an auto action, whether it's a few button presses or a longer and more complicated series of steps. By following along with the instructions in this section, you'll build the foundation of knowledge you need to start creating your own actions in the future.

Before making an action of your own, complete the steps of the action a few times to make sure that you know the process and can streamline out any unnecessary steps or mistakes in its creation. This pre-planning step can help save a lot of troubleshooting later on!

Actions are sets of menu commands executed on an existing layer or selection. Some settings and commands, such as the brush size, cannot be recorded. If a tool or layer is changed via a palette, this might not be added in the auto action recording.

Follow the steps that follow to complete making this new auto action set and action. You will need to create a new, blank file before completing these steps:


	In the Auto Action palette, click on the Create new auto action set icon to the right of the set drop-down menu. (Note that you can add new actions to the Default folder, but for the sake of organization you can also put your own actions into a new set.) Name the new set Custom when the dialog box appears, and click on OK to finish creating the new set. The Create new set dialog box is shown in the following screenshot below:





 


	While in the new action set, click on the palette menu in the upper-left corner of the palette. In this menu, click on the Add auto action option to create the new action.

	Name the new action by typing into the text entry box. For this example, we are naming our action Layer Set Up, as shown in the following screenshot:






	Now you have the new empty action in your Custom action set, we can begin recording the action steps! Click on the red circle icon at the bottom of the palette, the Start to record auto action icon, to begin logging the steps. Once recording has begun, this circle icon will turn into a square.

	Create a new raster layer, then rename the layer Rough Sketch. Under the Layer Settings, click on the Set as draft layer option.

	Create a new raster layer above the one created in step 5. Rename this layer Final Sketch.

	Create a new raster layer above the one created in step 6. Rename this layer Inks.

	Select the Rough Sketch layer in the Layer Palette to make it the active layer.

	Go back to the Auto Action palette and click on the record button again (it is now a square instead of a circle – a square was commonly used in older technology to mark the stop button!) to stop the recording. The steps beneath the Layer Set Up action should look like the following screenshot:



 


	Open a new canvas and then go to the Auto Action palette. Click on the name of the Layer Set Up action, then click on the triangular Start to play auto action icon in the palette to play the action. 

	If the auto action has recorded correctly, the layer palette of the new page should look like the following screenshot:



 

What steps do you find yourself tediously completing over and over again? Do you get tired of having to manually resize your comic's dimensions before saving it to upload to your website? Do you have a set of steps that you go through a lot to make a special effect? Any process, from the simplest to the most complex, can be made easier with auto actions. Try making some of your own to use in your creation process!
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If you have auto actions that you use all the time, you can assign them to shortcut keys or even add them to the command bar at the top of the Clip Studio Paint interface. 

In the next two sections, we are going to take the Layer Set Up action we created previously and create two shortcuts for it – one keyboard shortcut and one command bar shortcut! This is an easy process and will cut down on the amount of time you spend going through palettes, trying to find the commands that you use most often. Let's look at both of these processes to create easy access to our auto actions.
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Follow these steps to create a keyboard shortcut for an auto action:


	In the File menu, click on File and then click on Shortcut Settings to open the keyboard shortcuts preferences.

	In the Setting area drop-down menu, select the Auto action option.

	Click on the arrow to the left of the action set name to view the actions under that set name. In the following example, we are looking at the actions under the Custom set to find the Layer Set Up action we created earlier:






	Click on the Layer Set Up name to select it. Then, click on the Add Shortcut button.

	On the keyboard, press the key or combination of keys you'd like to use for the shortcut. In this set of instructions, we are going to use the Ctrl + F1 combination of keys to activate our auto action. This shortcut now shows next to the Layer Set Up auto action's name in the following screenshot: 






	To edit the existing shortcut to something else, click on Edit Shortcut and choose a new shortcut. 

	To add another shortcut to the same auto action, click on the Add shortcut button and press another key or combination of keys to set a second shortcut.

	To delete a shortcut, select the shortcut and then click on the Delete shortcut button.

	When finished setting shortcuts, click on the OK button to exit the Shortcut Settings.



Now, when you hold down the Ctrl button and press F1 on the keyboard, your Layer Set Up action will play.
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To add a shortcut icon to the command bar, follow these steps:


	In the File menu, click on File and then on Command Bar Settings to bring up the Command Bar Settings menu.

	In the drop-down menu at the top of the settings menu, select the Auto Action option to view the auto actions.




	Click on the triangle next to the action set to view the names of the auto actions beneath that set. In the following screenshot, we are looking in the Custom set for the Layer Set Up action:






	With the name of the auto action selected, click on the Add button.

	The shortcut icon will now show in the command bar, as shown in the following screenshot: 







Now, you can click on the icon in the command bar to run the Layer Set Up action without having to select it from the palette. 
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In this chapter, we learned how to make tedious activities more bearable by using recorded auto actions to automate their steps. We looked at the Auto Action palette and learned how to play default actions. We learned how to create a new Action Set, and then how to create a new action and record the steps for it. Finally, we learned how to create two different shortcuts to an auto action in order to make accessing it easier.

In the next chapter, we are going to start getting into an art creation process called inking. We will discuss the principles of inking, how to use inking tools, inking on vector layers, and how to modify clean pencils to simulate ink. Join me there to learn more about inking!
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Back in the early days of comics, pencil lines were too light to be picked up by the cameras used to replicate comic art. So, artists used brush or pen and black ink to render over the pencil lines and make them dark enough for the cameras to pick up. Inking has become an art in and of itself. Clip Studio Paint has some of the best inking tools in the digital art world, packaged with it when you purchase the software. There are also a multitude of third-party inking tools available for either free or purchase that provide specialty inking tools that give different looks and feels to inked lines. 

In this chapter, we are going to talk about the following topics:


	Principles of inking

	Inking tools

	Inking on Vector layers

	Modifying the Pencil layer to simulate inks



Let's get started!
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Inking in the world of non-digital tools is the process of using pens or brushes and black India ink to finalize pencil lines and make them ready for toning or coloring. The printing presses back in the early days of comics weren't capable of printing grayscale, so dark black ink lines were needed to reproduce the comic art. 

In the digital world, we aren't restricted to simply black ink for our lines, and we have a multitude of tools we can use to make our finalized lines. There is an art to good inking that we should discuss briefly. 

For more detailed information on inking techniques for comics, I recommend Pen and Ink by Comikers, and How to Draw Noir Comics: The Art and Technique of Visual Storytelling by Shawn Martinbrough. 

Inking is the art of taking a rough pencil sketch and providing finalized edges, volume, and a sense of light and shadow. To see this process in action, let's take a look at a comic cover from sketch to final colors and examine how the inked lines accentuate the mood of the piece.

The following screenshot shows our comic's two main characters in their finalized pencil forms (note that the finalized pencil lines have been turned blue using the Layer Color settings to make inking easier; we'll talk about this more in a few minutes):



As you can see, my sketches are usually pretty rough! I love to ink and my sketches are almost always loose and rough because I finalize the art when I do the inked lines. 

Now that we have our final sketch laid out, we need to think about where the light is coming from in this scene. In a well-inked piece, the colorist should be able to tell where the light is coming from without being told because of the way that the inks are done. In the following inked version of the previous drawing, can you tell where the light source is?



If you're having trouble, look at the thickness of the lines in comparison to each other. Did you get it yet? 

In the following screenshot, the light source for the finished piece is indicated by the arrows. 



Ink lines closer to the light source are thinner than the ones further away. This is a thing we call Line weight, and it's pretty fun to play around with! Line weight can give your drawings added dimension without even having to add color, and can also help to show what objects are closer to the foreground and which are further away. We'll talk about that in a minute, but before that let's look at this cover art in full color in the following screenshot:



Now, we can see how the color accents the inked work. The areas that had the darkest, thickest lines are in shadow, while the lighter and thinner lines are in the highlighted areas. 

Line weight can also indicate which elements are in the foreground and which are further away. For an example of how this can be used, let's look at the panel in the following screenshot:



The human character is very close to the camera (or the reader, if you prefer that terminology), and the little sitting robot is some distance behind him. This is shown not only by the composition of the frame, but also by using thicker lines on the human character and thinner ones in the background. This mimics atmospheric perspective, a principal of art where objects in the distance get less saturated and less detailed. 

Let's take a look at another example of this atmospheric perspective mimicked with ink lines in the following screenshot.



Note the thinner lines at the top of the central figure to indicate the direction of the light. The ink lines in the background elements get thinner and less detailed as the fences recede toward the horizon line. 

Of course, there are lots of ways to do inking. Many inkers use spot blacks to indicate deep shadows. Feathering, hatching, and cross-hatching can be used to add shading, detail, and texture. And there are even styles of art that use inks with no line weight, a style called ligne claire, or clear line. Inking is as individual as each artist's style and if you're new to it, it may take a while to develop your own style. The key is to keep practicing!

Now that we know some of the principles of inking, let's explore some of the inking tools in Clip Studio Paint.
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Clip Studio Paint has a variety of tools for inking, and thanks to the customizable brush engine we can also modify tools in order to better suit our needs. For the experienced inker, there are tools that mimic traditional inking tools, such as the G-pen, Turnip pen, Calligraphy pen, and Technical pen. There are also a variety of marker tools that can be used for inking as well.

This is all well and good for the inker who uses pens, but what about the traditional inker moving into digital who uses a brush? The G-pen default tool is pretty good as a substitute for a real brush and ink experience because of its pressure sensitivity settings.

I have a lot of people ask what inking tools I use. Personally, I use several inking tools from third-party designers who I love! These two Clip Studio artists make great and high-quality tools to serve a variety of needs, and since they are ready-made tools that suit my needs and feel great when I use them, I don't need to make a custom tool for myself. These two creators are Ray Frenden of www.frenden.com and Brian Allen of www.flylanddesigns.com. Both of these sellers, at the time of this writing, have many tools available to purchase for Clip Studio Paint at reasonable prices.

But if you don't want to pay for a tool, you can always make one that suits your needs and style! The right "feeling" tool will vary for every artist because every artist is different and wants a different look from their tools. 

Having trouble getting smooth looking inks? Ink while zoomed in! I find that zooming in to a 300 dpi or larger image at 250% and inking is the best for me. The lines look a little shaky when I'm zoomed in, but upon zooming back out the lines look smooth and crisp!

Let's briefly discuss each of the categories of tools that we can use to ink in Clip Studio Paint.
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From Micron pens to the basic Sharpie, most artists have used marker tools on paper to ink their work at some point in their lives. In Clip Studio, Marker tools are characterized as having a set line width, meaning that they don't get thicker or thinner no matter how light or hard we press with the stylus.

Even though these tools give us a line with no variation to the width, they are still valuable in some inking situations. For instance, backgrounds (especially background elements that are far in the distance and therefore have thin lines and less detail), machines, and other inorganic objects look great when inked with a line that has less variation. Despite not getting thicker and thinner as we press, we can always change the size of the marker tip to get some variation in our lines by making them thicker or thinner manually, instead of with pressure. 

The marker tools can be found under the Pen category, and they are a tab of sub-tools under that category. Here is a screenshot of the Marker tools in the Sub tool palette:
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Pen tools are the primary tools for inking, both in the digital and the analog art worlds. With a bit of practice, we can ink anything with pen tools. Pen tools in Clip Studio Paint have pressure sensitivity, allowing us to make thick and thin lines depending on how hard we press with the stylus.

Having issues with your tools in Clip Studio Paint? Go to the website of your tablet brand and make sure that you have the most up-to-date drivers for your model of tablet installed. Some of the most common software issues are just problems with outdated drivers. Make sure to have a backup of the previous drivers too, just in case there's a bug in the newest drivers!

For the traditional artist switching to digital who inks with brush or nib pens, the pen tools in Clip Studio Paint are going to give you the most familiar feel to your inking, especially if you have a tablet stylus with a changeable nib. Wacom brand tablets usually have different tips that can be put into the stylus to give a different feel against the tablet, whether it be extra friction to make the experience more like working on paper, or a spring-loaded nib that gives the squishy feel of a brush or nib. So, if you have one of these tablets with a nib that can be changed, be sure to experiment with it! Also, you'll want to make sure you have a few extra nibs on hand, because nibs can and will wear out over time and need to be replaced. You don't want to have a stubby nib and no fresh one when there's a deadline coming up!

The following screenshot shows the Pen tool category in the Sub Tool palette:



If you find your hand sticking to your tablet (or smudging your tablet, for those with screens or working on Tablet PCs), you'll want to get a smudge guard! These gloves go on your dominant hand and are fingerless except for the pinkie and ring fingers, which have fabric to keep your skin from contacting the tablet. You can make one yourself by getting a cheap pair of gloves and cutting off the thumb, pointer, and middle fingers, or you can buy one. I like the ones from www.dokiwear.com but another popular brand is from www.smudgeguard.com as well. 

We can customize our inking tools in many ways, but one of the easiest ways to start making tools your own is to change the pressure sensitivity settings. In the next section, we will duplicate an existing tool and adjust its settings to make our own custom inking tool.
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We're going to create a sensitive pen that will give us thin lines, but also get thick rather quickly. Follow these steps to complete this exercise:


	Select the G-pen tool from the Pen Sub Tool palette.

	Click on the Create copy of currently selected sub tool icon at the bottom right of the Sub Tool palette to make a copy of the G-pen tool.

	Name the new tool with a name of your choice. In the following screenshot, we are naming the tool Responsive Pen:






	Click on OK to complete making the tool copy. 

	In the Tool Property palette, click on the wrench icon to open the Sub Tool Detail window. 

	Change the Brush Size to 8.0.

	Click on the button to the far right of the Brush Size option to open the Brush Size Effect source settings options. 




	Ensure that the checkbox next to Pen pressure is checked. The Brush Size Effect window should look like the following screenshot: 






	The Minimum value slider controls how small our pen can get. It is set to 0, indicating that if we use light enough pressure we can create a break in the line. You can change this slider to a different minimum value if you want to make a tool that always gives lines of at least some thickness. 

	The curve graph at the bottom marked Settings of pen pressure controls how quickly the pen goes from 0% to 100% as we increase the pressure on the stylus. We are going to make this from the gentle curve it currently is into an S-curve. To do that, click on the curved line to add a second control point. Then, adjust the purple handles in order to make a shape like the one in the following screenshot: 






	Test out the pen on a new canvas. Press lightly and then press harder as you make strokes. Experiment with making lines slowly and quickly. Adjust the curve settings as needed until you like the feel of the new pen tool.

	If your tablet supports Tilt settings, you can also experiment with these settings by enabling the checkbox next to the Tilt option in the Brush Size Effect source settings window and adjusting them in the same way as we did for the pen pressure.

	The more control points you add to the curve, the more erratic the pen will behave. Experiment with the settings until you get the results you like! 

	When you have finished adjusting the settings, close the Sub Tool Detail palette. You are now ready to use your new pen on your drawings!





            

            
        
    
        

                            
                    Inking on vector layers

                
            
            
                
For the beginning inker, inking on a vector layer is very forgiving because of the editable nature of vector lines. (For more information on vector lines, see Chapter 8, Vector Layers and the Material Palette.) If you are just starting out with inking, or if you want to be able to draw an inked line once and then tweak it until it's perfect, inking on a vector layer is going to be perfect for your needs! However, beginner inkers, remember that in the digital realm, even ink can be erased, and the Undo button will forgive most sins. So long as you remember to begin inking on a layer separate from your sketch, you will be able to erase and tweak your lines no matter if you go with raster or vector inks.

For an example of how we can tweak ink lines on vector layers, let's take a look at the following screenshot, which has lines we made with a pen tool and hasn't had any vector adjustments made yet:



Note that some of the lines are shaky and lack the smoothness of a confident inking hand in the previous example. After we use the Simplify Vector Line tool and the Correct Line Width tool on the lines, we can end up with the smoother and more elegant lines of the following screenshot:



Whether you ink on raster or vector layers is, of course, up to you and your preferences. The more that you practice with inking, the better you will become!
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Now that we have some foundational knowledge of inking and of inking tools in Clip Studio Paint, let's talk about inking a comic page. These are some general tips, of course, because we could write an entire book about just inking comics (and entire books have, in fact, been written about this!). But for those just starting out, here are some general tips that make the inking process a little easier:


	Start with the panels that you're most excited about inking. In traditional inking, we would start from the opposite corner of our dominant hand and ink diagonally across the page and down to avoid smearing drying ink, but with digital inks, we don't have to worry about that. Start with whatever panels you wish to ink first and move around the page as you like.

	Remember to turn on the Layer Color option on any pencil layers before beginning to ink. This ensures that we can easily see where we've inked already and any lines we may have missed, and keeps us from inking on the wrong layer and having to start all over again. 




	Ink on separate layers for characters and backgrounds, or foreground and background. I like to separate my characters from the backgrounds and then apply layer masks as needed. This not only allows me to adjust the position of characters or of background elements easier but also ensures that backgrounds can be reused in other panels if needed.

	Use the eraser tools or the transparent color to correct your mistakes. Remember that digital ink isn't permanent! We can adjust it, delete the ink layer and start over, or add textures using erasers or tools set to the transparency option. 



If you really want to improve your inking, there are hundreds of resources on the internet where artists post their penciled work for others to ink and/or color. Make sure that you have the permission of the original artist to use this work, and that you give credit and a link to the artist's website if you post your inked version somewhere! Practice is the best way to improve and to find your own style.
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So, you've been trying hard to improve your inks but you just hate the process. I know many artists who love the pencil process and love to color, but they absolutely despise inking. (I'm not one of those artists; inking is my favorite part of the drawing process! But I know that makes me a little weird!) If you are one of the artists who just can't get the hang of inking, you can modify your pencils to get an inked look without having to go over the pencil sketch again. 

Depending on your style of art, this modified pencil method may work best if your pencils are "tight." This means that they are very clean, smooth, and defined. My own finished pencils are very loose and sketchy—because I love to ink so I don't spend a lot of time on pencils unless I really need to—but if you have a looser style like me you can still use this easy technique! The important thing is to get the style that you want for your project. If a looser line that is less refined fits with your goals for your project, then don't be afraid to use it!

In the following steps, we are going to use duplicated layers to get an inked look to the pencils, shown in the following screenshot:




	Select the pencil's layer of your image. Note that the pencils MUST be on their own layer for this technique. The layer should have only pencils and transparency, no paper color or other fills.

	In the Layer palette, click and hold the mouse button on the pencil's layer, and drag the layer down to the New Raster Layer icon. 

	Release the mouse button over the icon to duplicate the pencil layer. (You can also click on the Layer option in the File menu and click on the Duplicate Layer option to make a copy of the layer as well.)




	Now that the pencil layer is duplicated, the pencil lines should appear darker and sharper as a result of the two layers sitting on top of each other. Compare the following image with the screenshot before these instructions to see the difference: 






	If desired, continue to duplicate and stack the pencil layer to darken the lines. The following screenshot is made of three copies of the pencil layer stacked on top of each other to produce a dark and defined line that looks like it's been produced with the pen tool:
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In this chapter, we covered the reasons for inking and some basic principles for making clear and dynamic inked lines. We explored the marker and pen tools, two of our workhorses for making inks in Clip Studio Paint, and learned how to adjust the pressure settings in the Pen tools to customize our tools. We talked about inking on vector layers and the benefits of doing so. We also went over some inking tips specific to creating comic panels, and learned how to duplicate layers to simulate inks from pencil lines.

In the next chapter, we will discuss how to ink some special effects. We will also make a brush with custom brush tips to produce a special effect. 
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Sometimes inking requires us to solve a set of questions relating to how to render something out. How can we make a textured grungy look? How can we use the digital space to make repetitive inking tasks easier? 

Really getting familiar with the other drawing tools and how to customize them is the best way to maximize your time. When you have a core understanding of how to create tools, you can make specialty ones that solve problems and speed up your workflow. Some people who don't understand digital art refer to this as cheating because they think that the software is doing the work for you. However, making custom tools that can create a grungy effect, or make lightning, or even create a crowd scene for us is no more cheating than using a ruler or a compass on a piece of paper. It is merely making the most use of your tools and finding solutions to the unique challenges you face as an artist.

In this chapter, we will build a foundation that will allow you to create your own custom tools. Each exercise is designed to build on the skills learned in the previous one to take you through the different options in the brush engine. The following topics will be covered in this chapter:


	Creating a textured inking brush

	Making a broken glass shard brush

	Creating a foliage brush

	Texture with a cross-hatching brush



Let's get going right away! 



            

            
        
    
        

                            
                    Creating a textured inking brush

                
            
            
                
This exercise will get us familiar with creating and saving a custom brush tip, and adjusting some of the brush tip settings in the Sub Tool Detail palette. Complete the following steps to make this textured inking brush:


	On a new canvas, create a new raster layer. Make sure that the Color Expression is set to Gray.

	Select the Airbrush tool and the Droplet sub tool. On the gray layer, make a circular shape with the Droplet tool, using pure black as the active color. Don't make this too precise, we want some variation to it. Your shape should look something like the following screenshot:








	Turn off any layers, other than the one with the shape we created in step two. This includes any paper layers! We only want to see our new brush tip shape before completing the next step. 

	In the File Menu, click on Edit - Register Material(J) | Image... This path is shown in the following screenshot:



 


	This will bring up the Material property window. Enter a Material name that is descriptive and unique. The Material image shows us a preview of the shape we are saving. Check this to ensure that there is nothing else showing that we don't desire to have in our brush shape. Click on the checkbox next to Use for brush tip shape. Then select the Brush sub-folder under the Image material folder to store the material in. Finally, enter a few tags by clicking on the + icon at the bottom of the Search tag window. This will allow us to search for our material easily when we go to make our tool. Your Material property window should look like the following screenshot:






	Click OK in the Material property window once all the parameters are set. This saves our new material.

	Using the instructions from Chapter 14, Inking Tools, create a copy of the G-pen tool. Name this new tool Textured Inking.

	Use the Wrench icon to open the Sub Tool Detail palette. 

	Click on the Brush Tip category on the left side of the Sub Tool Detail palette. 

	Next to Tip Shape, click on the button marked Material. The box beneath Tip Shape will now say Click here to add tip shape. Click in this box to bring up the Select brush tip shape window.




	In the Select brush tip shape window, locate the brush tip we made at the beginning of this exercise. Click on it to select it, as shown in the following image: 






	Click OK to confirm the tip shape. This will take us back to the Sub Tool Detail palette.




	While still in the Brush tip options, click on the button to the far right of the Thickness option. Check the Random box to turn on this parameter, as shown in the following screenshot: 








	Repeat step 13 for the Direction option as well, as shown in the following screenshot: 






	Test your new textured inking brush!



This textured inking brush will give you results like the ones pictured in the following image:



Note how the textured, rough lines add to the threatening mood of the character! This is not a face you want to ink with a smooth, clean line, after all!

In the next section, we will create a brush that will help us create a more complex effect.



            

            
        
    
        

                            
                    Making a broken glass shard brush

                
            
            
                
By utilizing the features of Clip Studio Paint, we can save time with a brush that will make a tedious special effect into a simple matter. We will create a brush that will make shards of broken glass rain down on our images.

Follow these steps to create this brush:


	Open a blank canvas, preferably at least 300 dpi. You do not need to use the Paper option in this canvas, in fact, we want a transparent background.

	Using your preferred drawing tools on an empty layer, draw the outline of several jagged, broken glass shapes. Use black or dark gray for the outlines. 




	Create a new layer behind the outline layer. On this layer, fill the glass shapes with solid white. 

	Lower the opacity of the white layer to 50% by using the slider at the top right of the Layer palette.

	Merge the outline layer with the 50% transparent white layer by clicking on Layer in the File Menu and clicking on Combine showing layer. (Note, this will combine down any layers that are currently visible, so make sure that your only visible layers are the glass shard outlines, and the 50% white fill.) You should have a transparent background and your canvas should now look something like the following screenshot:






	In the File Menu, click on Edit - Register Material(J) - Image... This path is shown in the following screenshot:






	This will bring up the Material Property window. Enter a Material Name that is descriptive and unique. The Material Image shows us a preview of the shape we are saving. Check this to ensure that there is nothing else showing that we don't desire to have in our brush shape. Click on the checkbox next to Use for brush tip shape. Then select the Brush sub-folder under the Image material folder to store the material in. Finally, enter a few tags by clicking on the + icon at the bottom of the Search tag window. This will allow us to search for our material easily when we go to make our tool. 

	Click OK in the Material Property window once all the parameters are set. This saves our new material.

	Duplicate the G-pen as we have done in previous sections. Name the new sub tool Broken Glass. Click OK.

	In the Tool Property palette, click on the Wrench icon in the lower right corner to open the Sub Tool Detail screen. 

	Change the Brush Size to 60.0. Open the Brush SizeEffect source settings to set the Minimum value to 15 and edit the curve to look like the one in the following screenshot:



 


	Set the Anti-aliasing to Middle.

	Click on Brush tip in the Sub Tool Detail palette.

	Click on the Material button under the Tip Shape option. The box beneath Tip Shape will now say Click here to add tip shape. Click in this box to bring up the Select brush tip shape window.

	Locate the glass shards shapes we made at the beginning of this exercise. Highlight them in the Select brush tip shape window, as shown in the following screenshot, and click OK:



 


	In the Brush tip settings, click on the icon to the right of the Thickness option. Check the box next to the Random option, and set the minimum value to 65.

	Click on the icon to the right of the Direction option. Check the box next to the Random option and set Degree of effect to 100.

	In the Sub Tool Detail window, click on the Stroke category. 

	Set the Gap option to Fixed by clicking on the first icon (the one with one full circle in the center of it). 

	Use the slider under the Gap option to set the value to 150.0.

	Set Repeat method to Random. 

	Test your new brush!



The brush will give us the effect shown in the following image: 



By changing the Thickness, Direction, and Repeat method options to Random, we get a random rotation and direction of the glass shard shapes as we use the brush. By changing the Gap option, we make the brush tip shapes show up far apart from each other, instead of in a continuous stroke, like other drawing tools. 
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I don't think it's any secret that the foliage brush is one of my favorite specialty brushes ever created. This brush makes drawing detailed trees and bushes easier, and it introduces us to the Ribbon options in the brush details. 

In the following set of steps, we will create a leafy material, and then make it into a brush that rolls out like a spool of ribbon:


	Open a new blank canvas with at least 300dpi resolution.

	Using an inking pen, draw a row of leaves similar to the top of a tree or bush. 

	Fill the leaves with white. Use the following screenshot as a guide to create your leaves and the white fill. Take note that the colored area around the outside of the brush tip shape is just to show the shape of the white fill—you will want to have a transparent background as we have had in the previous sections of this chapter. 






	In the File Menu, click on Edit - Register Material(J) | Image... This path is shown in the following screenshot: 






	This will bring up the Material Property window. Enter a Material Name that is descriptive and unique. The Material Image shows us a preview of the shape we are saving. Check this to ensure that there is nothing else showing that we don't desire to have in our brush shape. Click on the checkbox next to Use for brush tip shape. Then select the Brush sub-folder under the Image material folder to store the material in. Finally, enter a few tags by clicking on the + icon at the bottom of the Search tag window. This will allow us to search for our material easily when we go to make our tool. Your Material Property window should look similar to the following screenshot:






	Click OK in the Material Property window once all the parameters are set. This saves our new material.

	Make a copy of the G-pen, as we have in other sections of this chapter. Name this new tool Foliage.

	In the Tool Property palette, click on the Wrench icon in the bottom right corner to open the Sub Tool Detail palette.

	Click on the Ink category of settings and ensure that the Opacity is set to 100 and the Combine mode is Normal.

	Click on Anti-aliasing in the left side of the Sub Tool Detail palette. The Anti-aliasing should be set to None.




	Click on Brush tip in the Sub Tool Detail palette.

	Click on the Material button under the Tip Shape option. The box beneath Tip Shape will now say Click here to add tip shape. Click in this box to bring up the Select brush tip shape window.

	Locate your leafy shape and click on it to select it. Click OK to load this material into the brush. 

	Set Thickness to 100.

	In the following screenshot, the leaf material is loading vertically instead of horizontally, which is not what we want:



 


	To change the orientation of the material shape, change the value of the Direction from 0.0 to 100. This should rotate the material to horizontal, as shown in the following screenshot:



 


	Click on the icon to the right of the Direction settings to open the Direction Effect Source Settings. Deselect the box next to the Random option. 

	Click on Stroke on the left side of the Sub Tool Detail screen. Click on the checkbox next to the Ribbon option to activate it. 

	Test out your new brush.



This brush works best when it's used in layers. To understand what I mean, let's look at the process of creating a tree using this tool.

After sketching the trunk of the tree and the general shape of the leaves at the top, use the brush to go around the outline of the top. Work in a clockwise direction to ensure that the bottom leaves are in the correct orientation. Look at the following screenshot and note the direction of the arrows. This is the direction we are working in:



Not bad, but it could look better! By continuing to work in the same clockwise direction, but slightly inside of the already existing leaves, we can make more layers of foliage. Continue going around and around to add more layers, and fill in the inside of the tree, as shown in the following screenshot:



Finally, fill the empty space in the middle by continuing to work in smaller and smaller circles. The following screenshot shows the tree top all filled in, using nothing but our new brush:



By using the Ribbon setting, we get a brush that repeats in a pattern, unrolling like a pattern printed on a tape. This is also what allows us to get the pattern to go upside down to make the bottom leaves without having to create a second brush with the brush tip material upside down. Layering the leaves gives us a detailed and lively finished product!

By using the Ribbon option, and playing with the Repeat method, we can make brushes that simulate patterned fabric trim, lace, ruffles, knit patterns, and even shoelaces! In Chapter 19, The Clip Studio App and Getting Animated, we will learn how to access the Clip Studio Paint assets download library, where you can get more ideas for custom tools to make, or download tools made by other users.
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Hatching is a shading technique achieved using groups of parallel lines. Cross-hatching is a group of parallel lines that cross the first group in another direction, adding texture and the appearance of darker shading. Hatching and cross-hatching can add a lovely look of depth and texture to monochromatic illustrations. By making a hatching brush, we can achieve this look without the tedium of having to make all the lines by hand.

When creating your new canvas to draw your brush tip, make sure that the Basic expression color is set to Gray instead of Color. The following screenshot shows the drop-down menu in the new file creation window where this change can be made: 



The following steps will walk you through the brush creation process:


	Select the Figure tool category and then the Ruler sub tool category.

	Select the Special ruler from the Sub Tool palette.

	In the Tool property palette, choose Parallel line from the Special ruler drop-down menu, as shown in the following screenshot:



 


	Click inside the canvas and hold down the mouse button or stylus. While still holding, drag the cursor across the canvas at an angle. Release the mouse button to set the ruler.

	Select your preferred pen tool from the Pen sub tools.




	Ensure that the Snap to Special Ruler option in the main command bar above the canvas is active. This will make the pen follow the parallel line ruler. Refer to the following screenshot for the location of this icon:






	Using your preferred pen tool, draw a group of parallel lines, as shown in the following image:






	Turn off or delete any Paper color layers or any fill layers behind the parallel line layer, leaving only the group of lines and a transparent background. 

	Before we can set the new brush tip material, we must clear the parallel line ruler. To do this, select the Object sub tool from the Operation category of tools. Click on the ruler to select it. Then click on Edit - Clear from the File Menu. (You can also right-click and select Clear from the pop-up menu.)

	In the File Menu, click on Edit - Register Material(J) | Image... This path is shown in the following screenshot:






	This will bring up the Material Property window. Enter a Material Name that is descriptive and unique. The Material Image shows us a preview of the shape we are saving. Check this to ensure that there is nothing else showing that we don't desire to have in our brush shape. Click on the checkbox next to Use for brush tip shape. Then select the Brush sub-folder under the Image material folder to store the material in. Finally, enter a few tags by clicking on the + icon at the bottom of the Search tag window. This will allow us to search for our material easily when we go to make our tool. Your Material Property window should look similar to the following screenshot: 






	Click OK to register the material.

	Copy the G-pen, as we have in the other sections of this chapter. Name this new tool cross-hatching. 

	In the Tool Property palette, click on the Wrench icon in the bottom-right corner to open the Sub Tool Detail palette. 

	Click on the Brush Tip option.

	Click on the Material button under the Tip Shape option. The box beneath Tip Shape will now say Click here to add tip shape. Click in this box to bring up the Select brush tip shape window.

	Search for and select the brush tip shape created earlier in this section.




	Click on the icon to the right of the Direction settings to open the Direction Effect Source Settings. Click on the radio button next to Direction of line to activate this option. This option will set the direction of the brush tip material, depending on the direction we move the stylus to make our line, allowing us to overlap the hatching to get cross hatching lines.

	Under the Stroke category of options, set the Gap to Fixed. 

	Test your new tool!



The following drawing was shaded using a combination of gray fill for the skin, screentones for the bulk of the hair, and our new cross-hatching brush to add additional texture and shading:



Because we created the brush material in a Gray color mode canvas, it means that we can set the color of the brush as needed. This can be seen in the preceding image as the white highlight cross-hatching on the right side of the face, the hair, and the tops of the arms. 
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This chapter has given us a foundation for making our own custom tools, and with this knowledge, you should be able to make nearly any special brush that you can dream up! We learned how to make and save our own custom materials that can be used as brush tips. We created a grittily textured inking brush, and learned how to set the Source Effect settings to get the look we wanted. We made a glass shard brush that utilized opacity and random direction to give us a look of hundreds of hand-inked glass shards in an illustration. Then, we used the Ribbon options to create a foliage brush. Finally, we used the parallel line ruler to create a brush tip material, and then the Direction of line brush option to create a layering cross-hatching brush. 

Now, we're going to start getting into coloring your comic! In the next chapter, we will begin talking about the different ways to make color palettes in Clip Studio Paint, and also how to use the eyedropper and Sub view palette to select colors. 
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Just like in painting, we can make color palettes in Clip Studio Paint. These palettes are digital values of color that we can save, import, export, and access in different ways to make color schemes and automatically mix colors. 

The following topics will be covered in this chapter:


	The Color Pickers

	Color History, Intermediate and Approximate Color Palettes

	Importing palettes from Adobe Photoshop

	Creating Color Palettes from the Sub View Palette



Let's jump into the wonderful world of color!
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There are lots of ways to choose colors in Clip Studio Paint, but the three that are most used are the Color Wheel, the Color Slider, and the Color Set palettes. Each palette gives us a different way to make just about any color we can imagine to use in our digital illustrations and comics. Let's take a look at each of these palettes and how to use them to pick colors. 
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The Color Wheel is probably the most used method for choosing colors in the digital realm. The Color Wheel Palette has two modes, HLS mode and HSV mode:


	HLS mode: Stands for Hue, Luminosity, Saturation. Hue is the name of the color, Luminosity is the brightness of the color, and Saturation is how much of the pure color is in the mix. Colors get grayer the less saturated they are.




	HSV mode: Stands for Hue, Saturation, Value. Hue is the name of the color, Saturation is how much of the pure color is in the mix (colors get grayer the less saturated they are), and Value is how much white or black has been added to the color to make the new color.



The following screenshot shows the HLS mode of the Color Wheel Palette:



The outer ring of colors controls the hue. The triangle inside of the circle shows the pure hue (chosen from the outer circle) in the point at the right. As we move up and to the left, the color becomes lighter and closer to pure white. As we move down and to the left, the color become darker and closer to pure black. By clicking inside of the triangle, we can choose any saturation or luminosity of the currently chosen hue.

The bottom-left corner of the palette shows our currently selected foreground and background colors, as well as our transparent swatch. We can quickly select to use the foreground or background color from this palette, or in the primary toolbar in the user interface. 

Along the bottom edge of the palette, we can see the number values of the currently selected color in Hue, Luminosity, and Saturation, marked H, L, and S, respectively. In the previous screenshot, the Hue value is 0, the Luminosity value is 38, and the Saturation value is 54. 

Knowing these number values can help you to match the colors that you use even if you switch to other graphics software. By clicking on the area with the number values, the options can be changed from Hue, Luminosity, and Saturation to the Red, Green, and Blue values instead.

The icon in the bottom right of the palette switches our Color Wheel to the HSV mode, which is shown here:



Like the HLS mode, we can choose the hue by clicking along the outer ring in the palette. The upper-right corner of the square shows the pure hue. By moving toward the lower-right corner, the color becomes darker and closer to black. The top-left corner is pure white, and choosing a color close to it makes the color lighter in value. Going toward the lower-right corner makes the color less saturated (grayer) and closer to black. 

The numbers under the color picker show the H, S, and V values of the currently selected color. 
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The next tab in the color palette is the Color Slider palette. It is shown in the following screenshot:



The tabs along the left edge of the Color Slider palette allow us to choose between different ways to select our color. The one shown in the previous screenshot is the RGB (Red, Green, Blue) mode. Each slider in this mode controls a different amount of color. The top slider controls the amount of red in the current color, the middle slider controls the amount of green, and the bottom slider controls the amount of blue. The swatches along the bottom of the palette window are the current foreground and background colors, as well as our trusty transparent swatch.

The second tab in this palette is the HSV mode, which is the same as the HSV mode from the Color Wheel, but instead of a wheel and square, we have sliders to control each individual aspect of the color selection.

The final tab in the color slider palette is the CMYK selection. CMYK stands for "Cyan, Magenta, Yellow, Black" and these are the colors used in printing color images on paper. Although we cannot set our document to be CMYK mode, we can choose colors based on CMYK values using these color sliders to control the amount of each color present. 

The color sliders are very useful when trying to precisely match a color, say from a logo or used in a website design. If you know the number values of the color, you can precisely enter them in, using one of the tabs in the Color Slider palette.
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The Color Set palette is shown here:



If you are a Photoshop user switching to Clip Studio Paint and you've ever used the Color Swatches, this palette will look familiar to you!

The Color Sets are pre-made swatches of color that you can click on to select. We can use these to select a color close to what we want and then tweak it to the exact shade we want using the Color Wheel or color sliders, or just use the color sets as they are. 

The drop-down menu at the top of the color sets palette allows us to choose between different sets of colors. The set shown in the previous screenshot is the Default Color Set. Our own custom color sets can be created as well so that we can save colors we use often, say for the main characters in a comic project. 

Follow these steps to create a custom color set:


	Click on the wrench icon to the right of the drop-down menu at the top of the color set palette.

	The window pictured next will appear: 






	Click on Add new settings in the Edit Color set window. Type a name for the new color set and then click on OK.

	A new color set made of transparent squares will now show in the Color Set palette. In order to add colors to the set, first click on the transparent square where you'd like to place the new color. Then, use one of the Color Pickers to set the color to save as the currently active foreground color.

	In the Color Set palette, click on the Replace Color icon in the lower-right corner of the palette. The foreground color will replace the transparent square.

	To add a color in a new square instead of replacing the currently selected one, click on the Add color icon. 



Now, let's take a look at some of the other tabs in the color palette and learn how they can help us add color to our illustrations.
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Color History, Intermediate Color, and Approximate Color are all palettes located within the Clip Studio Paint interface. Color History allows us to keep track of colors that we've already used in our art, and the Intermediate and Approximate Color Palettes allow us to mix colors in different ways. In this section, we will explore each of these palettes and learn how to use them. 
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Have you ever painted and required a color you were using a while ago, but it's so blended in with the colors around it that it's impossible to get the pure color any more? The Color History palette is the answer to your prayers, and it's easy to use to boot!

Before opening the Color History palette, open a blank document and select a brush or pen tool. Choose a color and scribble on the open canvas. Do this a few more times with several other colors. Before the color history palette can show us anything, we need to have some colors used on our page so that we have a history built up. The use of the color can be a simple click of the mouse or a stroke of the stylus, so long as it was used.

Now that we have used a few colors on the canvas, open the Color History palette by clicking on Window - Color History in the File menu, or by clicking on the Color History tab in the color palette. The Color History palette is shown in the following screenshot:



The palette will show any colors recently used. Click on the square of the required color to make it active again. 

To save the colors from the history palette, click on the icon in the top-left corner of the palette, then click on Register to color set palette to save the color swatches. To clear the color history, click on the icon in the top-left corner and select Clear color history. This will reset the palette and start the color history over again.

The Color History is such a simple little palette without a lot of options, but for a digital painter it can be a powerful tool and make it much easier to keep consistent colors across an entire piece.
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The Intermediate Color Palette allows us to create a harmonious combination of colors to use in our illustration and comics. By allowing Clip Studio Paint to do the mixing, we can easily create a color scheme that works together.

The steps that we will follow to learn how to use this palette work best if you can see the Intermediate Color Palette and the Color Wheel or Color Sets at the same time. This is impossible when the palettes are nestled together, as they are in the default user interface for Clip Studio Paint. We will need to pop out one of the palettes so that we can see them both at the same time.

To pop out the Intermediate Color palette, locate it in the tabs nestled within the color palette. Click on the tab at the top of the palette where the name of the palette is showing. With the mouse button still held down, drag the Intermediate Color tab out of the color palette. The following screenshot shows the palette in the middle of being dragged out into the canvas view area:



When you have moved the Intermediate Color palette out of the main color palette area, release the mouse button. You should now be able to see the Intermediate Color palette and the Color Wheel or Color Set palette side by side, as shown here:



Once you have these palettes next to each other, follow these steps to create a color scheme that works together using the Intermediate Color palette:


	Choose a color from the Color Wheel, Color Set, or Color Slider palette windows. This can be any color you wish to use in your color scheme. 

	With your chosen color as the currently active color, move the cursor over the large square in the top left of the Intermediate Color palette. The cursor will become a paint bucket icon over the square. Click to add the color to the corner box. 

	Repeat steps 1-2 for any other colors in your color scheme, adding the new colors to the other corner boxes. In the following screenshot, we have used green in the upper-left corner, red-orange in the upper-right, blue in the lower-left corner, and black in the lower-right corner:



 


	Use the cursor to select colors from the small square color swatches in the center of the Intermediate Color palette to color your image with.



As we add colors to the corners of the Intermediate Color palette, the small squares in the inside of the palette are automatically filled with a blend of those colors. This is an easy way to get mixes of colors the way that we would with paint in the analog world, but by using digital tools to do our color mixing for us. 
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The Approximate Color palette is a completely different way of mixing colors. This palette requires some experimentation to get used to it, but once you play with it, you may just love it! The Approximate Color palette is shown here:



Follow these instructions to learn how to use the Approximate Color palette:


	Open the Approximate Color palette by either clicking on the tab in the color palette or by clicking on Window in the File menu and clicking on Approximate Color.

	Select a color other than black as the active foreground color. The currently selected foreground color will change the results of the blending in the Approximate Color palette. 

	Click on the text to the right of the top slider to open the pop-up menu of blending options. These options will be discussed in detail later. 




	Click on the text below the slider on the left side of the Approximate Color palette window. Choose an option to blend from this pop-up menu.

	Adjust the top and left sliders by moving them and seeing how the colors in the palette change. 

	Click on a color square inside of the palette to choose that color as the active foreground color. 



The options next to the sliders in this palette are Hue, Saturation, Brightness (V), Brightness (L), Red, Green, and Blue.

This list gives details on each of these options:


	Hue: Hue is simply another way of saying the name of the color.

	Saturation: The amount of color mixed in. Bright colors are highly saturated, but desaturated colors become grayer.

	Brightness (V): The value of the color mixed in.

	Brightness (L): Luminosity of the color.

	Red: The amount of red mixed in.

	Green: The amount of green mixed in.

	Blue: The amount of blue mixed in. 



The sliders on each axis control how much of the currently selected parameter is being used. For instance, setting both the horizontal and vertical axes to Hue and setting both slider values to 100% produces lots of very saturated colors when a similarly saturated color is the currently active color. The following screenshot shows what the Approximate Color palette looks when a saturated purple color is chosen and the horizontal and vertical axes are set to Hue:
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If you are switching from Adobe Photoshop to Clip Studio Paint, there is no reason why you can't take any custom color swatches you may have created with you to your new software! In this section, we will import Photoshop color swatches into the color sets palette. 

Before being able to import your Photoshop swatches, you will need to save them from Photoshop to a .aco file. In Photoshop, you will want to go to the Swatches palette and click on the menu (it will most likely be in the upper-right corner, depending on your version of Photoshop). Next, click on Save swatches in the menu. Save the file to a folder on your computer where you will be able to locate it easily. You can also find .aco files for download on the internet with colors such as Copic Marker inks and more.

Follow these steps to import a color swatch set from Adobe Photoshop to Clip Studio Paint:


	Open the Color Set palette.

	Click on the menu icon in the top-left corner, which is circled in the following screenshot:



 


	Click on Import color set in the Color Set menu.




	Navigate to the folder where the .aco file is located on your computer's hard drive. Click on the file to select it, as shown in the following screenshot, and then click on Open:






	The swatches from the color file will be imported and named automatically, as shown in the following screenshot:



 


	To rename the imported color set, click on the wrench icon in the Color Set palette. The Edit color set window will open.




	Locate the imported color set's name in the list to the left. Click on it once to select it, as shown in the following screenshot: 






	Click on Change name of settings. The name on the left will change to a text entry box. Type the new name for the color set and then press Enter.

	The color set's name will be changed, as shown in the following screenshot:






	Click on OK to save the changes.



Now that we know how to use the different features of the color palettes, we will learn how to select colors using the Sub View palette. Read on to learn how to do this.



            

            
        
    
        

                            
                    Creating Color Palettes from the Sub View Palette

                
            
            
                
In addition to all the other wonderful ways we've explored selecting colors in this chapter, we can select colors from references that we've loaded into the Sub View palette as well. This is easy, convenient, and a real time saver for those working on comics where the same colors are used for characters or environments over and over. 

Follow these steps to import an image into the sub view palette and then select colors from it:


	
Locate the Sub View palette. It is usually nested with the Navigator. If it cannot be located in the interface, go to the File Menu and click on Window - Sub View to bring it up.



	
In the bottom-right corner of the palette, click on the Import icon.



	
Locate your reference image and click on it to select it, then click on the Open button to complete the import.



	
Your image will now be visible in the Sub View palette. 



	
To select colors from the reference image, click on the Eyedropper icon below the image viewing area. It is shown in the following screenshot, above the trash can icon:










	Move the cursor over the image in the sub view palette and click with the eyedropper to select a color from the reference image. The color will become the currently active color.



The Sub View palette is a great place to keep regularly used references, such as character concept art, environment designs, and anatomy and pose references. Being able to select colors from it means that colored character references become easy-to-use palettes in their own way. We can select the colors directly from the character concept art and then use them to add color to our comics. 
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In this chapter, we began to explore the wonderful world of color. Color is a complex subject and many studies can be done on using it effectively, but by using the tools and palettes in Clip Studio Paint, we can make it a little bit easier to handle. We learned how to use the Color Wheel, color slider, and color set palettes. Then we learned how to use the Color History, Intermediate, and Approximate Color palettes to track and mix our colors. Finally, we imported color swatches from Photoshop and learned how to select colors from the Sub View Palette. 

So, how do we apply these colors to our digital art? In the next chapter, we will learn how to create color flats, use layer blending modes, and how to color our ink layers. It's going to be a packed chapter, so let's get going right away!
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In this chapter, we will take the color selecting skills that we learned in the previous chapter and use them to start coloring our comics. Here are the topics that we will cover in this chapter:


	Using Reference Layers

	Creating Flats using the Bucket Fill and Paint Unfilled Area Tools

	Layer Blending Modes

	Creating Colored Line Art



Let's dive right in and get coloring.
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Reference layers are a game changer for anyone who does digital art. Reference layers allow us to make some aspects of the digital coloring process a lot easier.

Many beginning digital artists make a mistake when starting to add color to their art. Once they have some nice inks down, they grab the bucket fill tool in whatever software they're using and start adding color willy-nilly to the same layer that their line art is on. This produces results like the following screenshot:



If we look closely at the area between the black lines and the color, we can see a slight line of white and gray pixels that haven't been filled in. This results in an unpolished look, and to take a pen tool and go over the unfilled area takes a lot of time in order to clean it up. 

Each artist is unique and has their own way of working, but it is recommended that you utilize your layers to their full advantage and also to make your process easier. Line art should be on one layer, with coloring on the layer or layers below it. This is very easy to do if you create your inked lines digitally because you should have just your ink lines and transparent space. All you then need to do is create a layer below the inks and then put your colors on that layer, as shown in the layer setup in the following screenshot:

 

Another thing that some beginning digital artists do is to create their color layer below their lines, then take a pen tool and draw around the outline of each area on the new layer so it can be filled in on the color layer. This also takes a lot of time and effort and can be done much easier and more effectively using the tools and features built into Clip Studio Paint. 

If you do your ink lines on paper and scan them into your computer, you can still digitally color your lines. You will want to set your layer with your scanned lines to the Multiply layer mode. This will make your white areas transparent when color is applied to layers underneath, while the black areas will not show color through them. 

Before we get into filling in actual colors, let's talk for a moment about reference layers.

Reference layers are layers that have an effect on how tools act on other layers. This setting is turned on and off by clicking on the lighthouse icon at the top of the Layer palette. In the following screenshot, this icon is highlighted and is located next to the blue pencil icon:

 

The previous screenshot shows that the inks layer has been turned into a Reference layer. Now, even if we go to the flats layer below it, any tools that we set to work with the reference layer will be changed by the contents of the reference layer. 

As an example, let's see what happens when we use a pen tool with the reference layer options. In order to do this, we'll open the Sub Tool Detail window with the G-pen selected, as we learned how to do in Chapter 15, Inking Special Effects. Then, follow these steps to use the anti-overflow options with the Pen tool:


	Click on the Anti-overflow option in the menu of the Sub Tool Detail palette.

	Check the box next to Do not exceed line of reference layer. 

	Use the pen on a layer other than the layer set as the reference layer. The pen will only fill inside of the lines it is clicked in.

	If there is still a white outline around the color area, click on the box next to the Area scaling option. This option will automatically expand the area colored so that the color goes underneath the line art slightly, eliminating the white pixels. 



In the following screenshot, we can see the option settings for the Anti-overflow on the left, and that we are coloring on the flats layer. Even though the line art is on a completely different layer, we can constrain the colors to the line art boundaries using this simple combination of settings:



Let's explore two ways of making color flats in the next two sections. Read on to learn more.
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In this section, we will use a bucket fill tool that uses the reference layer as its boundaries. 

To complete this section, we will need a file open that has a set of lines on a layer we have set as a reference layer. Only one layer can be set as the Reference Layer at a time, but we can use tools that conform to the reference layer on any other layer in the file. Also, note that sometimes in the Clip Studio Paint interface, the reference layer is called the Referring layer. 

Complete the following steps to create a custom bucket fill tool that conforms to the reference layer:


	Select the Fill (paint bucket) tool. 

	Select the Refer other layers tool. 

	In the Tool Property palette, find the Multiple referring options. Select the Reference layer icon for this option. 

	Ensure that the Area scaling box is checked. This will automatically expand the boundaries of the color to underneath the line art, ensuring a smooth transition from line art to color without any stray white pixels. You may have to adjust this setting for optimal results, depending on how thick or thin your line art is. Use the eraser tool to clean up any overflow that goes into areas where it's not desired.

	If there are small gaps in your ink lines, check the box next to the Close gap option. This will automatically close small gaps and prevent colors from flowing over into other areas. Depending on how large or small the gaps are in your reference layer's lines, you may have to adjust the slider for optimal results.

	Using the Fill tool, click in the areas of the drawing to apply the needed colors for that drawing. In the following screenshot, the colors for the hair, skin, eyes, and clothes have been added to the character, but there are still some small white spots where the fill bucket missed because the areas are too small:



 


	To easily take care of these unpainted areas, we will select the Paint unfilled area tool, which is located in the same category as the Refer other layers fill tool. 

	Ensure that the Area scaling option is checked. 

	Ensure that the Reference Layer icon is selected in the Multiple referring option.

	Make a stroke with the tool over one of the unfilled areas in the color layer. When the pressure is released, any unfilled areas will be filled with the currently active color. 

	If the unfilled areas aren't filled after using the Paint unfilled area tool, check the Color margin option in the Tool Property palette. Moving the slider in this option toward the left may fix this issue. The following screenshot shows our character after the stray white areas have been filled using this tool:






	Use a pen or brush tool to fill in any other stray areas or add details, such as the whites of the eyes or any other areas that need special attention.



Many beginning digital artists ask how many layers they should use when creating their pieces. As with almost anything in art, this is really up to the artist. While you can put everything on one layer, it is recommended to separate line art and color layers so that colors can be changed without having to change the line art, and that coloring and special effects are made easier. Some artists put all their flat colors on one layer, then have one layer for shadows and another for highlights. Some artists have a separate layer for each and every color used in their piece. It's up to how you want to work as an artist, and sometimes up to the specs of your computer! A computer with less RAM and hard drive space won't be able to handle a file with lots of layers, so keep this in mind.

Now that the flats are done, we can use the Auto select (magic wand) tool to select the flat colors from the flats layer and then add shadows and highlights on another layer using the brush of your choice. Layer blending modes can also be used for adding shadows and highlights, which we will explore in the next section.
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At the top of the layer palette is a drop-down menu that controls our Layer Blending Mode. The following screenshot shows the Layer palette and some of the blending modes available for us to use in our art:



There are tons of layer blending modes, and each one can give us a different effect. However, in this section we are going to concentrate on the Multiply, Screen, and Lighten layer modes. These are the three modes most used in coloring, though of course you may find that other modes fit your style better. Let's look at each of the three modes that we listed and see how we can use them to color our images.
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The Multiply mode is used most often with digital artists. This is because it makes white areas of the layer "transparent" but keeps the black areas opaque. This makes it the ideal selection for something like a scanned ink image. By setting the scanned image to Multiply, digital colors can be applied beneath the line art to finish the illustration. Multiply also makes colors darker by combining them with the colors below them. This makes the multiply mode ideal for shadow layers.

Purple is a very popular color to shade with. In the following screenshot, the purple layer is set to the Normal blending mode and no mixing is going on with the flat colors beneath:



The purple shadows are just sitting on top of the base colors without interacting with them. Now, let's see what happens when we set the shadow layer to the Multiply mode:



Now, the purple color is interacting with the flat colors below and mixing with them, making new colors and shades.

We can control the contrast between the base color and shadows by adjusting the Opacity of the shadow layer. This is done using the slider to the right of the blending mode. The following screenshot has had the shading layer lowered to 50%, making the shadows much less intense:



Building up multiple layers of shadows can provide greater contrast and deeper shadows. 
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The Screen mode is useful for creating vivid highlights. You can even use colors that you might not think of using for highlights to create a certain mood in your illustration or comic scene. In the following screenshot, the highlight layer is set to Normal to show that we are using a red color on this layer:



By using our drop-down menu in the Layer palette, we can set our highlight layer to the Screen mode. Using this blending mode, we now get the highlights shown in the following screenshot:



Now, instead of the highlights on the face being bright red, they are a light color close to white. The highlights on the hair have gotten whiter as well, while the highlights on the arm and clothes still retain the reddish hue. 
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This mode looks at the layers in the top layer and the bottom layer, and combines the color in the bottom layer with the brighter color. We have taken the same highlight layer used as the example in the previous section about the Screen mode, and changed it to the Lighten blending mode in the following screenshot:



Now, our highlights have remained closer to the red color of the original layer. They are much more vivid and moody in this layer mode!

These are just three of the many blending modes available to us. By combing layer modes and opacity in different ways, we can create many different effects. Experimentation is key here because each artist is an individual and likes to create a specific look with their art. Changing the layer mode does no damage to the original layer, so play with the layer modes in your art to see what different looks you can create using them and different colors to make your shadows and highlights in your art.
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Colored line work, or color holds, can be used for a variety of effects. They can highlight an area, make it blend more with the coloring, or make a background element face away to leave the foreground in the spotlight. Colored line art can make an image look much softer by not having harsh black lines in it. This is a very easy technique to use to really add punch to an illustration. 

In order to follow the steps in this section, you will need line art done on a transparent layer, as shown in the following screenshot:



The preceding image is an ink drawing scanned from paper, with the white taken out automatically using Clip Studio Paint. You can do this with a scanned image by opening it in Clip Studio Paint. If needed, adjust the brightness and contrast to make the ink lines stand out sharply from the paper color. This will also make the conversion much cleaner. Once this is done, in the File Menu click on Edit and then Convert brightness to opacity. Clip Studio will make the brightest areas transparent and the darkest areas opaque.

Let's make some color holds in the following steps:


	In the Layer palette, click on the layer with the inked lines to select it. 

	Click on the Lock Transparent Pixel icon, located above the list of layers. This icon is circled in the following screenshot: 






	Select your preferred pen or brush tool.

	Select the color that you wish to change your line art to.

	Use the pen or brush over the inked lines to change the color from black to the current color.

	To change all the lines at the same time, select the color to change the line art to and then click on the Fill icon in the command bar at the top of the Clip Studio Paint interface. This will flood all the lines at the same time. 



When we lock the transparent pixels of the drawing, we prevent Clip Studio from altering the pixels that are not transparent in that layer. In this case, all our ink lines are opaque, so we can only change them. In the following screenshot, the scribble across the line art was made wildly, but it only shows on the filled in lines:



This technique allows us to use pens, brushes, or even the gradient tools to color our lines. This drawing had a rainbow gradient applied to the line layer:





Color holds can also be more subtle and make line work less "in your face," like in the interior of the hair and on the face and lips in the following screenshot:







            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, we started actually applying color to our images. We started out by discussing reference layers and how we can use them to make our color flats easier with anti-overflow brushes and bucket fill tools. Then, we explored how three of the many blending modes available in Clip Studio Paint can help us shade and highlight our images. Finally, we used the Lock transparent pixels option to make line art that wasn't flat black.

In the next chapter, we are going to start wrapping everything up in our Clip Studio journey. We will discuss the many ways we can export our work for display on the web and in print. We will also address some print shop considerations in the next chapter, too!



            

            
        
    
        

                            
                    Exporting and Printing Your Comic

                
            
            
                
Now that we have our comics or illustrations penciled, inked, and colored, it's time to get them out of Clip Studio Paint and to the print shop or onto our website. This chapter will teach you about the exporting option in the software, including how to resize pages and adjust the resolution during exporting. 

The following topics will be covered in this chapter:


	Printing at home

	Exporting for print

	Adjusting image quality and file size

	Resizing the final image

	Exporting for web 

	Exporting batches of pages (EX only)



Let's get ready to share our work with the world!
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Over the past few years, home printers have gotten more affordable and more powerful. Just a decade ago, most home printers were just being able to produce decent prints from digital photographs. Now, we have home printers that can print beautiful, high-quality images without breaking the bank. Some printers are even "artist grade" now and can print in wide formats, on fabric, and more.

There are so many home printers now that we obviously can't give a rundown of all of them in this book. It is best to do your own research before buying a printer and think about how you will use the printer. If you are mainly doing black and white prints, you can probably get away with a slightly less expensive printer, or even a laser printer that uses toner instead of ink cartridges. If you are going to print lots of large prints, you may want to consider getting a wide format printer. Printers can be set up with continuous ink systems to save on color ink costs for those who print lots of high-quality photographs or paintings. Read reviews online and compare the features of different printers before purchasing one.

If you do a lot of printing at home, make sure that you keep ink cartridges on hand. Ink always runs out at the most inconvenient of times! 

You will also want some high-quality paper as well. I like photo paper, cardstock, or presentation paper for my art prints, but thinner papers will work as well. Make sure that you don't go too thin, however, because if we saturate a thin piece of paper with lots of ink it will get wrinkled and warped!

Most inkjet printers will print fine from a file that is set up in the RGB color mode, so we don't need to convert our Clip Studio file at all in order to print from it. Ensure that your printer drivers are up to date, as this will solve most printer problems. 

Follow these steps to print an image from Clip Studio Paint:


	Open the file that you wish to print in Clip Studio Paint. Whether it's a color or a black and white file is up to you.

	In the File menu, click on File | Print settings to review the print settings dialog box. The Print Settings dialog box is shown here: 






	Under Preview, check the box next to Preview rendering results on output. This option allows us to see what our page will look like before the printing begins, and will let us stop the printing process if something is wrong. 

	Choose the correct Print size settings from the drop-down menu. Most print jobs should be able to use the Same as detail or Scale up and down according to paper options. The Same as detail setting prints at the size the file is set up as. The Scale up and down according to paper option will resize the print contents to the size of the paper in the printer.

	The Output image options gives us the chance to print or not print some parts of our image. Usually, any layers set as a Draft layer will not print or export, but we can choose to print draft layers by checking the box next to Draft. We can also choose to print or not print text, story information, and more. 




	Under Output image are the options to print Full page, To offset of crop mark, and To inside of crop mark. If we have artwork that extends outside of any crop marks (the bleed area of the art) but we want it to be printed, we should select the Full page option. The other two options will stop the printing at the crop marks or inside of the crop marks. 

	Under the Expression color settings, we have another drop-down menu with several options. The first one is Auto detect appropriate color depth, which allows Clip Studio Paint to automatically set the color depth depending on the file being printed. There are two Duotone options, one called Threshold and one called Toning. Both of these options print in pure black and white, no gray tones. The Threshold option takes any gray or color tones and automatically converts them into black or white. The Toning option still prints in pure black and white with no gray, but it converts any gray or color areas into areas of black dots that mimic shading. The Gray option prints in grayscale, and the RGB color setting prints the image with the RGB values that the printer translates into its own ink colors. Choose the expression color setting that best matches the image you are printing.

	The Advanced settings of color do not actually give us advanced color options, but instead options for printing out the crop marks and tones. Here is a screenshot of the Advanced settings of the color dialog box:



 


	In the Crop mark/Default border options, we can set to Export with display color (prints in the color that the borders are set to in the Preferences). We can also Export with black and Export with cyan, which are both pretty self-explanatory! 




	Under the Number of tone lines settings, we can set the tones to resize depending on the scale of the print (Depend on export scale) or to use the settings of the tones in the image itself (Follow layer settings). Depending on the scale of the printed image, this can be used to control any moire patterns that may occur from the screentones. 

	We can now go back to the Print settings to finish adjusting our options. The final section of print settings are the Process when scaling options. These are For illustration and For comic. These settings change how the image is processed before it is printed. If we don't use lots of tones, then the For illustration settings are suitable for our needs. In the For comic setting, the tone layers are processed individually before printing so that they are scaled with less of a chance of getting a moire pattern.

	Finally, we have a drop-down menu for our Rasterize settings. The Fast setting is fine for if we are printing out a quick copy just to see how our text or layout looks. For a better print, use the Prefer quality setting.

	To save the settings for later, click on the OK button. To print now, click on the Execute print button. You will be asked to select your printer and any printer settings before seeing the print preview screen. If anything doesn't look right in the preview screen, cancel the print job and adjust the print settings, then try again. 

	If you did not execute the print from the Print Settings window, you can click on File | Print to print the image when you are ready.



Even with only focusing on the printing options that Clip Studio Paint has, it's a lot to take in! Be sure to look at any printer-specific options that you may have to adjust, such as the print quality and number of copies. You may have to adjust things a few times to get the best print from your home printer. 

With most home printers, it's not economical to print out multiple copies of our comic to hand out or to sell. It may be perfect for small runs of color prints, but or any larger number of prints we will want to export our images so we can send them to a publisher or print shop. 
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Whether you're making comic books or making pin-up images to sell at a convention, you'll need to know how to print from Clip Studio Paint or how to export the images you create to send to your local print shop, an online printer, or publisher. 

Even if you are only planning on displaying your work on the internet, you should think about still setting up your file as though you are going to print it. Work in 300 dpi, and set up your file dimensions to match whatever paper size you will end up printing on. Even if you are only thinking about the internet now, you may eventually want to start printing your art. Setting it up for print when you create it will save a lot of time, headaches, and redrawing later!

There is a big difference between sending our files to a professional offset printer or a print-on-demand book publisher and sending them to the copy shop down the street. When sending your files out for printing, make sure that you research what file formats the printer accepts and whether or not they have any restrictions. When taking your files to a local chain office supply store or a copy shop, most file formats will do fine so it's up to you how you want to format your images. 

If and when possible, find a small, local print shop to do large amounts of printing at. Not only do they usually have better prices, but they can often work with you on special projects. Also, the staff at these small stores tend to have more knowledge of their equipment and how to get the best quality prints for your art. 

In this section, we are going to export high-quality, lossless versions of our images that will look good when printed, and can be opened by anyone even if they don't have Clip Studio Paint. Follow these steps to export your images in a format suitable for print:


	Open the image you wish to export.

	In the File Menu, click on File and the go down to the Export (Single Layer) option. 

	From the list of options under the Export (Single Layer) option, choose the file format to export the image as and click on it. File formats will be discussed after these steps.

	Name your file and choose the location to save to in the window that appears.

	Choose the parameters to be exported in the next window. It should look similar to the psd export settings window shown in the following screenshot; some of these options should look familiar from the Print Settings in the previous section:






	Click on OK to complete the export.



Here is a screenshot of the file format options available under the Export settings:



The following list explains each of the file formats:


	.bmp (BMP): Bitmap image. Lossless format with no compression. Creates large file sizes.

	.jpg (JPEG): Widely used compressed image format. Suitable for web display, but sometimes not suitable for images to be printed. 

	.png (PNG): Portable Network Graphics. Lossless image format capable of preserving transparency in the final output and suitable for color or grayscale. Image file sizes are small but maintain original quality.

	.tif (TIFF): Lossless file format that can preserve layer information, transparency, and original quality. Not suitable for online display but good for storage or editing.

	.tga (Targa): Truevision Advanced Raster Graphics Adapter. Bitmap image format not suitable for photographic or images with lots of gradients, but suitable for simple images such as icons, cartoons, and line art. 

	.psb (Photoshop Big Document): Adobe Photoshop image format suitable for handling large images with lots of color depth, resolution, or large canvas size. Not suitable for web display.

	.psd (Photoshop Document): Adobe Photoshop document format suitable for images that will be opened and further edited in Photoshop. Not suitable for web display.
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There are times when you do not need to save a full-resolution image, such as when exporting for the internet or sending a proof to a client. This section will explain how to export an image with compression so that the image quality and file size are decreased. 

You will need an open file to export before starting the following steps:


	In the file menu, go to File | Export (Single Layer) - .jpg (JPEG).

	Name the file and choose the folder to save it in. Click on Save.

	The JPEG export settings dialog box will appear. Click on the checkbox next to Preview rendering results on output at the top of the window to enable this option.

	Under JPEG settings, find the Quality setting. It is marked in the following screenshot:






	Adjust the setting using the slider or arrows to change the compression of the file. The smaller the number, the more compressed the file will be. Compression sacrifices image quality to make the final file size smaller. 

	Click on OK.

	The Export Preview window will now appear. If needed, continue to adjust the quality using the setting in the bottom-right corner of the preview window.

	Click on OK to complete the export. 



The quality setting controls the amount of compression in the final file. Compression lowers image quality to make the overall file size smaller, making images load faster on the internet. 

In the following screenshot, the Quality option is set to 80. Not the fairly large file size at the bottom right of the window, at 880.82 KB:



We can make the final file size smaller by adjusting the quality lower. By doing this, the quality of the image is reduced. Note how much the file size has gone down in the following screenshot, but also note how pixelated the image has become because of the low quality, especially around the gradients and the black lines:



The image quality can only be adjusted when exporting to .jpg file format. Other formats are lossless and cannot be compressed. However, the other file formats can be resized on export, which is covered in the next section.
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Another way of changing the file size of the exported image is by changing the width and height of the image during the process. This can be done on the fly without making any changes to your original file, ensuring that you'll never again accidentally save a 600-pixel-wide version over your original drawing ever again. 

You will need an open file to export in order to complete the following steps:


	In the File menu, go to Export (Single Layer) and choose the desired file format for the new file. For this example, we will be using the .png file format. 

	Name the file and choose a folder on your computer to save it. Click on Save. The export settings for the file format you chose in step 1 will appear.

	Locate the Output size options. They are marked in this screenshot:



 


	Select the radio button next to Scale ratio from original data to scale the image by percentage. In the following screenshot, the scale ratio has been set to 50.0%. Note that Width and Height change as the ratio changes:






	Select the radio button next to Specify output size to enter an exact Width or Height measurement. In the following screenshot, we have changed the drop-down menu to the right from in to px and entered a width of 800. The height changes automatically when we enter a new width measurement: 






	Click on OK to complete the export.
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In addition to getting your work printed, one of the best ways to get known as an artist is to post your work to the internet. Whether you have your own website, an account on a host, or are just posting to social media, the web is a great way to connect with other artists and to share your art and stories with the entire world.

Let's export a comic page with internet-friendly settings. You will need an image open to export. It can be of any width and height, and any resolution. We will be adjusting these parameters as we complete the export process. 

Follow these steps to complete this process:


	Execute the Export (Single Layer) command as detailed in the previous sections of this chapter, and choose a format that is friendly for web display. JPEG is recommended because of its small file sizes and ability to control the compression. 




	Name your file and choose a folder to save it in on your computer. Click on Save. 

	In the Export Settings window that comes up next, ensure that the Preview rendering result on output option is checked. 

	If you are using the .jpg format, adjust the Quality option as explained in the previous section. In this screenshot, we have set the Quality to 70:






	Adjust the Output size options to dimensions that are web-friendly. Usually, this is 1000 pixels or less in width, but this might change depending on the format of your image or the website that the image will be uploaded to. For example, a horizontal comic strip may need to be wider than this to be legible. In the following screenshot, we have used the Specify output size option to set the image width to 1000 pixels:



 


	At the bottom of the export settings window, we have the Process when scaling options. If you are exporting a colored image or an image that doesn't use screen tones, select the For illustration radio button. If the export image is a comic with screen tones, choose the For comic option instead to cut down on the amount of moire pattern in the exported image. 

	Click on OK.

	The Export preview window will be displayed once the image has been rendered. Use this preview to review the dimensions and the quality of the final exported file. Make any changes to the file quality by using the option in the bottom-right corner of the preview window. This allows us to change the compression before the final export so we can ensure we have a good looking image with a reasonable file size. In the following screenshot, we adjusted the quality from the initial 70 to 80 to get a better image quality while still keeping the file size small:






	Click on OK to complete the export.





            

            
        
    
        

                            
                    Exporting pages as a batch (EX only)

                
            
            
                
No need to export your entire graphic novel one page at a time, so long as you have Clip Studio Paint EX. Because we can create story files in the EX version of the software, we can also export all or part of those story files all at once. They can even all be resized and compressed at the same time too, saving you lots of time and effort in finishing up a project. 

Follow these steps to export an entire chapter's worth of pages at once:


	In the File Menu, go to Export (multiple pages) and then click on Batch export. This menu is shown in the following screenshot: 






	The Batch export window will appear, as shown in the following screenshot: 








	Using the Refer... button, choose a folder to save the exported images in. The chosen folder path will show in the Export folder box. 

	Use the drop-down menu to choose the file format for the exported images. 

	If desired, click on the box next to Write text to file box to make a file of the text used in the story file. 

	In the Name box, type a name that will be the beginning of the file name for each exported image. 

	Select the Page range. The All option will export all images in the story file. The Only cover page option will allow us to export just the front cover, just the back cover, or all cover pages. The Only main text option allows us to select a range of interior pages to export. 

	To export each page of a two-page spread as a separate image, check the box next to Export spread separately. 

	Click on OK.

	Clip Studio Paint will now load the file and prepare for exporting. This may take several minutes, depending on your computer's specifications and the size of your file. Be patient!

	Once the file has loaded, the export settings for the chosen file format will be shown. Adjust them as detailed in the other sections of this chapter. 

	Click on OK when all the settings have been adjusted to complete the export. 





            

            
        
    
        

                            
                    Summary

                
            
            
                
In this chapter, we have learned how to take our art from Clip Studio Paint and change it into files that we can share with the world. First, we learned how to print our images from Clip Studio to our home printer. Then, we learned how to export our images to be sent to a print shop, copy shop, or publisher. We learned how to adjust the image quality and the dimensions, and how to export our images so that they display well on the internet. Finally, we learned how to export batches of pages in Clip Studio Paint EX.

The next chapter is our final one, the end of this journey that we have been on together. In it, we will explore the animation features of Clip Studio Paint and also learn how to import materials and other assets from the Clip Studio app. 



            

            
        
    
        

                            
                    What Is the Clip Studio App and Getting Animated

                
            
            
                
Two of the most exciting features added to Clip Studio Paint in the past few years are the Clip Studio App, which allows fast and easy downloading of new brushes and other assets, and the ability to create animation in the program. In this final chapter, we will explore both of these options and how to use them. 

The following topics will be covered in this chapter:


	The Clip Studio App

	Creating an account and logging in

	Downloading from the App

	Creating animation

	Exporting animation



Let's jump right into these amazing features!



            

            
        
    
        

                            
                    The Clip Studio App

                
            
            
                
The Clip Studio App is the screen that we open before getting into Clip Studio Paint. The app is our one-stop-shop for new assets and materials, as well as updates from the creators of Clip Studio Paint. It shows up in the Windows list of programs as Clip Studio, and looks like the following screenshot:



On the left side of the window, we have links to the Paint program of Clip Studio. We also have links to manage our works and to Manage materials library. There are quick links to ASSETS, ASK, and TIPS. And finally, we have Export/Publish shortcuts as well. 

In the main window of the Clip Studio App screen, we have our most recent files shown at the top. Below those are recent news stories and updates from Celsys. New patches and upgrades will show up here, as well as contests run by Celsys and other articles produced by them. 

In this section, we will concentrate on creating a Clip Studio account and downloading new assets from the Assets library.



            

            
        
    
        

                            
                    Creating an account and logging in

                
            
            
                
Before we can download new assets from the Clip Studio App, we must create an account with Celsys. This is an easy process that is fast, and best of all, it's free! 

To start the process of creating an account, go to the Clip Studio App screen. In the top middle of the screen is a button labeled Log In. Clicking on it will bring up the following window: 



To create a new account, click on the Register account... button. Your internet browser will open to the Celsys website. Enter the required information on this page to create your account. You may need to verify your email address after account creation before you can log in to the Clip Studio App. 

Once you have registered and verified your account, enter the E-mail Address and Password from your registration details into the proper fields in the Log-in window. Checking the Save e-mail address and password box will ensure that your information is saved for quick login later on. 

Do not save your email address and password to the app if you are using a public or shared computer. Someone with this information can change your Celsys login details or download tons of materials to your computer. Some of the Assets in the Clip Studio App are premium content and cost an amount of real money, so consider these things before saving your details in the app. If your computer is private and you are the only user, saving your details can make logging in much faster and easier.

Once your login details are entered, click on the OK button to log in. If you have an account but can't remember the password, click on the Forgot your password? button to complete the password retrieval process.

Now that we're logged in to the app, we can search for and download new assets.



            

            
        
    
        

                            
                    Downloading from the App

                
            
            
                
The Clip Studio App Assets are user-created brushes, materials, 3D objects, sound effects, and more that can be downloaded for use in your own works. To access the materials available for download, click on the Assets link in the left-hand menu of the Clip Studio App. The following screenshot shows the Assets library as of the time of this writing: 



Each asset has a thumbnail showing us what the asset looks like. Beneath the thumbnail image, we have information about the asset. The first line tells us what type of asset it is (Brush, Material catalog, 3D, and so on). The next line tells us the name of the material. The third line tells us the username of the person who created and uploaded the asset to the online library. The next line tells us how many times that asset has been downloaded, and the final line tells us the cost of the asset. 

Many of the items in the Asset download library are free. However, some assets cost real money. In order to download these assets, you first have to purchase "gold" from Celsys. At the time of writing, 1,000 gold costs around $10 USD. Gold has an expiration date, so if you purchase gold, be sure to use it all before it expires!

To search for a specific asset, type a keyword or keywords into the Search bar at the top of the Assets window. Press the Enter key on your keyboard to complete the search. The button marked Detail to the right of the search bar can be clicked and then used to narrow the search results. For instance, in the following screenshot we have entered the search keyword "heart." If we only want to see brush assets that match that keyword, we would click on the Brush option under the Detail window. This will filter the search results accordingly:



You may have noticed that quite a lot of the assets have Japanese names. This can sometimes make searching difficult. If you are having trouble finding an asset, try searching the internet for an English to Japanese translator. Enter the keyword into the translator, then copy the translation and enter that into the Search box. If this doesn't return what you're looking for, then it may be up to you to make that asset and put it out there for others to download! This is a great way to show off your Clip Studio skills, and you can make a little extra money too if you create a paid asset that lots of people download.

Once we locate an asset that we might be interested in downloading, we can click on the thumbnail to view more details about it. The asset in the following screenshot is a shoelace brush that looks pretty good:



From this detail window, we can add a Like to the asset by click on the Heart button (and we can see how many likes the asset has, too). We can add the asset to our favorites by clicking on the Star shaped button. Favorites can act like a sort of wish list for paid assets, if you'd like. 

Scrolling down further will give us more information about the asset we wish to download. Most users will include more thumbnails and ideas of how to use the asset in an image. Be sure to look at this information before deciding to download this asset.

The shoelace asset is a paid asset, so we would need to have gold in our account in order to download this brush. In Free assets, we will see a Download button below the asset thumbnail. Clicking on the Download button on a free asset or the Checkout Now button on paid assets will allow you to download them.

Now, we need to open the Communication Manager to see the status of our downloads. At the top of the app window is an icon with two arrows, one pointing left and the other pointing right. This is the Communication Manager. The Communication Manager is shown in the following screenshot:



Any recently downloaded items will show in this window. We will see the name, the date and time that the download occurred, the status of the download, the Content ID, and if the process was successful or not. Check this to make sure that the download was successful before trying to download the asset again.

Now that we have downloaded an asset, we need to locate it in the Materials Library in Clip Studio Paint.



            

            
        
    
        

                            
                    Locating your downloads in Clip Studio Paint

                
            
            
                
When we download an asset to Clip Studio Paint, it goes into our Materials Library. Open the Materials Library and then the Download folder. Click on this folder to see your downloaded assets, as shown in the following screenshot:





If the asset you downloaded was an image, pattern, or 3D asset, you will be able to use it right away from the Material library. If it was a brush asset, you still need to register that asset to one of the subtool palettes. This is a very simple process. To register the brush material, follow these easy steps:


	Open the Sub Tool palette to the group of tools that you wish to register the new brush asset to. We will be registering a new Pen asset in this set of directions. 

	In the Download section of the Materials Library, click on the thumbnail of the brush asset to register to select it. 

	Click again on the material and maintain the pressure on your mouse button. Drag the mouse cursor over to the Sub Tool palette without letting go of the mouse button. Once the cursor is over the Sub Tool Palette, you will see a + symbol appear next to the cursor. Release the button pressure now.

	The new brush or tool will be registered to the Sub Tool Palette. In the following screenshot, we can see the brush from the previous screenshot is now in the Pen Sub Tool category:



 





            

            
        
    
        

                            
                    Creating animation

                
            
            
                
Animation is a very complex art form that requires lots of study and practice to get right. There are many books and internet resources for how to animate, the principles of animation, and tips for animating well. These things are beyond the scope of this book. However, we can explore how to create a Clip Studio file with an animation timeline and then add cels to make our pictures have the appearance of motion. 

When working in Clip Studio Paint PRO, your animation frames are limited to only 24 in a timeline. Clip Studio Paint EX can create unlimited animation frames in a timeline.

You can either start a new file just for animation, or add animation to an existing piece of artwork. Clip Studio Paint has several presets for standard video sizes already programmed into the software. Follow along with these steps to make an animation file:


	To create a new animation file, go to File-New. Click on the Animation icon in the Use Of Work section of the New dialog box. It is shown in the following screenshot:






	Select a size from the Preset dropdown or set a custom size using the Width and Height entry boxes.

	On the right-hand side of the New dialog box, set the frame rate. This will depend on the purpose of your animation (whether the animation is for the web or for a movie), so make sure that you know what frame rate you need before starting.

	The Playback Time is the number of frames that will be created in the timeline. In the previous example, since the frame rate is 24 frames per second and the Playback time is 240, the animation would be 10 seconds long. 

	If needed, set the Scene number and Shot number. These are helpful for longer projects or projects with a team working on them.

	Click on OK to create the new animation file.

	You will now have a timeline window in your user interface with a new timeline in it. In the Layer palette, you will have a Paper layer and an Animation Folder. This animation folder is the default folder for the animation cels that you create. 

	Draw the first frame of your animation on the pre-made cel layer in the Animation folder. 

	To add the next frame of animation, click on the New animation cel icon in the Timeline, circled in the following screenshot: 



 


	In order to see your previous frame and check where your shapes should be moving to, you'll need to turn on the Onion Skin feature. This allows you to see a ghosted image of the previous frames in your timeline. To use this feature, click on the Enable Onion Skin icon in the Timeline palette.

	Continue adding cels to your animation and drawing new frames until you have finished your animation. You can use the play options at the top of the timeline to play back your animation and check your motion as you go. 




	Once you have your rough animation done, create a new Animation folder by clicking the New animation folder to the left of the New animation cel icon. This will create a new folder in the Layer palette. 

	In the new animation folder, use your favorite inking and coloring methods to refine your animation cels from the rough animation. 



You can create finished animation cels in one folder, but when doing more complex animation, such as characters moving and interacting with one another, you may have more success by roughing out the animation in one folder and then refining the motion in another folder. This way, the original sketches are preserved and you can adjust anything as needed. This is similar to traditional animation roughing out the motion in pencil sketches and then painting the finished animation onto transparent cels.

Once you have your animation complete, it's time to export that animation to share it with others.



            

            
        
    
        

                            
                    Exporting animation

                
            
            
                
Just like when we exported our still images, we can export our animations. This is a simple process, but there are several formats to export that we need to explore in order to know which is the correct one to choose for our purposes. 

Under the File section of the File menu, we will see the Export animation option, and under that option are the different ways we can export. These are shown in the following screenshot:



We will discuss each of these options next. 

The final three options in the Export animation menu are mainly used by animation professionals and teams working on animation projects together. As such, we will not be covering them in this book and instead will only explore the first four options.



            

            
        
    
        

                            
                    Image sequence

                
            
            
                
An image sequence is a series of still images. Each animation cel is exported as a numbered image that can then be imported into other software for further editing. The Image sequence export settings window is shown here:



By using the Refer button, we can select the folder to save the images to. The text entered in the Name field will be the file name for each image. The character entered into the Separator field will separate the Name from the numbers in the final filenames. By changing the entry in Start number, we can adjust what number our image sequence will begin with.

Under the Advanced settings, we can set the file format of the images from the drop-down menu. 

The Scaling settings can be used to resize the exported image's Width and Height.

The Export range settings can be used to specify a section of frames to export, or all frames can be exported. 

The Frame rate option can be used to change the frame rate.



            

            
        
    
        

                            
                    Animated GIF

                
            
            
                
An animated GIF is one of the most common ways to share animation on the internet. You've undoubtedly seen animated GIFs on countless websites and social media posts. To export your animation as a GIF, select the Animate GIF option from the Export animation menu option.

First, name the file to be saved. Then, the Animated GIF export settings will appear, as shown here:



We can use the Width and Height to change the dimensions of the output image.

The Export range is how many frames from the timeline we want to output. To export only a portion of the timeline, enter the number of the first frame and then the last frame.

The Frame rate is how quickly the gif will play back. The Loop count controls how many times the frames will replay before the animation in the gif ends. 

Click on OK and the gif will be exported.



            

            
        
    
        

                            
                    Animated Sticker (APNG)

                
            
            
                
An animated sticker, or APNG, is an animated image with the qualities of a .png file instead of a .gif file. The APNG export options are shown in the following screenshot:





These options are the same as the .gif options detailed below, with two additional options added at the bottom of the window. The Delete blank spaces option deletes any blank areas that are not drawn, such as outside of the frame area. The Color reduction option reduces the color palette to 256 colors (transparent + 255 colors), which can reduce the file size but may make some colors display in a way that was not intended. 



            

            
        
    
        

                            
                    Movie

                
            
            
                
Movie files can be uploaded to YouTube or imported into video editing software to add sound or other effects. When you select the Movie option, you will be prompted to select a location to save the file and for a name for the file before the following window appears:





At the top of the window, we have two video format options, AVI1.0 and AVI2.0. We have the option to export as an Avi 1.0 or Avi 2.0. Avi 1.0 can export animation files smaller than 2 GB and the format is supported by most editing software. But the background may not be able to be made transparent in this format, depending on the video settings.

Avi 2.0 can export files larger than 2 GB but is not supported by some software and devices, and so may not play back correctly. Choose the appropriate file format. The dimensions of the movie file can be changed here in the scaling settings. Transparency can also be enabled, which is useful if this animation will be composited over other images. Again though, the video settings may not support this option if used so be sure to double-check after exporting.

By using the Width and Height settings, we can again resize the dimensions of our final file. The Frame rate option controls the frame rate of playback. By checking the box next to Enable transparency, we can export the transparent parts of our animation as transparent.



            

            
        
    
        

                            
                    Summary

                
            
            
                
Finally, our long Clip Studio Paint journey has come to an end. It started back at the beginning of this book by installing Clip Studio Paint. We learned how to set preferences and create new files, use and create brushes, and use layer properties. We covered eraser tools, ways to make selections, and how to use the Sub View palette. We learned about 3D objects, rulers, vectors, and the Materials palette. We created text, word balloons, and sound effects, as well as layer masks and screen tones. Then, we made comic panels and auto actions, and then delved into the wonderful world of inking. After that, we touched on the ways you can bring color to your art. Then, we exported our work to share with the world. Finally, we spent some time learning about how to download new materials and how to bring life to our illustrations with animation. 

It's been a long and crazy ride, but I hope that you have learned a lot. I hope that you are excited to discover more about the incredible world of Clip Studio Paint. This program is so diverse and customizable that it can fit nearly any artist and any style of art into its workflow. I hope you have ideas of all the worlds you wish to create using the incredible tools available in Clip Studio Paint. Remember to keep practicing, learning, and experimenting with your art!



            

            
        
    
        

                            
                    Other Books You May Enjoy

                
            
            
                
If you enjoyed this book, you may be interested in these other books by Packt:



Real-Time 3D Graphics with WebGL 2 - Second Edition

Farhad Ghayour

ISBN: 9781788629690


	Understand the rendering pipeline provided in WebGL

	Build and render 3D objects with WebGL

	Develop lights using shaders, 3D math, and the physics of light reflection

	Create a camera and use it to navigate a 3D scene

	Use texturing, lighting, and shading techniques to render realistic 3D scenes

	Implement object selection and interaction in a 3D scene

	Cover advanced techniques for creating immersive and compelling scenes

	Learn new and advanced features offered in WebGL 2





Moodle 3 E-Learning Course Development - Fourth Edition

Susan Smith Nash

ISBN: 9781788472197


	Know what Moodle does and how it supports your teaching strategies

	Install Moodle on your computer and navigate your way around it

	Understand all of Moodle's learning features

	Monitor how learners interact with your site using site statistics

	Add multimedia content to your site

	Allow students to enroll themselves or invite other students to join a course





            

            
        
    
        

                            
                    Leave a review - let other readers know what you think

                
            
            
                
Please share your thoughts on this book with others by leaving a review on the site that you bought it from. If you purchased the book from Amazon, please leave us an honest review on this book's Amazon page. This is vital so that other potential readers can see and use your unbiased opinion to make purchasing decisions, we can understand what our customers think about our products, and our authors can see your feedback on the title that they have worked with Packt to create. It will only take a few minutes of your time, but is valuable to other potential customers, our authors, and Packt. Thank you!
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